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THOREEERTEET, ZOFPAFTERLEBRL, V=1%o b« FH— b -
Ey hDO XML 7 7 A WITRIFSNET,

FEANIZOWTIE, 47 ~X— [Toolkit Support Properties 7% 1 7| ML T X0,
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Test Object Class TH4 +

Test Object Class 7 ¥ 771, Extensibility Accelerator D EFE 27 A FT9, ZDOTHA
FTHE, WAZL Ay br—MIH LT UFT BMERT 7 A A7 V=7 b 75
ADTRCOFFMEERTEET, BIELTUL, TAM - ATV b 77 AO4H]
Kyarbo—nofA47, PR=—PFLHELToRT AR ERHY £T,

ZOTHATOXTIETRTEERO THRLTIZIN,
FEARICOWTIE, RESRL TSI,

> 86 ~X— [[General] # 7 (TestObject Class 7 A F) |
» 98 ~X—<” [[Map to Controls] %7 (Test Object Class 7 %1 ) |
» 111 ~*— [[Operations] % 7 (Test Object Class 7 %A1 ) |

» 123 ~X— [[Properties] %7 (Test Object Class 7 # 1 F) |

Enumerations 54 7

ZOTHAFTTIE, TAL AT V=7 MIEOBIESCRVEICHEHATE 2EDO U R b
FERTEET, ZOHRIL, TAM AT V27 FREXML 7 7 A )V IRFEESNET,

FEHNZ DWW T, 51 2—2 [Enumerations 794 7] #ZRL T 7Z &0,

JavaScript TT« &

JavaScript 7 7 A /Wi, JavaScript HHO =7 1 Z TR ET, 20T ¢ ZITiE, #XD
AR X IntelliSense FERE & Vo 7o AR YE) 72 JavaScript fREEMSRED Mo > TWET, 3
AZDWTIE, MSDN Visual Studio 427 A &+ ~LTEBRL T TZE,

_elem F—7 0%, BEEOFITHHC UFT MBI L CW D ar e — L -3 ER 2R L
%9, Extensibility Accelerator TiX, _elem k— 2 /Zx7 % IntelliSense 12 LV, T X
e ATVl b VJIFRATEREINTZHIIN—NMZ—BTHT TV —var-ay
FE— /L THEHTFTRER A Y v RE T u T 4 PRt IhE T,

_elem N —7 \Z%9 5 IntelliSense NMEHATELHD1E, A - AT V2T h - 7T
DIEREREDRIET 7 A NV EFRE L TV DHEITRY 7,
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_elem ]‘_7 2% L C IntelliSense NEHTE H720121E, 77V r—3a VisBn
TREIE—FEATEY, $R— bbfwé&47®:/hn—wﬁ%Ténfwé
VERHY F7 (Web 77 7 2B < HilIZ, Extensibility Accelerator 3T L T r Y =
7 MERSLERH Y E7),

ELWIATDary be—AR3ERTELL9E, 7AL - AT7T=2 b 7T RTH
L=k » =7 4 ZIZRR SN TN D /L— L, Tf)#~v5ymmzyhm~w
A &b I DIELSREINT 5 Z L 2RI H2MNERHY £9, 207X, [Map
to Controls] % 7" (Test Object Class 7 A F) (98— %4 %) T [Test All Rules] %
IV L, TV r—varTcary ha— L RMRE RSN L 2R LET,

XML T 5744
XML 7 7 A4 Wi%, XML HO=F 4 Z THMNET, 20T ¢ ZITiE, BniTRRe

ST DR SEMEE & W o TR HER) 72 XML fRERE D > TV E T, FEHIIZ DV TIE,
MSDN Visual Studio &> F A > + ~VTH#BRLTL 2 &0,

ZOZT 4 XTI, BET 5 A F— <25 < XML IntelliSense 35 & UMRAEFEHE B i > -
TWEF, Extensibility Accelerator (21%, Y —/vF v FEE XML 7 7 AV &ET Ak « 4
TV =/ FRIE XML 7 7 A VOMREICHER XML A% —< A fFE L THET
(<Extensibility Accelerator f > X k—)L>\dat\Toolkit.xsd &

<Extensibility Accelerator 4 >R k—JL>\dat\ClassesDefinitions.xsd) .

FE WETa Y NTHE, JrAN, Tl NNOT 7 A IVOEHL, KT 7
A NVONEORNZERBELREENDLY £, LENR-T, XML 7 7 A VA2 FEITRET D
BEIE, R —EMRNELRNE IICEESSLETT,
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ZEDfDY 1+ FD

AA VHEBOENT, ROV 4 FUMEATEET (ZNHE2FRT DT, [View]

> J—PTJA—: HAX L V=X y OV R— FOIER ET 7 0 AT HE 2R BT E:
BerFRRL, BUEOBREZRHERLET,
BT ABEMA 7Y v 7 LT, ILWT AN A7V ke 7T AFEKLTZD,
V=% bV R—F -y b ET oA LY TEET, FEMITOWNTIE, 40
NR—=Y U=y T7u—-- 4Ky Z2RLTIEIND,

> VS5R-EBa— i Tnd7uelel hTEZHENTWDET A AT V=7 k-
PIAL BT AN FT V2V b TRAH L TERIN TV DAEEER R LET,
DU 4 RUNLIE, 7T AOBMHmEE, BIEOREST Ny 7 Lo iz—k
BREELFETTEET, FEMICOVWTIE, 23—V (752 - ba—] 2BBLTL
7ZE0,
IO RUE, Tavad RBBEINTWAEADOHREHATE T,

> TR Y b - TVRTA=F VTV DR 0 Y =7 MRy o7 4V F L
T ANVEFRRLET,
Il ke V)= NOT 7 ANELX TNV v 7 LT ZENRTEET, M
WZOoWTHE, 43— [7avcl b2/ A7u—7 | 22RLTIEEN,

>» IS5—-JRb: 7oyl MIMEAT—HNRELTDHIHAR, BR5774 10D
BHRMOBNIF ELCAR—BER RO T2GEI1L, =T —, B, F3ERA v -
FFRRLET,

ZDIEMIZ, Visual Studio FE¥ED T 4 KU BEHATEET, & X, A2 - U R
h, BMBHER, BLOTL—IRA v FRa~wr R4 R W=y 7S
T4y RURETT,

AZa—&Y—)LR—
Extensibility Accelerator T T& 2 A =2 — &Y — L 3—[%, Visual Studio ® & D & {2

TEY, BIEEEL WL TIFATERE 7 7 A NVDEA TS CTELET, Hilx
F2FET,

> [File], [Edit], [View], [Tools], [Window], [Help] ®% * == —i, #IZfEH
ARE T,

> [Project] A==o—i%, 7uv=7 FPHIN TS EXIEATEET,
> [XML] A==—{%, XML 7 7 A LN TND & XIHEHTE ET,
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Q rSITLYa—F 4 24 EHIBEIE - Extensibility Accelerator

Z DI TIE, Extensibility Accelerator (2B 25 M T 7 vy 2 —F 4 7 EIIRFHIZ O
THBILET,

XML T5 1 42— 8875 XML IntelliSense L AEHE L ALY
BMoarya—FnbY— %y heYR—Fr ety oS rR—bL7EHA, XML 7 7
ANTEBEINTNDAF— « 77 A IVOBEFTNRMES> TWODAREMERH Y T3,

XML 7 7 A VDT H D xsd 7 7 A L~DEHE (Typelnformation ZE3E D
xsi:noNamespaceSchemalocation J&#:) %R L T 7230,

ZRMNELLRWEGS, ROWTINEFATLET,
> xsd 7 7 A /LDIE LWT (<Extensibility Accelerator € X b—)L>\dat 7 + /L %)
ZZRTLHL01C, FEAITEREELELET,

> ZHROITEHIERL, 77 A NVERIFEL T EE LE 7, Extensibility Accelerator 3
ELWAF—<T 7 A L~DBREFALET,

Extensibility Accelerator A XML 7 7 /)LD A > FEXDIHFE LG R—
FLZLY
> XMLtEZ > a v aEHELTWDET AR AT V=2 b2 7 Rk 5 Test Object
Class 7 A TP TWS (2 A v METFETEMT 25E51C#Y, & xid,
GWTPushButton 7 Ak« A7 V=7 MIBET 53X M4 XML =7 1 Z TAJ)
9 5354, GWTPushButton Test Object Class 7 VA T H B LE R H Y 7)),

> AU NBRERORGY 7 OEANCH D%, 272 L, IROBERZ A TORIOD 2 A
v MEIYAR—FEINERA,

» TAN ATVl NRET 74 /LN : Description, Additionalinfo,
Documentation, IdentificationProperties

> V—J)L¥%y NRET 74 /LI : Controls, Methods, HTMLTags, Settings,
Variable (Controls\SettingsZ3% ™)
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PR=FPENRNIA FEFURXML 7 7 A VB3 H LY R— bty haAf AR —KL
7238346, = A b Extensibility Accelerator © XML 7 7 A /L|Z i ZOLNERA, ZD
£H7%a Ay M XML =7 4 % TREED XML 7 7 A VIS FB TEIM L7256, 2 A
MIFEINET,

Extensibility Accelerator T4 41 F+ D4 iR Al

Extensibility Accelerator @ [Name] =5 ¢ v | « Ry 7 A THFR— FINDHDIL, EF
BT, ATy, FRXTFRETT, BHIIRTCTHOILERSHY £7, [Property] 4%
FROLFITMEATAR=2 2GR LN TEET,

TT 4y b Ry 7 AT R—= SRRV FE AN LTH, BHINLET,

TAM-FTPxH FRE XML 77 1 LT, Argument EFNOD Description
BRFYR—rEZhFEA,
INHEEL XML 7 7 ANABHLIYR—F By baA A= L72E, 2320

X 9 72 B3 % Extensibility Accelerator 7' 2 = 7 NNOBEFD XML 7 7 A VI FE)CTiE
MUT=5E, ZROHDOEETXML 7 7 A ADLHIBRSVET,

B : 512 OFPIX, Operation EHENE D Description BHEIZFik LE+, 72720
BEOBINIUFT OV — Lk v MIFRRIND E V) ZEICHER LTI,

Fxaxy FOKIBEER
> A U H—Fy MIERE L TWRWIEE, A7 Visual Studio IDE (Z%f9 5 27 %
AR e~V T (FlL 2T EFOR) IV AR— b EEA,

» [Project Explorer] @t > K7 & [Control Selection] %A 7 w2 « AR v 7 ATlE, Fli
PR—bFINEEA,
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Extensibility Accelerator D4 > X k—JL

FEOAE
»>» f VA= LENDHIALR—FRF (2832—)
> A VA M= LVOFIHRSEME 29%—)

> UFT R a B a—F~DA A =L (30%—7)
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Extensibility Accelerator for HP Functional Testing 4 > A h—/L -« 7’1 7 A, RO =
YRR N EA A=V LET,

>» Extensibility Accelerator

ZOTa T RIT IR ATHIZIE, TAY My EOT A @)y, Unified Functional
Testing 70 7 Z 5« 7 —7 ( [RE—F] > [FAYSL] > [HP Software] >
[HP Unified Functional Testing] > [Extensibility Accelerator]) #fiif L %7,

> UFT Web Add-in Extensibility APl (XSD 7 7 1 /L, 7 1 —/ LB ® JavaScript 7 7
AN ExETe)

> TE - L—E—

Z D A—E—|Z, Extensibility Accelerator @ FEAEHE AT 2H0T, FED Web =
b=kt T D UFT OV R — e W AX <A AT H T avRAE2RLET,

T « A—E'—|Z, Extensibility Accelerator Bi#f~2— % 7=1% [Help] A ==— ([Help]
> [Product Feature Movies] /b H/ETE £9,
> FXatvhk

[HP Extensibility Accelerator for HP Functional Testing = —%—X « 1 K] & [HP UFT
Web Add-in Extensibility BRFEH 7 A K123, A4 v « ~V TR L HIBA (PDF)
B TA A b= ENET,

774 KX <Extensibility Accelerator £ X k—JL * 24 LA >\Help 7 4+ V% N 5HIE
BT /v ATX, T4 - ~)L7L Extensibility Accelerator ® [Help] A == —»»
LR Z &b TEET,

> H > 7)L Web Add-in Extensibility 7o 4 +

IhbnTuT s ML, WL ONDOAR Web2.0 Y —L¥ v &Y R— T 55
KLY —nFy b PR—F -y FRAEGENLTHET,
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W27 i, %ALLUSERSPROFILE%\Documents\ExtAccTool\Samples 7 + /L 4 (2
A > A h—/L&#, Extensibility Accelerator Bl —T MO (7 7 EATEET, i
LboTuT=r FERWT, TrA0n, B, 3 A FEFNDLET, PR— -
Ty FORFHIOWTEFHELLMD Z ENTEES, E2, VoI Trv=7 b %
EELTERLTADZELTEET, P Fud=l ORI T v 7 - 2
v —7%, <Extensibility Accelerator £ X k—JL = 7+ JLS >\Help\Samples 7 /L
WA VA M=V ENTHET,

& 1R F—ILOETIEEHE

Extensibility Accelerator for HP Functional Testing %1 A b —/L 9" B HIIZ, KOAIHESM:
BA VA R—LENTVDILERD Y 7,

» NET Framework v3.5 SP1

» Microsoft Visual C++ 2005 SP1 Run-time Components

» Microsoft Visual C++ 2008 Run-time Components

> Visual Studio 2008 Shell (43HfE— F) +SPI FRA AlRE/ S v 77—

Extensibility Accelerator for HP Functional Testing D1 > A b —/V{ZIE, 2 DOERRH Y F
T 1 DN DORHRRMED A U A b—)v « TR T T REFLRENA VA=) -
Ny r—, b 9 1 D0F Extensibility Accelerator 721F 2 & Te/N Sy 7 — 0T,

A YA M= VFROEGFH P LFATTE ET,

» Unified Functional Testing D% > ~7 v 7+ 7’1 7°Z A d [Add-in Extensibility & Web
2.0 Toolkits] 4+ 7> 2> (REWA VA R—)L - Ry r—),

F: OO —BRLELT, html X—=YRT T UFTHEET, A APV EFET
T 5121, T DO~X—% Internet Explorer TH < LR H Y £,

> www.hp.com/go/functionaltestingWeb2 (KX A A F—Jb « Ny lr—T LS A
VAR s Ry —T D0 )

RKEWASTF—U b A A F— )L &EFLT L72YE, Extensibility Accelerator DA > A
M=V DHNZ, RELTWOHHERIFEDOA VA h—)b » T 7T ANFATINET,
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INEWRy T —UnbA VA M= )VEFEITT DAL, £T T XCTORMHREENA A
= ENTWNDHZ EEMHRELET,

5 : Visual Studio 2008 A2 U B a2 —HFIZA VA =L ENTWBEAIE, Extensibility
Accelerator %1 > A b —/L ¢ BHIIZ Service Pack 1 14 A b—/L L TEBL LERH D
iﬁ—o

@ UFT AENIAVELI—FADA VR =L

UFT A VA b= EnTWielna B a—HF Th, Extensibility Accelerator % A > A
%~wa Web 22 br— /LT 5V —Fy b« FR—b &y NEERTDZ
LIFAHE T,

Extensibility Accelerator (Zi%, 88Ft L7727 A b« A7 V=7 MUEDTZDDT N JHiE
DHAAENTWET, 2L, UFT 2HH LIZBEDETE L I 2L — 560D T
T, ZOMEEIE, UFT A YA b=l s TWihnaryBa— X CHfEHTEET, 2
DTNy THERHE LI, Y—Fy h ¥ AKR—F &y FEUFTIZT 7 A L72< T
%, JavaScript B O—H 2 0 — BT Ny FTEET,

UFT 23 A > A b—/L & T 5 2 ' 2 — & |Z Extensibility Accelerator % 1 > A h— /L
o5&, Y=nFy b BR—F -ty hPEABNICUFTIZT 70/ TE5DT, YV—
NFEy b R—=b -y bOT RNy 7 ET A MR EVERICRZY £,
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F3IE

HREL - Y—I)Lxy FOYER—F

EEOAR
=
> WAL« Y—)F¥y kPR —F -ty b 323%-)
> BEOBMALBREFEOLA I LT (343—)
V4
> DAL LY —Fy NOYR— FOEREITEHROE B6—)
> BEDOY =Xy b e FR—F By A v BR— M5 5HE (384—)
V77V VA
> Uy T U R (40— )
JTA e Ba— (4278
Tulxl b2y ATR—T (443—-)

>
>
» [Import Toolkit Support Set] #4717 « Ry 7 R (46-2—27)
» Toolkit Support Properties 7 %1 F (473—)

>

Enumerations 7 %4 F (51X—2)
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UFT Web Add-in ZHEL TH A HZ L Web YV —/L¥x v FaYR— 5121, ARRL -
Y—IExy b -HR—bF-ty rE2EKL, UFTICT 70 A LEd, YV—bF v bW
A—h &y M, XMLZREZ 7 A V& JavaScript BAE s HAERR S E 5,

XML %E7 7 A ML, HAX A Web 22 ba—LEYR—bT52DIERTET A
heF 7V b7 2FEHRL, avrbuo—NI~vy 7 LET, £72, UFT ¥ H A
Hheary b=l LTED LS ITEET 2026 EFR L E T, JavaScript B#i%, UFT
LT AMRBOT TV r—2 g DML E T 2 —ADEEZR-L, o ho—
VBT AERERE LY, 2 he— ot A8EZEIT LY LET,

Extensibility Accelerator CiZ, JER7 0 =7 M&A{ETH L, V—F v F e HFR— |-
Ty NCRADTZ 7 AN Ta Y27 MIEERET, 70V =7 MITKRO XA T
Ty ANBEENDFRERSH D T,

» XML 7 7 A JL : Extensibility Accelerator Ti, 7 %A 7 (Test Object Class 7 ' F 72
E) ZfioT, AN A7V FEEBIPY =¥y MRE XML 7 7 A /ViZ
BENLERERETEET,

» JavaScript 77 AL 1B T DET AN AT V=7 b7 T RIT% LT, Extensibility
Accelerator |IX}H> 9% JavaScript 7 7 A VEVER L E T, 7 7 A VAIZIE, FEET D4

TN DO A Z T HIMER STV E T, Extensibility Accelerator 7> 5 7 7 A /L% B
W, INHOAKEFEET DN ERa— REZBINTE £,

> FDH®D T 7 A )L : Extensibility Accelerator OV D030 T ¥ A F1ZiL [Import] R %
PIMESRTEY, TOMOT 7 A v ETn Y= MIBMTE £,

B2 DEMMIZONTIE, 36 23— [HAZL < Y—LFy OV R— FOIERKRE-IZ
FHOFE) 2B TI SN,
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Y—ILxy b -YR—F -ty FIE ROLOMBEFERLTHET,

>

FRAMFTCIHFERE XML Z7AI: ZOT 7 AL, WAX L bp—
NEYR—FTHEDINERLET AN ATV b7 TFRE, ZRHDTF A -
F TVl PCH LTI R—= TR ERDH IR T e RT A BIOT A - 47
Ul MNEEEETER L ET,

Z O XML OFEE EELOFEMZHONTIE, UFT T A b« A7 V=7 b+ AF—<D
~/V 7 (Extensibility Accelerator ~/L 7’ SHHTEE) #SM L T 7ZE 0,

V—ILEY FREXML 274 : ZOT7 7 A WE, ERLIET AN AT V=7 |-
7T AEB#ET S ar fe—l~y 7L, UFT 82 hr— L2 E{E4 5 HiEICE
T HEREOFHEME TR L ET, FEOHEMO—MILIZORET 7 A VT, TOMIXZ
D7 7 ANDBER IS JavaScript 7 7 A MZFEIR S E T,

O XML O EESCOFEMICONTIE, Y%y hEEAFXT—vD~ILT
(Extensibility Accelerator ~/V 7N HHRIHTFEE) ML TS EE 0y,

JavaScript 77 : TNHDO T 7 AT, YV—F v FRE XML 7 7 A 05
BRI N D FEBENELZ SN TCOET, UFT X6 0BEEEFRH LT, h R4
L3y b —VOERERG LIV BEEZFIT LY LET,

FEAMIZ O TUE, THP UFT Web Add-in Extensibility BIE WA K] oY —% v b -
A=k « & MIHT 5 JavaScript BB OBRFTOHEE S L T Z &0,

FAAVBEIUALT - TP (FTF2aY)

TAaAY T AL, TAK ATV b 7T ZA%FT72DIC UFT THA S
NE7A4aryPMEESHTHWET (WR—=bENB 77 AV %A 7 :ico, .exe, .dll)
NIVT T AL, TAN ATV bV TARBIREDRA Y vy RETaT o
T2 TR VT IEHESNET, (WR— RSN 7740 ZA4T
.chm)

WE7 vy =7 FOBEOFEMIONTL, 4= [TFev=z/ b2/ 270 —7)
ZHEMLTLIEE N,

UFT 2T 7 EN5Y =¥ v bk« FR— b - Ty hOHEEOZEMITHONTIE, 142
R=V [FTaAf A b T7ANVOEE] 5L T EE,
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Extensibility Accelerator D7 A T CEH LIERIL, Y— ¥y k- PFR—Fr &b
DEESERT 7 ANVRIEESNE T, &7 7 A NVOEROMIIIBRE R ORB Y RN H
DT, BEAHEC B LEFETRET 2 ENEETY, I, D07 7
ANETEZETIAFIEHETAEEEITo70GA, e 2ET A AT V=T k-7
T AFITBREDOBIMRA I OER 2T 258 TXEY £

REITU FOEA

> Save All : A FTELIEIT 7 AN - =T 4 X T EREZRIFLET, TTO
XML 7 7 A /v & JavaScript 7 7 A VMETF SNV E T,

> Save (Z7AJ)): 77 AN =7 4 X EBIRLTRAET [Save] 2~ REHEHT
L, BIETZT 4 ZTHOTWDS 7 7 A VETBMMEESRET, TORICHOT 74
JVCRIGET AEFE I LIS, V=A% b - B —F - By NNTR—EDE
LET, 20X AR —%E, =F—--URF U RyicgEangd,

> Save (THAF) : THAFERINLUIRET [Save] o~ FEFEHATH L, 20
THA T TIToEER, BT 53 _TD XML 7 7 A /L & JavaScript 7 7 A /L CH
manEd,

BEOTRA-ATOzH b - VSRERET HEEDERER

TRTOTAN ATz b+ 77 AT 5 XML H#RIL, 120 XML 7 7 A /LI
BIFENET, THPAFTTEFEEITo7ZL T XML 7 7 A VBN TORWEENT,
FOEFIIMRGF LI 77 A VICERHSNET, 20, [Save] 2~ R&%E
TLET A FICEET 2R TN RIFEINE T,

KR LT, VAT TEEEITHT- & ZIT XML 7 7 A VRPN TW G EIE, &
FIZZDOHTXML =F 4 ZIZ (T 7 A M TIERL) BEXRAERES, #HEOF A | -
ATV b VTREERLT, TDOHH 1 2BEFELERS, =F 4 2 THMNT
W5 XML 77 AL, TRTDTF AL « 7= b+ 7T R THEE 250 TR
FENET, TOBRICA—HNELELAIE, =7 —- VAL U0 RUCHE SN
=

Z D7z, Extensibility Accelerator 7 A 7 CIEET 2851, XML 7 7 A VAT TEH
Ky 1ODT AL AT V=l b 7 TAOEREERZTNOHND 7 T ADEH 20
HZEEBEIDLET,
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JavaScript 77 1 VI3 L TEBMICTHOh S ER

[Properties] % 7 %721 [Operations] % 7 (Test Object Class 7% A F) TEREZELHEL
756, BIE T 2 JavaScript 7 7 A VTR A X T RNBIMEITEHFINDLZERHY F
¥, JavaScript 7 7 A VR EF SNDH DI, BEERGFET D0, THAFT0silo7 ¥4
T, TrAN, FEFUA Y RV T A= A B LIZEE T,

JavaScript 7 7 A VBN TV A IRETEOF O EE T L7-154, ZH T JavaScript
TTF A4 X TITORNET, 77 A0« VAT AURFEIND DX, [Save] 2~ FEEH
L& 2T,

T 7 ANVBEDPNTWRWES, BREILT 7 AV VAT NI L CHEE TODNET, 7

AN FTV2I N THA T TR ERELTRIFELRNI LI LERATYD,
JavaScript 7 7 A JMZXF L CTAT O ARITFE D £97,
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T HREL - Y—Lxy FOYR— FOERELIEIESHOHE

ZDHF XY TIX, Extensibility Accelerator ZfEH L TY—LF% > k « R —F - kY bD
VERR, #EF, T7uA 2T 7 ut A0 KEFHBHLET,
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DX AL, WOFIENREGENTHET,

36 _X— TRifEsM: - AR — N OFHH ]

36 X—Y NriE7rmy=7 N2, ERTD, 1A — b5
37— W Fy e BR— | s FOUSRTF S DEZ-F T a
37— TH—ay ha—A0FR— b OVERE 72135 5

37 X— [UFT ~OY—)F vk« PR—=bsDF 7o, FHEFEAAGDOZDD/R
r—4k)

ATREH - Y R— FDEE

SEMIC DT, THP UFT Web Add-in Extensibility BIE 74 K] Y —/L% v ki
%195 UFT AR — FOFHHEIOEEZ SR L T 7230,

fiRInozy bERLC, BT S A UR—FT B
BLVIEIR 7 Y =7 P aRERT 20y, BEfFO 7 vy =7 FEHEET,

> o 7e Y7 MEB<IZiE, [File] > [Open] > [Project/Solution] %%
L, weproj 7 my=s b« 77 A NESRLET,

> ZEoTavey bEHBREKRT 5121E, [File] > [New] > [Project] %R L,
[New Project] # A 7 172 + 7R 2 AT Web Add-in Extensibility 7 > 7" L — N & fiff
HALET,

TuaYxy MICHATE DD, BT, BFE, M TrDOHTT,
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> oY —nF%y PR —h ey b2 R—FLTHLWEE 2y =2 b
ZVERCT %121, [File]l > [Import Toolkit Support Set] #3#R L £4, FEMIIC
DN, 38—V [BEFOY— L%y b e BR—b -ty b2 R—1+T2
k) #BBL TSN,

T —ECEFATe Y27 NI OFEIT T,

3Y—ILFxy b -HR—F-TANRTAODEHE- T3>

I DUV T, 47 ~— TToolkit Support Properties 7 %1 F | ZZH L T 72 &0,

4 B—a Y FA—)LOYR— FOEREITEH

ZEIZOWTHE, 59— [H—ay ha— OV FR— NOERE - ITEE O FH )
R LT EE0,

5 UFTADY—L¥xy b - YR—+OFTAA, FLERFTOLHD/Yr—
21

FENZOWTIE, 143 X—2 [YV—Fy ke ViR—k by baT oA 455k
FHRLTLEEN,

HAB L« —Fy hOYKR— FORBEEFEETHIZIE, Fa— I TALEETLT
STEEW, FEHMIZHOWTIE, 145 ~<— [F 22— [ U 7L : Extensibility Accelerator % i
LA AZ L Web 2 b r—L DY R—FOMER] 2B LT &N,
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ZDH AT TIE, BEAFD Web Add-in Extensibility > —/LF% v b « R — bk &y &A1 v
R— b T 2HEEHALET, ZHUICEY, $FR—b -y FOT 7 A VEETH LW
Extensibility Accelerator 7’12 ¥ = 7 FMER SN E T,

F oA, L0EWLLDF R O—EE L TEITESNET, FEMICONT
1%, 36— [HAF L« V—=)LFxy hOVR— FOVERETITEHOHE] 23R L
TLIEEN,

ZDOXATIZIE, WOFIENREGENTONET,

> 38 ~X— [HiHESM)
> 39— [V—%y b FHR—F -ty hOA R}

> 39 X— TR

1 BiREH

A > R— ;95 Web Add-in Extensibility > —/L' % > b « #/K— |k « &~ ME, UFT I
TIaATHY—=LFy h YR — bty NOMEEZFFOLENH Y £ (THP UFT
Web Add-in Extensibility Bi¥EE T A K] DY —L% v k- FR—F -y bOFF A
DIEEBR),

F72bb, XML 7 7 A VHBFFEDOLENCH Y, JavaScript 7 7 AV, TA Y« 77
A, NIV« Ty ANTREZOMD T 7 A IVDOEETN XML 7 7 A VI E S
TWHRERH Y T,

BHRDY —LFy b« PR— K - By ML, ROBEEZRLET,

FI+ LS (UFT 4 >R k—JL>\dat\Extensibility\Web)
|
|---<Y—JL* v FH&>TestObjects.xml 7 7 1 JL
|---Toolkits 7+ L4 :
|
|--<Y—IL¥y B> T A LT
I
[---<Y—ILF¥y FE>xml T 7 ()L
|---JavaScript 7 7 € JL (# F < 3 > TJlavaScript 47 7+ L X [Z1RTF)
|--Res 7+ ILE (FA4AY - I7AILEED) (AT a>)
[---Help 7+ L% (.chm 27 A ILEET) (X FLa)
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2 Y- LEFxYF-YR—F-Ey FOSUR—F

[File] > [Import Toolkit Support Set] % &L, [Import Toolkit Support Set] 4 A
TRz Ry 7 ZAEFHALT, V=AF vk FR—b -ty FEBRLTA o HR—
FLET,

3 #8

Y= Fy bR — bty FOT 7 A R, FEER S 7172 Extensibility Accelerator
TV MIlabt—8hEd, a2 b 77 A LOBEOFEMIOVWTIL,
U= [ Tavxl b 2270 =7 ZBZRLTIIEE,

[Import Toolkit Support Set] %A 71 7" - ;8 27 A T [Open imported project] 73
RENTWEGE, FrLWBEY ey =7 A& E3, BRI TW RS THE,
ZATar « Ry 7 AFANWEEE2OT, BIOoYFR—K -ty hEA R —FTX
ij—o
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Z D7 4> KL, Extensibility Accelerator 7’1 Y =7 hTIEET HBICHNERT—F 7
B—%RLET, HAX LY —Fy hOVR— MOERE T 7 0 A (0 E e B B

BEador L, BUEOBRZMiRETR LE T,

M arkflowe
Add Test Object Class \ Edit Test Object Class
Create a test object class to represent the custom Edit the test ohject class details and
comtrol in UFT. /’ implementation functions.
)
FUERA% [View] > [Workflow] %R L £,
EE2 R 36 =Y (WAL LY =%y OV R~ N OERE - IZEHFO
ik
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WIZ, 22— e {2 BT 2 — RABER|ZONTEHALET,

Ul E%
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Add Test Object Class

ZOMEEE Y v TR, HLWT AR ATV 2T e TTR
BYER S ET,

FEHIZOWTIE, 59— H—a v he— LoV R— sOERE
FIEEHOIE] 2R L TSN,
BARTEINBEH] : T AL ATV b I FTAR TV
FT1OHEREINTWRNEAR,

Edit Test Object Class

ZOEEPAHRR RSN TV AEE, eV s FOBRERICH
HZlERLET,

ZOEMETIE, BIMOT AN ATV b 7T AEEKRLED,
TAN ATV T b 7T AOFM, EET AN, V—Fy
e HBR—F - TuXF o2 lemELEZY TEET,
BBFRINDIEH D RLEBLIODT AL - AT V=7 b7
TANTBY =27 FTERINTOIHA,

Deploy Toolkit Support

COfEME Y v THE, V—Fy b YR— kv b .zip
Ty ANMIT e SNET,

BEMICONWTIE, 143 5—2 [V—LFy ke BR—F -y b
TTuATEHHE] ESRLTIEIN,

BERATEEHE DL b 1ODFT A ATV b 7T R
NTaYzl hTEREINTVWDLHA,
BWREBRTEINBEHR : 770 A - a~2 RRETHFOBEA,
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®HS5Z-Fa—
ZOT 4 RO, BN TWnWASA eyl FTEEZEINTWVWAET AL ATy
e TFRE, H£T A FTVxT b 7 TRHLTEEREISN TV ARENE RS

WET,
Test Object Classes ar #
A webExtBook

A=) WebExtUsedBooks

Orperations
Select()
GaoTotuthorPage(AuthorMame)
GoToUsedBooksPage()
VA Vb Tavz s NRBMN TS & X, [View] > [Class View] #%
BIRLET,
EELGER ZOU 4 RUTHE, ROZEEFITTEET,

» TAL ATV b T ADBMETITHIBR,

» Test Object Class 7 A %<,

> TAL ATVl MMEOFEEa— FERL,

> TAL ATV MMEOT Ny 7 - 2y va OB,
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WIZ, 22— e {2 BT 2 — RABER|ZONTEHALET,

Ul E%
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Test Object Classes

B Tnwas 7 ry=s hTEREINTWHT AR AT V=

ke ZF20DY Xk,

Z ORETIE, ROEENTHETT,

» VR —DRFEMALT, TAN ATV b T TR
ZBMLZVHBRLZY TEET,

> TAN AT F e VTRAEXTNI Y v LCT AT %
B ZENTEET,

Operations

BIRLET AN ATV F - 7 7RTHLTERINLTVD
Btk

ZOfEERTIE, ROEENTETT,

> BfEa 272 Y v 7 LT Test Object Class 7% 1 %< Z &
N CTEET, TV A F1%, [Operations] ¥ 7 Tik4d 2 HEfEN i
RENTIREET 123V % BM) CTHEET,

» 17 U v 2 LT [Implementation Code] #3#&R4 5 L, HiED
JavaScript FEREEEEL 7 7 A VBRHEINET, 77 A NLDH
MT LGB E £,

» 477V > 7 LT [Debug] #8795 &, [Debug Test Object
Operation] #4717 « Ry 7 A (133X—=V% M) BHEE
T, FATaT Ry I AT, TAN AT VI b 7T
A LBERBEBICEIRS N TVET,
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® Joszyb-THRTO-5

DY 4 v RUIZIE, BAWLWTUY D Web Add-in Extensibility 7' 2= 7 b & $ 5 7 41
BT 7 ANRERENET, BV b V)V —HNOT 7 ANEL TN Y v L
TR ZENTEET,

Project Explorer - WebExtSample » I X
)/ ebExtSample

A Help
= | JavaScript
5] WebExtBook.js
5] WebExtlsedBooks js
= & Res
] webBook.ico
] WebBookList.ico
2] WebExtSample.sxml
2] WebExtSampleTestObjects. xml

TIRRAE [View] > [Project Explorer] %R L £,

FELER Tavzl eV —OHEBEEAEZ Y v 7 L& ZIC, BEHED Visual
Studio Shell 2~ > RO—HHBHEHTEES, IKET v =2 b T
X, 77 ALK, T ANDAE, 77 A NOEFTOMICERE ;RS
BRBONRHVEST, LENR-T, 7rY=Z M7 7AVEBMML
720, Z7ANVOAFIEER LY T5a~y FidEATE AL
o TWET, ZDX D 2ElL, Test Object Class 7 ¥ F %
LTIToTLE&EW,

FUHEHBT, 27V v 7325 LHHTE % [Exclude From Project]
avr RIFERA LN TLZEN,
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FuaYx s b AT 0 =50V Y —I2E, ROBHENHY £,

YY—+J—F

Bk

<7nozy ba>

Web Add-in Extensibility 72 =2 D kv 7« L)L+ ) — K

Help 7 4L %

A7 arTVT (chm) 77 A NVEELT FVE,

ZOTHANEDTFANME, TRV RDF AL - FT V=0 k
BEXML 77 AV bHERENET,

ANT-TFAN>

FE, EBLETAN AT b e JFADIALTHFAR « ~
TV D UFT O~V « 77 A )b,

Y R—bZNBIT7AIL 247 .chm

JavaScript 74 LS

7Yy RO JavaScript 7 7 A VEEHT T 4V H

TDTANED Ty ANT, TPy FOY—LFy FERE XML
TrANDLEBEINET,

<FRMFTOzH

PEER O SEHE JavaScript B2 G 7 7 AL, ERLIZET AN - A

b OS5RE>js TVl b 7T AH LT 12T JavaScript 7 7 A LV MERK
274N SNET,
XA AR — b LI=Z O JavaScript 357 7 A /L4, JavaScript
T A NENR SN E TS,
Res FFarTTAar I rANEELT FIVE,

IDTANEDT A ML, TuY =l hOF AL ATV b
BEXML 77 A M HBRINET,

<FPALaAr 274>

fEE, EBLET AR A7 V=7 b+ 25 ATk L T UFT 23MEH
THETAar s Ty A,

YR—bEhE3T77MIL 24T ico, .exe, .dll

<7avzH 44> xml
274N

Juavxy hOY—)LFy NRE XML 7 7 AL,

<7aPzy h&>
TestObjects.xml

274N

TVl MOT AN ATVl FERE XML 7 7 A b,
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®. [Import Toolkit Support Set] #4704 - Ky s X

ZOXATaT KRy 7 AT, BEFD Web Add-in Extensibility > — /L% v | « R —
k+ &y MTESWT, #H L Extensibility Accelerator 7’1 ¥ = 7 h B{ERTE £97,

1] Irnpart Toolkit Support Set @

Test objects XML file: . ChProgram Files\HP\Unified Functional T
Mew project folder: . ChlUsers\LTQANDocumentsiUnified Funct

Cpen imported project

| Import Cancel
VA Vb~ [File] > [Import Toolkit Support Set] % iR L £,
EELER AVHR— b FTBHY—LFy b FAR—b By ML, 38— [H]
G IR EN TV DBEEFONLERDH D 7,
BE2RY 38— [HEFEDOY — Xy ke YR— &y hEA VFR— T
2 Ik

WIZ, 22— e f X T 2 — AFER|IZONCHHALET,

Ul E% L)

Test objects XML file A R—F TEHEY—LFy N e YR —F Y NODTFTAK - F7
Yl NEE XML 7 7 A b,

New project folder FLnryavcs NEERT D7 4V,

Open imported project | > 7K—| - 7R AREFHICHK T LEET, HLnTry=s |
ERSMEIDEEELET,
ZOFTvarBIUTENTHWELRE, AV R— b DOETHLH
AT70as Ry ZFIENEEEROT, EFLOY—LFy b
A— b - &> | % Extensibility Accelerator 7’12 ¥ = 7 NNIA KR —
MLTEHBTEET,
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®_ Toolkit Support Properties TH 4 F

ZOTHFAFTTIE, UFTBZOY—Fy b« HR— b - vy MO 2 FIEICRE
TORECERTEET,
/ Toolkit Support Prnperl:iesl - X
Toolkit Configuration Settings
Caommon implementation file:  lavaScripti GWTCommon.js _ x
The file that contains shared implementation functions.
Toolkit priority: 100
Toolkit description:
Test object class priority: 0
[] Development mode - Override UFT Object Identification definitions.
VA VY:b: [View] > [Toolkit Support Properties] %R L £9°,
EELER > ZOXAT RS Ry 7 ATERLIZHERIE, Y—AFy b b
A—h &y hOXML 7 7 A MZRTFS N ET,
> ZOFAT S Ry I ADREFA T 3 T, FELRD
e, BYEREEMMEASNET,
BAES R 36 =V [HALZ L= NFy POV R— N OIERE T DO
Jiik )

47



E3BEHREL - Y—ILFTyY FDYR—F

48

WIZ, 22— e f BT 2 — RABER|ZONTEALET,

Ul E%

Bk

Common
implementation file

1E 2D FEEERIE) & IFF N & 5 3@ D JavaScript B Z EFRT D
77 A VO EE),

COMITEBAR T LI LI TEEEA,

(Import File] | == | % v 2 LC, #4773 JavaScript 7 7 1
NEZRL, BRL TSN,

TF 4y bRy s RE2 YT BHI0E [Clear] $ A& o %48 H
LET,

V=X FERE XML 7 7 A VANORIET 2 XML BHE 27 U
7 ENFETH, JavaScript 7 7 A MEI T Y =7 ML HIBRENE
A,

{RTEBAN : toolkit configuration XML file PN common_file &\ 5 4,
7™ Control\Settings\Variable %%

Import File : JavaScript 7 7 A V&2 SR L CEIRTE £7,

ELL T 7oA T52DiCF 77A4rn7ay=s b0
JavaScript 7 + VA ICFET DML ERH Y 3, LB ->T, Blo
G 7 7 A NVEBIRLIZES, TO7 7 A rOu—J)L - 2
v —3 7272512 JavaScript 7 4V ZITERR S E T,

AVAR—= b TDT77ANVDAFTNIDOT A NZIHLEFEDOT 7
A& —ET 5455, Extensibility Accelerator |%, £ > A — ~ L7z
T AN (jsPERTORD IV AR () EFRGFEMAMLUET,

Toolkit priority

V=X NOERE, BAZA a2 ba— Ui~y T EINTET
AR ATV b 7 TAEBRT AR, UFT IS ESF A
V=% NEEREOIEICHE > THRRLET EEARKEVLO
NN

RERENE : 100

F:o0xF 49 b Ry 7 RAZANTE 20K ELTTT,
BEHFR: V% v FRE XML 7 7 A /L O Controls 3% D
priority J&
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Toolkit description

Y—Fy OB, ZOHWE, UFTO [7 KA v 32—V ]
AT « Ry ATY =¥y b FR—F &y OB
MEIRI N2 L FITRRENET,

ZOY—=Fy b YR— by NERMAHICHET 25511,
B9 2 AW % 72132t % <7 Provided by f1 % & 8 £7,

F2, ZOHAIA—Ta rFEEEODTCHLINTLL D,
BREB\F Y —/ %y FRE XML 7 7 A /L0 Controls\Description
EES
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Y—ILFy bOYR—

Ul E%
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Test object class
priority

TAR AT V=27 PREXML 7 7 A VICEREINTWVDT A b+
FTV s b 7T AOEEE, ZOBEEE, 1ZH5D XML 7 7
4W&®@%(ﬂu%ﬁfﬁiéﬂTW5@@@?zﬁ'T7V1
7 k7T R) BFEETDEAEICERESET,

REREE : 0 (R b IRV V)

F:ZoxT 4y b Ry 7 RAZATTE 2035721 T,
BEBFHR: AL - ATV FREXML 77 A LD
Typelnformation %5 @ Priority &%

Development mode -
Override UFT Object
Identification
definitions

Z—PREABE—REFHALTCODENEI NERELET,

>’@ﬁfyaym %%&WT?~w%y%'ﬁﬁ~b-ty%
Al = I (e ) WZEIRLET, Zhicky, 7A b - 47
Yl b ”EXML 7 7 4 JLC IdentificationProperty 3 D J&
PeZEE L2GE, UFT I3 ThN T X TOEREZFEN L ET,

> EBIHERT 70l —AFy bV AR -kt l\%?ﬁ”tﬂ
ATHENE, BTZDA T arE27 VT LTLESN, 5
THILT, TAM AT V27 FRE XML 774’/&@"’“;357)\
A7V =7 OB XA T2 Ry 7 ATUFT O2—Hi)
ol BRI LT EEEINDIOESIENTEET,

FHMZ SV T, THP UFT Web Add-in Extensibility BiJ&& A RJ D
T FEHYR— FOEROHEESR L T3,

BEBH : TAL - AT V7 FEEXML 7 7 A LD
Typelnformation #5% ® DevelopmentMode &%
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®. Enumerations TH 4 7

IDOTFTYALFTTIE, BEOTa Y27 hOT AL « A7V 27 MMEDOFIEPRED EIZ
HHTEXAEDY A FE2ERTEET,

Enumerations v X

Enumeration Names o ¥

Name
Status

| Enumeration Values R T

Name Value
Open o
Closed 1
Disabled |2

TR EE [View] > [Enumerations] %R L £,

EE2 R PBR=T [FAR-FTP=7 b - 77 2ABEERET DA

i 111 ~X—2 [[Operations] # 7 (Test Object Class 7 1 ) |
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WIZ, 2—P A F T 2= 2ABREHHALET (T2 LOEHIL, [Lh v aTH

HET),

Ul E%

551

Enumeration Names

DY A kD4 H,
Z OREBICITROEE R H Y £,
> B 3 3% R Lo e IR A BT TE B YN —,
» Name : 52U 2 s D4,
ORI A% ) v LTARIERELET,
FT:ZoxF 4w b Ry 7 AiE, E=F, BT, M7y, TV
H—=2aT7 e AN TEET, BEVOXLFIIRTTHLLERD
nET,

BEBFT: 7 AL - A7V 27 FERE XML 7 7 A L O ListOfValues
B

Enumeration Values

[Enumeration Names] fHIk CHIERIR I TWDH U A MOIEEO

410 &,

Z OFEBICITROEE N H Y £,

> 08 3t I U romBEoBN, B IEFOEEZE
TTEDY— LR —,
BANL7-fEE, ®iCU R FoRRIBMSNET,

» Name : FIZ$IHE O 4 i,
ORI 2% v LTARIEmRELET,
(ZDx=F 4 v b~ Ry 7 AL, EFE, BFE ~AT, T
H—=R2aT7 2T w A TEET, YO FIEHTTH D LEN
by FET,)

» Value : JIZTEE OBEE, ZORy 7 2% 27V v 7 LTHEER
ELET,
RERFEME: VA MHOREBEOTEAOfE+1

BEEBH: TAL - ATV FREXML 77 A LD

ListOfValues\EnumValue 235
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ARBL-arbA—)ILOYHR—F

FEONE

N

> AR T ADEN (54—2)

> Extensibility Accelerator A1 k@ —/L D~ v B 7% T A M55 (562—)
» JavaScript IO T R 7 (573%—2)

BRY

> Hi—ar hu— oY R— bOVERRE TR O IE (595—)

> TARN ATV b IV TRET TV r—vary-aryia—Wi~vy 7355k
(612—7)

TAN ATV 7T AREERRT D HIE (73:3—)

TANF TV b 7 TAOERT BT 4 BEHET HHE (16/—)
TAN FA TVl MRIEOVHR— 2T A NLTT ANy 7T 55k (193—)
TRAT A REEEET A N LTF Ay 7T 50 (829)

< Y VY VY Y

Zr VA

[General] # 7 (Test Object Class 7 %1 F) (86~=2—2)

[Map to Controls] % 7 (Test Object Class 7 %1 F) (98~X—)
[Operations] % 7" (Test Object Class 7 %1 F) (111=—7)
[Properties] % 7 (Test Object Class 7 % A F) (1233—2)

[Debug Test Object Operation] %A 717 « iRy 7 X (1333—)

Y YV Y Y Y Y

[Debug Property Retrieval] # A4 7 a2 « Ry 7 A (135~3—)

NG TN a—TF 4 o T EHIBEE - 2 fa— O R—F (137—)
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[General] %7 (Test Object Class 7% A F) (86— % 5M) TTA L AT Vxs b -
7T AR EHRTHHGE, BERI)SRAEZEHRLET, 2, HILWT AL - AT V=7
ke 7 TABPERT BEGFOT AN ATV b« 7 TATY, BERETIE, T
TOWebT AL« A7 V=7 b+ 77 A1X WebElement ZJLE L 77,

BIRLIEAR Y FRAE ST, TAL - ATV=0 b - 7 FAONME A 7 LAIFHERE
BIEDIREY  (ERNTHRE L2 G 2 bR<), ROEEDHEFS N E T,

> BRI T AMBHEKENTEZT A S - A7V 27 MREEOVIHIE Y b, ZHh B0
[Operations] # 7 (111X—Y2ZM) IR RIS, A——F 4 FLEY, HEDOT
AR ATV MMEEZBMLIEZYTHZENTEET,

> TARN ATVl 8 JTRIEDDIDITERTEX LT a7 DY A b,
b O—EIX [Properties] % 7 (123X— V% 2H) ICFRRSN, BT a7 4O
EREBMULIZVET LI TEES,

> PAR—hLEO2ELTWDay ha—NZ, BRI FTRAZL>THER—FENDEHZA
7O HIML BENEGEENDHA, ERTDHT AL AT P07 b« 7T A1, kS
NIEBEE T a7 ¢ YR — b2 ELMA L E7. FFMIc oV TiE, [HP UFT
Web Add-in Extensibility BARE 7 A ] OBEFEDOT A N - AT V=7 b - 7 7 ZADJLHK
DOEEZL T 7EE0,
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FDTD, WOBITHER L TLIEIN,

> PAR—hLEIELTCWD Y ba— VOBMEICHEEIZREEE 70 X7 ¢ 22 T
HEAY S AEBRINUET,

> AV T AL THR—=bENDBHX AT D HIML HEHERa bo—/LIEGEND
ZLEEMRLET, £ TRV, MASINET AN ATV MEEBLIOY
a7 4 D9 H, WebElement IZ X » THAR—FENBWNEDTRTIIX LT, MED
FIEZHETOILERHD £97,

» Y R—hFLEIELTWEar bu—Z, A TRZLoTHR—FENDHHA

ZOHIML EZNEGENTWEE, ZThANar be—LAKERTEETRVIES
X, YRR ARELSE & KT JavaScript %A T LML ERH Y T,

EXRY)SRADERE

TARN AT b I TAOERT T AEEETH L, [Operations] # 7 Offfrk S
NEBED Y 2 N &, [Properties] ¥ 7 DAY FADT /"7 4 DY A NP HEIIZE
FEINET, BrbBn, £F, F—N"—F 4 RLIZEEST e T 11X, TOEFEE
v ET,

L7zl oT, 8EL7a T 4OV A N2 ERELTEETHOREAY T 25 RN LIZ5HEA
%, ZhoD) A MAEBEICARETLERHY £, ROBEEZEBLTLIIEESN,

> FEELLBRIEST B T 4o B, JET2H LW 7 R L CEyI TRl Tn5%
REENRH D 97,

> YR— T DHDUERHDLT AN A7V MEE, TAN ATV b2 7
AWK L 72 < oo TWAATREMER BV 77,
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> TAL ATVl b JTADEHT 0w NT 4 O—EN, FOREELHTNERS T
AP OAREA L TR ERH D £7, FILWERS FANRZ DT 0T ¢ P R—
FLTWBZ LEHERT DD, 20T T %) 2 SDOHIRT 50, TOfE%H
49 % get_property_value BI% & I B ICEIET A LERH Y £5,

> FTLWIARY F2ADOEEL T a T 4 OFEEWKTEX DD, HLWERS F 20
PR — 325 HIML EHER, YR —hLE>ELTWDHar he—lEEZhs54
T, £2, TOEZEN Y br—LEFKT HIML EETRWIEAE, %415
HTML 235 % K7 JavaScript B A 2T 20BN H Y £77,

& Extensibility Accelerator 3> FO—LOTYEV T ETR T3

ik
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REDTAN ATVl b« 7 TRAIKIET DALy ba—nNDOXA T EH#HINT BT
WCUFT MRS 2~ v B« = LRl Bz &G LI h, ZOBINRED LS I
ETH0ETANTEET, TD7HITIE, [Map to Controls] % 7 (Test Object Class
THFATF) 8=V EZM) A LET, UFT A A b= A ENTWDLHEITH Y
FHA,

= DT A b BB A2 FEONH T E 9 22O E 1T Extensibility Accelerator 3%
T2V 701%, HAXLAWeb 2 ba— LI L TCHERTETAN TV b -
U T AERBRT DO UFT BMERT 20y v 7 L LT, #H2oW T, THP UFT
Web Add-in Extensibility BAF&#H A RID A A% 5 Web 2o b — W2k L CHERT 5T
AN F T2 b 7T AORBFHITIED UFT ~OFEROEEZZR L TLEE W,
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JavaScript A E TR FTIROEBEEE :

> util AV v RRFEHTELZ01E, UFTO a5 X% N CETTIHATEIT T, L=
23> C, JavaScript 5B T _util 2V v RZFFERH L TW55E, BEEOT7 A o
BRIZIEFFOH LIRS T S E A, £OMRDVIZ, A Yy RFFOH L & Z OO L
THEINTZRNT A—F R ET D A v — ) Extensibility Accelerator O H 1w 1 >
RUICERRINET, ZOAvE—VEFHALCEEKET Ny 7 c&ET ([Debug]
> [Windows] > [Output]),

> kBB T Ny 7 - B — RTTIREOH S22V D T, Extensibility Accelerator Tt il
T X % Microsoft Visual Studio ¢ JavaScript 7 /3w 7« > — V&R U Cilpl B %k % 52
THIZT Ry 79252 LIETE LA, Internet Explorer ETFATLTWT, Zhbo
TNy T = VEER L CREEET Ny 7 LI GA, BB & S2km s LT
T2 =T A N« ATV =7 MREEAIFERRL, TA b - ATV =7 MED
TNy 7 ERIUFETEOREE T Ny 735 HERD Y £7,

& JavaScript EBDT/Nv Y

TAL ATy MMEL T 08T OB A FEHET D JavaSeript B AR L2 6,
Extensibility Accelerator Z#fEf] L CTENHET A ML, TNy 7 THZENTEET, Z
DI=DITIE, UFT A VA R— L3N TWHMEITH Y E8 A,

TV r—varCTEIRLEay ha—Licx LT, BIRLET AL - A7 V=7 MM
EZRETT 20, BRLIE T 0T 4 OEEZTFGFTE £, Extensibility Accelerator I3,
UFT RFETE Yy a v TITIDER UL 2T, AR — b DT OITHER S 7z JavaScript B
BEETTHIEICEST, TAR ATV MEEEFEITLIZY, T a7 1 Of
EWMAELZYLET, ZhICLY, FEEHLETR—FDOTANET RN 727520
T&EET,

JavaScript B3 AT S b & & 1T, Microsoft Internet Explorer T3AT L TW 25414,
Microsoft Visual Studio ® 3% @ JavaScript 7 /3 7« & v 3 3 > & [ JavaScript BI%KL
BTNy TEET,

72 & 20E, BEERFEITTARNCEEIC T V—I RA v FERELESAE, EiTey e
YIRT L= WA v MIBET D LI LET,
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£72, TL—2RA L FOBEMN, AT v 7 - a<wy ROMHEW-7=ZDfo [Debug]
Ama—Da<wy Ry — =% H L7720, [Watch] X [Output] & W\Wo7eT /Ny 7
BEOXEFIER T FUERMERHLEZY T&EEJ, FEMIC oW\ Tik, MSDN Visual
Studio ~V T A B L T EE W,

Mozilla Firefox TEITLCWDHEE, Ty 7 OEDIZHAA vE— V% 2 — RZBENT
HBZENTEET, a—FhbAvt—2 - Ry 7 A2 HEDIEIMNS, _util Y v
REMRHTZ L TEET, ZO5E, MO LAY Yy NEEIRTEANTA—F%
FeE9 D A v E— UM, Extensibility Accelerator D)7 1> K7 ( [Debug] >
[Windows] > [Output]) IZF/RENET,

o util AV Y RBMERTE 501E, UFTOa T X% X N CEITTIHATET T, L
728~ T, 24T L7= JavaScript BIEUC _util A Y v R~DOFFOHLAEEN TV EEHE,
TNy T e TR ARICRE L LIRSITENETA, TR0V, AV Y K
EOVH L & Z OO L CHEINTZ T A —F 2 R/ET D A v & — U2 Extensibility
Accelerator DD ¢ v RUIZFRENET,

B AT DEZONTIE, 79— [FRAK - A7 V=7 MEOYR— 2T X R L
TTF Ny 750k L = 7 a7 s BBEEET A ML TT Ny 745 5k
EZRLTLEEW,
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2R

T E—aY rO—LOYR— FOERERIZESHOSE
12OV —=)Fy ke PR—hr -ty ML, IRAFL o ba—LOEKOX A T Y
A= T 5008 EEHTT,

ZDOEART T, 1 20X A TOVKR— NEAERT D HFEEHRALET, R — T 5=
v RhE— A DFENENDEATIZH LT, ZTOXATEFETFTLET,

EHER{FT 5 &, Extensibility Accelerator |ZfEM A MGEL £9°, MERT —FNREL
TWDh, BRD7 7 A VOFEROBICT ERLR—EN RO -T2 s, =5 — - U A
b U RUICEZHAT A v E—URERRENET,

34 R=Y EEOBEHAEREDIA I T BB TSN,

DX A7, ROFIESEGENTOET,

> 60— THHEEM - BEfEO T 0 Y =7 P& H, BT aY=s b afEmk)
> 60 ~— TUFT Ta v hr— V& RTT AR AT Vx 7 b« 7T A5G

> 60—V [FAL AT V27 b 7 TAEMET LAy hr—LDFA T~y
LET, ]

> 60— [T - ATVx b 7T AREEZRFL, Ty LET,
> 60— [TALFTV=T b 7T AOBMT 0T 4 @G LET
> 61— T3y ba—/ T DO R— FDOEE - F 72 g )
>

61— [YR—bDOTFTTrA LT AN
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AREH -BEOTOD ) FEBLKH, HILLWITBD Y FEER

SEHICHOWTIE, 36— THRAZ L Y — Xy hOFFR— NOERE - IZEHO
Fik) OETe Y =7 FERL, fERT D, AR — T DEOFEEBBL T
X\,

UFTTaY hO—LERTTRE AT H b - HS5REBEH
a FILOWTFRAR 372V b 25 2%ERTED, BEDOT AN - AT V=
keI 2EREET,
> HLWTF AL AT Vxs b7 FREERTHITIE, 7T A E2—T [Add ]
RELEs )y LET,
> WEDT AR AT V=0 b 753 2A%FICE, VTR Ea—Tr T A%
BTNV w7 LET,

b Test Object Class 7+ F+® [General] # 70B&Ed, AL AT V=7 b -

7S5 ADLIEERL, VIETHT AL - ATV - VT RAFEEL, 4
varCEMo—&EREERLET,

PRI DUV TIE, 86 ~X— [[General] &7 (Test Object Class 7% 1 7)) | &5
LTL7EENY,

FAR ATz b 9S5RER}ET D2 FA—LDEAL FIZTYTL
9,

FHEMIZOWTIE, 61 =V TR F TP b VT RET TV — g -0
Yhue— vy 7T 5HE E2RLTIEI N,
TFAMFTSzH b USRBEEZREL, TNRYILET,
FEMCONWTIE, BR—V [FAN ATV b 75 2B ERRET 2L %
ZRLTL &,

FRA ATz - SRAOBHETONRT 2 EZREFLET,

I OWNWTIE, 76— [T AR - ATV b - 72O T 03T ¢ B HE
THHE] 2B LTLIEEN,
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6 A rA—IZHT BREHEOTR—FORE -T2 3>

a [General] # 7 (Test Object Class 7 %1 ) @ [General] ¥ 7 - Advanced Options
FE (92— %% M) T, [Record Options] Z MBS U TREL, = b
B—/UZK LTHRAET LA b2 Y v AT 572D FELE L TRET 285D
LHiERELET,

b JavaScript 77 A VT, A2 MEREEIEE, FifkE Y T a VIS R RFEAE
L7c & EICUFT BT A RV b« N RTEFEELE T,

FEHINZ DU TIE, THP UFT Web Add-in Extensibility BIFEE 4 A K] Otz 4 54
R— hOFREOHEESR L T IZEW,

7 YR—bOFIOLMETRE

FEICOWTIE, 43—V V=X v b P R—F vy T Tl T555E]
R T &N,

HAF L« ay ha— OV R— NORBEEHEETDHIZE, T=2— ) TAEFTLT
STEEW, FHMIZHOWTIE, 145 ~<— [F 22— [ U 7L : Extensibility Accelerator % i
JALT=H AL L Web b — LD R— FDOER] 28R LT EEN,

PFRE-FTCzH - 953RFF7TYr—S30-aY FA—LIZ
E&WA R Vb

ZDHAITE, TAF AT V2P b TR T DY E LT« L—ILDEFHE
TANOFEEZFHALET, v v 7« b—E, UFT BT AL « ATz k7
TAEEHT a2 va— VDX A TERLET, BRDHEATEN—Va DT TD
PFEGFR— T 572012, Bilx D —VEERTE £,

<~ BT =L DFEMIZ OV TIE, [HP UFT Web Add-in Extensibility BEE 4 A K]
DAAZ L Web 22 ba— U Ikt LTHERATAT AN - A7 V=7 b« 75 A0
1D UFT ~DOIROEAZ B L T IEEW,

FDoXRTE, LVEWVWLARNALOX A7 O—EE LTEITINET, sEMIcONT
1%, 59— [H—ar hag—LOHR— NOERELIZESTOHE] 28R LT
él/\o
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62

ZDXATIZIE, ROFIENREENTHET,

Y Y Y Y Y Y

62 ~— THIHRESA

63 =Y [T UFEEON =+ By bOZT &N - FT v =)
63— BT DL —IL D H A TG DS % B

64 ~— [ L« L—LDE v & HEIWER

64 ~— (= o v/ « L=V & TBTHRE- 47 a )

65— (=o' T e = NET TV r— g I LTT A ML, BERLER
L9,

RIREH
a YA hEEELET,

FEAMIZ OV T, THP UFT Web Add-in Extensibility BRZEE WA K] oY —L% v b
IZxt9° 2 UFT AR — hOFHHOEEZ SR L T2 &0,

HES o hun—LE2EL T T r—a UEREET,

Extensibility Accelerator 7’12 ¥ = 7 M ZBWZRET, YR —FrF 23 br—
EEL 1 OFERITEEOT ) r—va v EETLET, - UNEAICE— R E
n, BiET 53y ba— A BERENTNDLZEEHBELET (Web 77 U %
B < AiTlZ, Extensibility Accelerator Z T LT oY =7 NEHLENH D F
EDR

BEOT7 T U EYR— T 2560, 77V r—varafiihs 7 7 P CHRE
£7
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2 JSOYERADIL—I -y FDETEER-ATa

[Map to Controls] % 7" (Test Object Class 7 %1 F) (98- X— % £ f8) T, [Default
Rules] & 7 COHB~ v B2 7« =NV EAEL LTC 6, 1B LIcv—day he—
NWNETAN FTTPx2l b JTRIyTTHEDITTRITOT Iy THEHIN
gzj_‘o

BRI DT T OV A TNV a0k > T, UFT Ray ha— WA+ 5
v~ BT e =V EE ZTWEAETE, [Add Browser-Specific Rules] #7 V v 7
LT, Blov—noty hooHo# 7 %8N L ET, [AddBrowser] ¥4 7 a7 «
Ry 72 (109N—T%5H) PHE, 7790 FOMEIEETCEET,

KA TTROFEEZEITL T, HERL—LDOEy FEERLET,

3 BT BIL—ILDRA TIZHiET B/ ARILERR

a

b

[Map to Controls] % 7 (Test Object Class 7% F) T, [Default Rules] % 7 &
X7 7 U FEAOZ T ERIRLET,

VERRT 2= N DA THER L, ST IR VEREBLET,

fEFHAIRE72 % 4 7 : [Identify Control], [Call Identification Function], [Ignore
Control]

I D B2 A T ON— VAT D12, HIRT 23RN DENEN TROFIEA I
TLET,

% : [Call Identification Function] /L —/L®% » |k & [Ignore Control] /L — /L
Oy NEER LSS, a2 he— %27 5B UFT i [Ignore Control]
=Dty FEBEELET,

& XA FDN—)LE UFT MM 5 FiEOFEMICOWTIE, [HP UFT Web Add-in
Extensibility BRHE T A K] OB A X 5 Web 2 b —/LiZxt LTHEHT LT X
e AT V= b« 7T 2O ITED UFT ~DIFEROHEEZ SR L T FEW,
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4 IvEVT - =IOty FEBBER

ZOFNEE, FA—NMEH RN L, TITUVFEEOY T OZNEINTH &7
e

ZEHIZOWTIE, 67— =y - b—LDE v F & BERIIIER T 5 715
EZRLTLEE0,

IYEVT  N—ILEFHTHRE- AT a>

J—)v « =7 ¢ ZGEs ([Map to Controls] & 7 D& L —NAAERLSE AL OH, BIOT
ZUFEREOKZ T ONE) T, BEMER SNV — L EZFETEELEZY, HED
= NVEER LY TEET,

el 2E, WO EMTAET,

> L= LOBIEHIBRPTE ET,

> V= LDIEFEIFuY vy 7 2 EFECTEET,

> 7T A EICHT O ERKRBLZERL OL— A E—RIETEET,

> HEMER SN ERARBREZEEL TRHREZRDDLZENTEET,

=L, V= Fy FERIE XML 7 7 A AN OIET % Identification ZEF#E
Conditions ZFE IR IILET,

=)« TF 4 DA T T 3 OFEIZOWTIE, 98 ~*2— [[Map to Controls] % 7
(Test Object Class 7 A F) ] DL—/L « =F 4 ZFEROEA BB LT E &0,

EVbAREZ Ly LD B A%, f5ET D HIML # 7 % £7-> HTML
BWRICHIRT D52 LT, "I —~vr A2HETESEY, L, Zhdy—1Fv b
RET 7 A M3t L TFREITIT O BN H Y, BN L 72 EFE 1L Extensibility Accelerator
IR RENEE A, FEHIIC OV TIE, Toolkit Configuration Schema (UFT Web Add-in
Extensibility ~/V 7" 2 GFH FIEE) @ HTMLTags EROEAZSH L T 72 &0,
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FA4FEcAREL - FA—)LOYR—F

6 TYELY - W—NNETFTTIr—2aVI@LTTFAML, DELGSEHL
E3 8

BRIV DN—VZBNZT A R LTS, §R_XTOAL—LEELEHDTTAMTSHD
ERTEET,

WITRTFEONT N1 &2 FATLET,

1

120L—LDty FEEFEETICTFR T BICIE, ROFIEZERTLET,

[Map to Controls] % 7 (Test Object Class 7 %1 F) (98X—T % &) T, 7 A MT
LN—NDEy FERIRL, [TestRules] ZIEIRL EJ,
WOZEBREZD ET,
» Extensibility Accelerator 233EFR/RIZ/R D £,
> ZON—NDEy MIEST LTI THINTNETRTD Web 77U 7r—
YarvT, vy BT = I ETEHTRTOar br—ARRARR IS
F9,
%< OEE, TORET, JIOT 7Y r—3a Y EZIE Web ~—V &AW, Z
NHICBH LY TEXES, 7TV r—va VEREIS—UREFICe—NEhD
L, ToRTHL KT Har hu—AnmERIE T,
ZORRTHEDR—VICBBI L& 2L, X—UBRIEFIIr— RInZWEA
X, V= vET A NS By Y a U ERIGT AR, BOT T U TEOR—Tk
n— RLTRBEET,
oo r e — UEFHFER S D DI, Extensibility Accelerator TR Y = 7 b
ZRWERICBHINEZT T UFITRY £,
> i LEIC [Done] A& U MFRENET,
[Done] #7 YV v 27 L%J, [Map to Controls] # 7B, 77V r— 2 Tl
MBARNERINET,
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120L—L -2y FEFRMLT, BECKHLCTEHRTHICE, ROFIEERTL

7.

1 V- VETANTET 7V r—va v &R, ~—URELicn—Rah, BET5
I PR ARRREIN TV 2R LET (Web 77 vH &R <AL,
Extensibility Accelerator #E{TLC7rY =7 MR MLERH D £7),

2 [Mapto Controls] # 7 (Test Object Class 71 7°) (98— %&M) T, T A T
H—Dty FEFEIRL, [Test & Refine] #EIR L £,

WOZEREZD ET,
» Extensibility Accelerator 233ERRIZ/R Y £,
> THiE D LB [Create Rules] R4 & [Close] R U NERENET,
> L— L OHBEROE Yy v a UABBERET, ZOL—LDE Yy MY T LY
7 '7*)‘”6‘[1515]75‘%’(0‘:79?”'\”(0) Web 7 7V r—3a T, BBEO~ vy B T b—
WME—E T2 _Coay ha— 8 @RERE LTe—2 SRET,
3 LEOFIE 4RENEZEBVICEITLET,

FTRTCOL—NZEFEDTTRAITBICIE, ROFIEEETLET,
[Test AllRules] #7 VU v 7 LET,

BN TWAETRTDO Web 7 7Y r—2 30T, =y BT« b= LIl —FHT 5T
Dy ba— RRHETTRINET,

KX TON—E, AP THWET7 I U0 I LS T b0ICEAINET, &z
i%, [Default Rules] %7, [Firefox3] % 7, [Firefox 3.5.5] ¥ 735 554, B
T % Internet Explorer 7 « > K & Firefox 2 [ZIFIEHER T DO/ — LA S, Bk
TV 5 Firefox 3.5 7 4 > K 7|21 Firefox 3 L — V3 A SIvET,

EBIT, EREHSLONL—/LTHRIESNTWEEAL, BES S a2 ba— L oikil %
d 5701z, FELZHIEELFOHENET, &L, arbtre—ro7mx
7 4 7% [Call Identification Function] /L —/L®O+t v MIEHZ SN2V —IL &7
B, FEEFA—AR I OLERIN T ARWEAE, SAEEAEOH S ET,

56 ~X—3’ [Extensibility Accelerator X 1> B —/L D~ v V' 7% T A NS5 HE] b
ZHRLTLIEEN,
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P wybELs  L—L0ty FEEBNICERT BHE

Z DX AT T, Extensibility Accelerator ZffH LT, 7A k- ATV 7 |k« 7T AN
RISy va—LOX A TEHNT D1 O2ONL—)b - &y N EBEIICERT S
FEEFHLET,

Z DX A7 1%, [Mapto Controls] # 7 (Test Object Class 7 %1 F) (98— % &) T,
BN— AR ANV &, T T OFEGDX T DENEILTHI A IZITWET,

T 20X 271, L0EWLLDF 27 0O—8E LTEITENET, FEMICHONT
X, 61 = [TARN ATV b VT RET TV r— g earyba—Livy
TTDHHE) ESRLTLEEN,

ZDOXATIZIE, WOFIENREGENTHNET,
> 68— [HiHESM)

> 68 ~X— [ [Select Controls] R¥ %27 Vw7 LT, arvie—ERltyiarz
B4R )

> 68— TN TWET F U r— a0 bicw 7 2B

» 10— [ZDOTAN ATV he VJIFGATYHR— DXL TDary br—L
YA

> 71— [[Select] R¥ %27 Y v 7|

> N A=Y RILTAN ATV I bV TATYHR—FTHIEND2 FE—LE
BN L £, )

> 28— Tay ha—LOBRELEE -7 9 )

» 72— [[CreateRules] R¥ %27 Vw7 LCTrEA%E%ETT 5, [Cancel] K
oIV L THFy BV LET,

> 72— THER

67



Ea4B.HREL -2 FA—)LOYR—F

1 AiRSEH

6l =Y [TAN - FT VT b I TRET TV r—ary-aryhba— vy
TIHIE] ORGIO 3 >OFIELETLET,

TV r—va v BFITTAH T T UY T, A7 YT FEIL ActiveX 2 hr—LD
EITNENNC > TWAZ L AR LET,

2 [Select Controls] R4 %9 YwH LT, avrA—ILEREYaVE
BA

Extensibility Accelerator 233 /RIZ72 0, M O LI [Create Rules] & [Cancel]
D2ODHRE U REREINET,

3 MM TWB7Z TV —2 3 DEICIIREBE
2R B AR E LRICEDY £,

TV =g VNTY I RAERE N -ay ha— LR B\FHF RSN, Z0Oay ha—
NERT HIML BEREOARINETRINET, ROKTIE, WFAERINZT A R
e ay b — LT 5 INPUT HTML BEENE RSN TWVET,

-2 http://newtours.demoaut.com - Find a Flight: Mercury Tours: ... |Z||E|fg|

al

File Edit View Favorites Tools Help
Type: = Round Trip ' One Way

Passengers:

On: |September v||25 V|I

Amving In

Returning: |September v||25 V|

|

Preferences
Service Class: [ERBINNUN class

[.] Business class
) First class

Airline: | Mo Preference V|

ﬁj 0 Internet

| £

=
|
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EVbh: Z05E, EOCRLF—%2MTZL7T, HILBEOKRA X EEHEDR
AVEIIZEZT, 77V r—varO#fE Bl Web X—TU~OBE), V2707
Vo2, ZF 4y~ Ry 7 AOEREEROANT], FryTET « YR ELLO
IR YY) 2EITTEET (2770, CIRLF—RIHENTWEH =027 T 7 DOEME
NELT HAREMEDN D Z LITEE L TLIEE W),

TOHETHEDR—JICBEI LI L X2, X—UREFIce— FEh2WEas,
ay b= LERIRT Iy v a U EBRBET RIS, NOT I 0P TEOR—Tk
oD—RLTEEET,

D Web ~—IZBE) L7254, W R—UN5meicn— REn5 &, MFARRD
Tt A FFDOR—U TGRS E T,
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4 TOTFAR-FTSzHO - HU9SATHR—+TB24T0Oa> 00—V E
2099
[Selection] A 7 a2 « Ry 7 A (107—2%BR) N7 7790 EEICHE, &
W L7zarybe—Va2RTHIML BEEZDO T v X7 4 BRRRINET,

<2 http://newtours.demoaut.com - Find a Flight: Mercury Tours: - Microsoft Inter... |Z||E|fg|

Elle Edit View Favorites Tools Help

Passengers:

Departing From: | Acapulco v

0 :|September v||25 \'| =l e

Returning: |September V||25 V|

Preferences
Y o INPUTUNSMM Conto1 |

=

tag:

@ Business class O

(O First class FONT
LFONT

Airline: | Mo Preference V| I-|INF'UT|

Properties
| CONTINUE | name sernvClass
taghlame INFPUT
.
© 2005, Mercury Interactive (v. 011003-1.01-058) V“’jje =

<
:Ej 0 Internet

ZOEALTRT Ry 7 ZAD FERICIE, 22 hr—/Lo HTML JEJEHN O % Do 3isE
NERENET,

X RRSNEWENOEFELERT 5L, TOEBEOT R AT (2RRLIZY, =
YRRV ERTTEDICEDOEREZRRLIZY TEET,
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5 [Select] K22 ZEH )V

BIR L3y he—ARNT Y r—3 gy ClRERTEINNET, KOKTIE, V4
RE «ay ha— LB IR I TVWET,

- http://newtours.demoaut.com - Find a Flight: Mercury Tours: - Microsoft Inter... |Z||E|rz|

File Edit View Favorites Tools Help i

Type: & Round Trip © One Way

Passengers:

On: |September V||25 Vl_
Arriving In:

Returning: |September v||25 Vl

Preferences
Service Class: |@|Economy class
| O] Business class

E First class

Airline: | Mo Preference v|

© 2005, Mercury Interactive (v. 011003-1.01-058)

4]

I@ Done @ Internet

6 RILTAL -ZATCzH - HSATHR— LT BEFI DI FO—)LEE
RLFET.
RUCZATDarybho—Le LTHIMERDY, BOT 037 ¢ B2 TWDINR,
FIEO—H PR DO b — /LB L £7, Extensibility Accelerator 23 /ERK
TAHL—LOMWE L TEHRSIE, BIRLEay e — O e FDSEENEC Lo T
EhEJ,

7
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7 AV hrA—ILOEREEE-ATPa Y

> a2 bu—/LOBEREMRT H121E, [Selection] ¥ A 710 r « Ry 7 AT b
n—/NL%27 U7 LT [Delete] 27V v 7 L7,

> BRL/-ar bo— AR08 HIML BEE A2 EET D120, 2> ha—
NE27 U w7 L, [Selection] AT 17 « Ry 7 AT RENTZPER—EHSHEY) 72
WHEEEIRLC, [Apply]l 27V 27 LET,

[Create Rules] K2 > &5/ Uy H LTTORERTTHH, [Cancel]
REAVEY I LTEFYoEILLET,

ay b —LERE Y v a VBT LET,

9 #ER

[Create Rules] #7 UV v 7 L4, ROZ LRIV E4,

> BRLIZTRTOay hr—MZEBO 7 a7 1SN T, ZOTF A 47
Vb I TRHT DY v BT - L—)L7) Extensibility Accelerator (2 &> T
RSN ET, BIR L7y hr— VORGP EBROT 7T 4 B Fo8E, £
LSOz b — VA — VOEROBRICER SN D Z R H 0 £7,

TER SN Te— iz, RBIUS U TERREBREENIHENH D T, Ttz
1%, ASPNET @ Ajax 7 a2 —5 4 A4 « 23L& 2 HZBIRL, 1 OB RS T
T (className = accordionHeaderSelected) T, & 9 1 DB ER LTV
(className = accordionHeader) &, 1R V72— WITITIR O TERI RIS
W& FNFET : className equal accordionHeader*

¥E : [Map to Controls] % 7 D Z D /RFMIZURNZE ENTW 2 L—E,
TEEHEIONET,
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> oV hur—l@T L7 e T A BRE LTV DEEIE, V—WIER SN E
A,

EVbh: B4 T70ar ba— LV EYR— T ODICRLETARN ATy
ke 25 2EERTAHIIE, ZOHB X2 EALT, 150X FDar k
0=V EZHRT DN —VEAER L ET, RIZ, ZON—LEFETRELT, Or
7Yy 7 And NotEqual =¥y 7 2 B C— LB+ 5 2 L2k, o
A T EXHBIEDET,

> TV r—a U CHFARRAMER SN E T,

> JL—/LiX [Map to Controls] & 7 D/L—)b « =5 ¢ ZFEIRICR /R I, YV—IbF
F&%E XML 7 7 A LINORE$ 5 Identification 3% @ Conditions Z3E (238N
SnEd,

P TR FTSH b HSRBERERHT DIHZE

CDFATTIE, TAM - ATV=T b 7 TARYR— T LHBEOER, FE 7
Ny 7o)k aH LET,

FZoOXARTE, LVEWVWLNLOX AT O—EE LTEITSINET, FEMIIOVT
1%, 59— [H—ar hbog—LOPR— NOERELIZERTOSE] 28 LT
W,

ZDOXATIZIE, WOFIENREENTHNET,
> 14 RX—Y [ZDT AN FTVxF b« 7 TANRYR— T 28EDY 2 FDEF]
> 5= [FAR - A7V =7 MEFEAL IS S JavaScript BIERDFRET)

> 76 = REOT A NET Ny 7
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1 COFARM-FTSzO b - 9FABYR— T EBEOIY R FDER

[Operations] # 7" (Test Object Class 7 % ) (1115—Y & SM) T, ROFIAXE
TLET,

> BAEZBIMMEZIHIERT 20y, A= =T 4 FT DAY T 2B EZ BN 7,

WOEMENMT-ENTWBEE, AT 7 ADEED 55, WebElement 7 A b -
F T2l b TALE o THR—=FENTHRNE DT RTELS—N—=F A
TAHLENHDHZ LIZEELTLLEEN,

> PR—FLEHELTWBay he—AR, BHAZFR Lo THR—FEh
5 HTIML BFEDOHX A T TEIN TR,
> %M+ 5 EFEE UFT (2K T get base element B & 323 L Ty,

ZOHE, A= =T 4 RLghom8EL, 7 A MERETIEICIIEH T £
T, FEShERAL, CNOOBEEZT AR« AT v AT &, EiTH=
F—NRAELET, MOV TIE, THP UFT Web Add-in Extensibility BAFE# 4 A
K] OBEFOT AN « A7Vl k77 ADIIROEEZSR L T EI W,

BINEITA—NN—=F 4 RLEBRIEIZRH LT, A Yy ROBL L, 7 a Tl
nEREERLET,

IDTANFT V2T b TAOEMEREOBIELIEELET (X7 a ),

TRUERE D|RIEZ BIR L 2o 1256, AR 7 ZADBHEREOBRIEDNHEH Sh
gﬁﬂﬁo

ChOEDEEDI7AIN~DOE -

> ZOXTTEZRBLIEERIE, V—AFy b PR R—h-Ey FD XML 7 7 A /LT

RIFSHET,

F LWEED JavaScript BAELA ¥ 723, #%%43 % JavaScript 7 7 A /VITIEM S 4L
357;_‘0

> B EEE LT-BIED JavaScript BB AR EFHF I NE T,
> HIlBR L 7=#ED JavaScript BI%iX, JavaScript 7 7 A A HHEIBREINEH A,


WebExtJavaScriptReference.chm::/js_get_base_element.htm
WebExtensibility.chm::/WebExtDev_extend.htm

F4E.HRAL - FO—LOYHR—

FoEEMA a0 [Implementation file name] & 7z 13 [Implementation function
name] % /EF L7354, Extensibility Accelerator | % JavaScript SEHEREH %2 E B L £+
loe TIDH, BEEAZTIX7 7 A MBS T, BIEOEL F121
[Implementation function name] + 7" 2 V2 F L THMEKOBLITTH SN E
A,

FEAIZOWTIE, 34 = TEEOBEH LIRFOZA I 7] ZBRLTIZIN,

2 TR FATTxH MEHEZEZRET D JavaScript BIEIDERET

a [Operations] & 7 (Test Object Class 7 F) (111X—T %25 M) T, #{ELEREIN
L, [Implementation Code] "% > %2 U v 2 LE7, JavaScript =7 ¢ &% (22
A= BM) T, JavaScript 7 7 A L OXFIT 5 JavaScript BAEX OB FT A A
\ij—(j

BOFEELT, Zuv=r b7 A7 0 —F TiEX4 3 5 JavaScript 7 7 A V%
XTIV Vw7 LTS ZELTEET,

HEYERE T, JavaScript 7 7 A VOZLENE <TFAM ATz H b HS5XE> s

Thy, RETHEHOLFNIT AL - AT V=7 MUEALFRILTY, b0

4 i, [Operations] %7 (Test Object Class 7 %A F) OFMMA 7> 3 L TEET

%i?‘ T WA FFE72id JavaScript 7 7 A NV CREBA EFEH LIZGA, OO
G CHLENTO2MLERH Y ET,

b = e IHLTT AL ATy FMEIEEFEITT 2 L 51T JavaScript BI%
FRIELET, SOV TIE, THP UFT Web Add-in Extensibility Bi¥&38 474 K]
DTAN F Tz b AV ROV R—bOFEEDHEZBHL T ZI0,

HLWEEL A= =T 4 FSNDEAEDOT X TITH LT, JavaScript B$ A 548
THVENDY £,

75
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3 BEDTRMETNRYYT

M ONWTIE, 79—V TR - F 7V MR EOYR— 1+ 2T XA LTTF
Ny TFTBHHE] #2RLTIEIN,

P FRFATOCH P ISROBETONRT 4 EBHTI5%

76

IDHARATTIE, TAN AT V2T bk« 77RO T aXT 4OV R—FE2EFHRL
TRETIHFEEHHALET,

F oA, L0EWLLDF R O—EE L TEITESNET, FEMICHONT
1, 539 =Y [H—ar ba—LOVR— FOIEREITEHFOHE] 28R L T
SYAN

ZDHAZITNE, ROFIERGENLTVET,

> 16—V [FTAL AT VxI b I TZAORHT 0T 4 DY A % ERE]
> 71— [ 7 a7 ¢ BER S35 UFT ORERE % 8 7E

> 77X TRB#H T T 4 DYV R— b OFEMA TV a v B EHE- AT a )

> 77T = [FTFREDOF T V=27 ORI 7T ¢ OIEA TSI 5 JavaScript B
AR

> A= [T mT 1 OEZ ST 5B ET A L TT Ny 7 LET

1 TR ATz H - HISRAOBETANRTLADYRNEESE

[Properties] % 7 (Test Object Class 7 WA F) (123 X—Y &2 HM) T, 7o X751 %
BIMEIEHIBRT 22y, A LTI A MIEDLIERS TADT r T ¢ ZRINL
£
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2 JONRToRMEREINS UFT OBEEEIETE

[Properties] % 7 D /E{flo> [Properties] U A D, HAIOEK T —F o7 a7 4
EFBIMLET, 2L, TAF ATV bRBRIZEDE e T 4, Ty IR
AV P THERLTHNMEER T2 a7 4, 2A~—  BICERT 27
TABREETRLET,

BEBIORT DY R—+ORMFT T avERR-F Ty

FEMIZDOUNTIE, [Properties] & 7 (Test Object Class 7 %4 F) (131X—T %2 &M) ©
AT Y a v OHEAESHLTSZE N,

ETEOAF T FHLRBETA/NRT 1 DIEZFIET S JavaScript BIE
ERE

a [Properties] %7 (Test Object Class 74 F) (123 _—T%&H) T,
[Implementation Code] % > % 7 U » 7 LE 7, JavaScript =7 « ¥ (23—
ZZM) T, JavaScript 7 7 A /L D%t T 5 JavaScript BB DL FT B E T,

REH7 V) 7T HRNCT 0T ¢ BB LTEGE, BN T 587 v a
COGETNBE £,

BOFHEELT, 7auv=r b7 A7 v —F TikX4 ¥ 5 JavaScript 7 7 A V%
TN Y7 LTS ZEHTEET,

YR E T, JavaScript 7 7 A VOZENL <TFAM ATz H b HS5XE> s
ThY, EiETLEKDOLATIT get_property_value T3, Zh 56 DO4 AT

[Properties] % 7 (Test Object Class 7 % ) @iiﬁ‘ﬂiﬂ'j)f/ a vy CERETEET,

T YA FE721X JavaScript 7 7 AV TREEAEERH LGS, 5 D% TYH
BT 2 0ERH Y T,
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b T 0 T ¢ OFITREOME A G 5 JavaScript BAE 2 4 L £, FEHIIZ OV
Ci%, THP UFT Web Add-in Extensibility BAZ#E 7 A K] OFET 737 4 OV R —
FOEBEOEE SR L T ZEW,
WOEBNRWIZINTGE, TARN A7V b 7 TRTERT T AND
get_property value O34k L E 7, ZO%4, (BT 28Xz 07 mx
T4 DEZEET A0EIETH D £H A,

> P R—FLEYELTWDaY FE—RERY TR L STHR—FEIND
A A4 TOHIML BRTEIND, £1E, TOXIREZEEATHNT, TOD
PR % UFT [ZIK B2 523k LT,

> A7 T ANE CAHORBMT 08T 4 &Y A= T 5,
5 BRITONRT A OEZRETIEBZETRALTT AV ILET,

FERZOWTIE, 82— [Fu T s BEEEET A N LT Ny I 55 %
ZRLTLL7EE0,

78
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T FREATS1H FMREOYR—FETFRARLTTFNAY ST BHE

Z DX A Tl¥, Extensibility Accelerator N/ 57 A~ « A7 V=7 MREEZTFITL T,
JavaScript EEERHKET A ML TT Ny 795 FikESHALET,

T oo RZE, K0VEDNLVOX RO E LTEITSNET, FEMizoWT
W, BRX=VIFTAR ATVl b7 7 RAEEERFT 25 #2B L TLEIN,

ZOXATITIE, WOFIEREENTHET,
> 79— TRIHESA:)
> 80 N— [FEIEPAMICT L —I RA UV bERE- AT a )

» 80 ~X— [[Debug Test Object Operation] XA 70 « Ry 7 AT, ETTDHT AL -
XTI kIR ER RN LU E T, |

> 81 = EEDMGR LB T 7 r—ray s arybo—LEBRLET, |

> 81 X— TH{EE 1T

1 AiRSEH
a Microsoft Internet Explorer TEIT L TWAHE, 77U TRAZ YT hOT Ny 7
AL TSN,

WIZHl 7~ LE T, Internet Explorer 6.0 £721X 7.0 C, [Y—IL] > [1 V3 —2Y
AT ar] ERRLET, (BEMERE] ¥V <, [F539X] F/A—T0 [R
HYVFTROTRYTEERLEWN] 7> a7 07 LET,

b BEE2FETLTTAYITET7 T r—va 2, S—UNRERICe— X
n, BES ay he—RERENTWDEZLE2HERLET (Web 77 U %
B < BT, Extensibility Accelerator Z5/TLC7ry =7 R MLERDH Y £9),
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€C TALN FT V2T M 7 TR LTL—)L s =F 4 ZIZEREINTWDHL—)L
N, BEET ANy 7T 5ar b — L EIE LT D2 L 2R L £,

[Map to Controls] # 7" (Test Object Class 7 %A F) (98X— %5 [) T [Test All
Rules] #27 Vv 7 L, 77V r—varTary ha—ARNERIREIND Z L%
RLET,

2 EEBBIZTL—IRIVMERE-ATVay

Microsoft Internet Explorer TFEAT L TWTC, B fEZ AR — M 572 DIZ5RE L2 BA%IC
FELTEXICE Ty v a v —RHEESE WA, BSOLEICT L — 7 RA
VREBINTLZENTEET,

T L —27 KA N EIBIT DITIE, Extensibility Accelerator T fl T & % Microsoft
Visual Studio ¢ JavaScript 7 /3w 7« > — )L EFER L E T,

3 [Debug Test Object Operation] ¥4 7R - Ry H AT, RFTFTETR
ATz H - HSABEEZRBRLET,

a ROFIEOWFRNEEITLET,

> VT A-Ea—T, BEE A7 Y v 7 LT [Debug] %R L E 3, [Debug Test
Object Operation] & A 712 « Ry 7 A (133X—T%5MW) MHE, 7A - -
AT b 7T RAEBENRIRSNET,

> [Operations] # 7 (Test Object Class 7 %4 F) (111X—T % HM) T, #fEY
A M SEEEER L, fE) 2 kY —/s3—@ [Debug Operation] 7R %
%27V v 27 LET, [Debug Test Object Operation] &4 717 « iR v 7 ZAHEH
X, TARN ATV b7 TREEERBRINSINET,

> [Project] > [Debug Test Object Operation] % 4R L &4, [Debug Test Object
Operation] A7 R7 « RNy 7 ARENH, TAR - FTVx7 b7 TR
LFITTOEAEA IR L 97,

b IR LUIBEPSIEEZIWMDEE, BIROLH, A7 anl b, LERME
DEA TNRIZFERSNET, BERGE, BECETSIROBEANLET,
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4 BEORFELDZT7IVS—ar-arbA—ILEBIRLET,

a [Debug Test Object Operation] %A 7 1 7 - 78 v 7 AC, [Select Control] %7 U v
27 LE7, Extensibility Accelerator 23FEFR/RITA2 D, BN TWDFTTHD Web 7
TV = a Ty BT T 5T R T Oy b r— L RHRER R
&, EEOEEIZ [Cancel] R v inFranE 1,

%< OHBE, ZORRT, MOT TV r—va v EiiE Web 2=V EBWEZD,
FNHIBEI LY TEET, 77U r—3a VERIIR—UREFICn—FEn
e, FOPRTHL—HTHay bn— U RNEEERINET, ZORFFSETBEITS
(21, CTRL ¥—Z T MERH Y 7,

OB TRHEDSR—JICBE LT L &g, X—UREFICn— FEn2WiEs
1%, [Select Control]l #7 YV v 7 T 5HZ, BIOT I U TEOR—TEn— K
LTRBEET,

Ear b ADSBETAFR SILD DX, Extensibility Accelerator TV’ Y= 7 k
ZRWIZRICENTZT T ORI £,

b #fEoxRLRDar hrn—na2s )y LET BHFRSA TS br—
ND 1 D& BT LLERDHY £,

7TV = a TR DMERR X4, Extensibility Accelerator 238 %, [Debug
Test Object Operation] Z A 7 B « Ry 7 ANRERINET,

5 BEERT

[Debug Test Object Operation] %A 7 1 2 « 7K v~ A2, [Run Operation] %7 VU »
27 L'¥9, Extensibility Accelerator 73, R L7z ha—LZ&t3 57 A - 47
Tl MNREDFAT R L, BAED JavaScript FEEERIF A FEONH L E T,

Microsoft Internet Explorer CEIT SN TWH 3 ha— Ikt L CTEEZET L=
4, Extensibility Accelerator Cfifi H{ T X % Microsoft Visual Studio Shell D7 /3w 77« >/ —
NEMHA L TEEOT Ny V7 Z2aT& £7,

Mozilla Firefox TEITINTWD 2> b u— Ukt L CEEEZ FEIT LIZGE, T3y 7
DDA v =V a— RIZBMT5ZENRTEET,
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T TanF RBEAKETANLTTFNAYSTTEHE

82

ZDHATTE, THVr—varNoaryha—Lhb7rans o OEEEST 5 X
9 |Z Extensibility Accelerator |ZF5~9 2 FIEZHLET, ZNITLYD, v T 1 OfE
ZHUFT 5 72T L7z JavaScript EEBIK 2T A ML TT RNy 7/ TEET,

T oo RZIE, K0VEDNL_VOX AT O—HEE LTEITSNET, Gz T
X, 76 =Y [T AN e ATV b+ 7T AQOEBZT 0T 4 BRKFTDHHE 25
LT &N,

DX ATIZIE, WOFIENREGENTHNET,
> 82 ~— [HiHESMt:)
> 83— TFEEMIZTL—I RSV FERE-F T 9 )

» 83 ~X—’ [[Debug Property Retrieval] 4 A 712 « RNy 7 AT, BFHTH7 237 ¢
SN

> 84 ~N— [T Fu T A {la2fFoT7 F U r—ar - ar ho—/L 2R

> 85 X— [ a7 ¢ il % Hif5)

1 AiRSEH

a Microsoft Internet Explorer THEIT L TWAEE, 77 UYWTRAIZ VT hOT Ny 7
EAPCL TSN,

il : Internet Explorer 6.0 £721£ 7.0 C, [Y—I] > [AY4—Ry kF T a V]
ZRINLET, [HERE] ¥ 7 C, [TI30X] /—T70 [ROUYTEOTF Ry
TJEERLEGW] A7 arvizs7 V7 LET,

b 7o T4 OEERET LTSV r—varwllE, S—UREalir—Ranh,
BT 5 hr— b RRRINTNDZ L 2R LET (Web 77 U EBAL
BIIIZ, Extensibility Accelerator (T L C7 Ry =7 &R YLERH Y 7)),
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€C TALN ATV V F e VTR LTIL—)b s =F 4 ZITERENTNEL—L
N, TuaRTF o ERETSIay Fe— A3 ELBNTI2 2R LET,

[Map to Controls] % 77" (Test Object Class 7 %A F) (98— %5 M) T [Test All
Rules] #7 Vv 7 L, 77U r—varcary ha—R@EHR RSN L%
RLET,

2 EEBEKICTL—IRSIVILERE -7 T3y
Microsoft Internet Explorer TFEAT L TWT, F'mNT ¢ OEZ ST 572 OIT5RE LT
BT Lo L I2FATE v v a v RIS ETWGEAIE, BT L—27 RA
VNEBMTAHZENTEET,

TL—27 KA N EIBIMT SITIE, Extensibility Accelerator T fl T & % Microsoft
Visual Studio ¢ JavaScript 7 /N 7« > — )L EFER L E T,

3 [Debug Property Retrievall] ¥4 7R% - Ky Y X T, M/TETAN
T 1 ZER

ROFMADONF NN EEITLET,

» [Properties] % 7 (Test Object Class 7 A F) (123 X—T%HH) T, Tux
TA VA IPOBET AT 4 2BIRL, 0T ¢« UZXRDOY —8—
@ [Debug Property Retrieval] "% %27V v 7 L7,

[Debug Property Retrieval] 44 7127 « Ry 7 A2 (135 X—U%5M) M,
TAR ATV T b 7 TFAETRRT A PBRSNET,

> [Project] > [Debug Property Retrieval] %% L £,

[Debug Property Retrieval] A 722 « Ry 7 ARFNZH, TAK - FT7 V=

I b 7 TREEGT DT BT ¢ @I L EJ, JavaScript B TY AR — &
REt LT e T R EEIRLET,
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4 BRI EHIONTAEEKROTIUr—Yar -2y bO—LEER
a [Debug Property Retrieval] #4712 « Ry 7 2T, [Select Control] 27 U v 7

L 7, Extensibility Accelerator BIERRIZ/ Y, BN TWDTSTHD Web 77
Vr—2arTey B 7 =8I 2T TOay br—L5iiEoR S
, O EEIZ [Cancel] R U BRFRINET,

%< OHE, ZORRT, MOT 7Y r—va rEIE Web X— U EFNWED,
FNHICBEI LY CEET, 77U r—a VERII—VREFIce— &R
e, FOPRTHL—HTHay bn—AREEERSNET, ZORETBEITS
(21, CTRL ¥—Z T MERH Y 7,

OB TRHEDOR—JICBE LT- & &g, X—UREFIcn— FEn20WiEs
1%, [Select Control]l #7 V v 7 F2HZ, BIOT I U TEO_XR—TEn— K
LTRBEET,

Eor be— ADSBETAFR SLD DX, Extensibility Accelerator TR Y= 7 bk
ZRWIZRICINTZT T U FICRY £,

BT 57 a T fizEoarrae—Lx2 27 ) v 7 LET MFE RIS TNS
I =D 1 DOEFFERTILERH D 7,

7TV — 3 TR MERR X1, Extensibility Accelerator 230 %, [Debug
Property Retrieval] A 712 « R 7 AREKRINET,
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5 JOnT 4 EEZRG

[Debug Property Retrieval] %A 7= 2 + 7R~ 7 2T, [Retrieve Value] #7 YV v 7 L
¥ 7, Extensibility Accelerator 1%, 7B/ N7 A fHOWMBE D= DIZFEEINLTWD
JavaScript B ZFFONM L, @RS N7 a7 4 A2 T A =2 L LTETZEIZL
n, BIRSNEZay ba— Ao e T s OEZEELLEISELET (Fuir g
%1%, UFTIZ L2 7 a7 ¢ OEOTRGEIHEICELE T, FNLFTEINET),

Microsoft Internet Explorer THEIT SN TWDH 2 hu—inb 7 a7 ¢ OfEZ R4
9 5454, Extensibility Accelerator T il T& % Microsoft Visual Studio Shell D7 /N >
7 =V EMERLUTCEBEOT Ny 7 &2 RETEET,

Mozilla Firefox TEITSNTWHay ha—iAhb7FaTF s OMZEET 258, 7
Ry T DDITH A v =Y a— RGBT 3 8 TEET,
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J)27L2RA

® [General] # 7 (Test Object Class TH4 F)

TDOXTTE, WAZ L3y ba— /WX LTUFT MERAT 2T AN A7 V=7 -
7T AD— M E ERTEET,

IOXTTERBLERIL, V—ALFy b PR —F kY FDO XML 7 7 A MTIRES
NFEI, ZOXZTOEEEHIOL T aid, TAM A7 V=7 FREXML 7 7 A )V
ICARTFENE T, A a iz y— A Fy FRIE XML 7 7 A VITIRIESNVE T,
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W DIXE, Test Object Class 7 A 5 [General] # 7 THHATE 2 HEARAS T a v &m

LET,
ASPAjaxComboBox - x
[ """" General |
*Name: ASPAEComboBox
| Map to Controls '
. Description: | A control that has a regular edit box on the left, and on the right has
| Operme a down arrow that opens a drop-down list.
| Properties
lcon file: ;Hesl'm'rxbo_bax_ SR J _ )4 ﬁ_ﬁ
Helpfle: | HelpldSPAax chm ) &l ¢ Context ID: [ 21
[ |
ClassType: | Baseclass: |WebEdit v
Generic type: | List - |
¥ Advanced Options l
T EREE JIGAEa2—T, HILWTAL - ATV b 7T RA%EMNT
520, BBIFD 7 FABL TNV ) v 7 LET,
EEGHR Test Object Class 7 ' A 7 DKL T H#BWT, TA L - AT V=7
ke 7 7 ZADFMERPT X TELLERIN TS Z L a2 fERL
TLEENY,
BT RHOBIZHRNT AL VAT PFERINTODHEAE, T0¥T
NEERIPN TN EEZRLET,
BEES R 59 = TH—ay ha— OV R— b OERE 7213 HHT O Sk
sH 02—V [HAF A Y= Fy b PR—F -y k]
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WIZ, 2—P A F T 2= 2ABREHHALET (T2 LOEHIL, [Lh v aTH

HET),

Ul E%

HiEA

Name

HAZ Ly ba—LERTTEZOICUFT BMEATET AR 47V
7 k- 7T ADLH,

ZDLARNE, DAF L ay b — Ik L CTHERT AR — b1 v

T TANT I F ¥ THEANEEEZ R LET, THIKROFERZRE L

£7

> ZOT A ATV =r b OFEEBIENAER S 11D TavaScript 7 7
ANDAHL, ZDT 7 AN, FEMAT T 3 D [Default
implementation file] ([ZFE RSN E$, ZoFHRIE, Y—rF*v b
BE XML 7 7 A VINOXHET % Settings\Variable B3R IR S 1
7,

> TAL ATV FRE XML 7 7 A /L? Classinfo %3 Name
EE,

» V—L¥% v h%E XML 7 7 A /L ® Control EFE D
TestObjectClass &1,

TAL ATV b7 TADAKHELEE LIcGE, ERROT TR

HEIWICEFESINET (LER->T, 0L RERIIEHICHRET

L2 LEBEIOLET),

F:Io=T v b By 7 AT, ¥, BT, ATy, TUH—

AaT T EANTEET, BRYOLFITRFTTHLILENH Y £9°,

Description

YR=FLEIELTVETAZ L - 3 ha— LD,
Z OB, WE Fd 2 A NHTY, UFT IZIEFERENERA,

BREEF: TAN 7 V27 FEREXML 77 A LD
Classinfo\Description %%
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Ul Ex HL

Icon file TFAN, BATRT Ry I A, FETEya L HERT, ZOT A -
FTx T b IV TARZKH L TCUFT BERTDHT A2« 77 A LD
4 il
mport Filel| = |75 L 2600 U<, i~ 7 4 L aiaE L s
TF 4y ke Ry s A% YT TBICIE [Clear] 38 R v afiL
7,
BERFEF A : UFT ® WebElement 7 A =1 >/
BEBH: TAL - ATV FREXML 77 A LD
Classinfollconlinfo Z£5%
ImportFile: 71 2 - 77 A L ESRLCTERTE E7, .ico, .dll,

— exe 77 ANMLT A Ay BRI TEET,
EL<T7D4T5t X, 7 AANRTeY Y RO Res 7 4L

WCHFETDHERDD iﬂ“o L7=D3o> T, BIOBEICH L7 7 A V%

ﬁiﬁbtzﬁu, FOT77ANDER—H) « A —NT-72HIZ Res 7+
NN SN ET,
A UR—= T BT ANLNDEATINZD T +IVEITHIEFED T 7 AL
L —ET 5354, Extensibility Accelerator X, AR —hL7=7 74V
% (WEEFORD VAR () EF/FSEMMMLET,
F: 7MY Ky b PR—F -y MZBINEH, TO—
LLTTF7uaAfEN5DT, £ XDKEV .exe 7 7 A L2 dll 77
ANEA VR — bTDZ LI T EEN,

<FAar> BRINL 727 A 2 EIMEEREDOT A 2 > O,

Help file IDTAN AT b I TADALTHR AR - AT UET B

HHT 2 chm ~IVT e T 7 A IV DLTT,
[import File]| | % v 2 L, 77 » 4 L2 d57E L E T,

TF 4y bR 2% 2 VT T30 [Clear] $ &% v 2 fi L
S

BREBF: TALN T T7 V=27 FREXML 77 A LD
ClassInfo\HelpInfo %5
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Ul Ex L

| Import File : .chm ~V~7 + 77 A L EBR L TRINTEX £,

EL<77u4¢ét i, ZrAANTaY s RO Help 7 4V
AR 2B &;Uih L7eio T, BIDGFICH L7 7 A V&

@mbtﬁu,%@774w@m~ww-:E~ﬁtE%tHap7ﬁ

NEAERL S IVET,

A R—=bTBTFANDEHNID T FNVEIHEBEEDT 7 A )L

& —3 9 B84, Extensibility Accelerator I%, £ > AR—F L7777 AV

& (JEBRF o) e VAR () EFSEMAMLET,

Context ID HBELEZALVT « 77 A VN TRHL VT« MYy 7 2T 5,

BEEBH: TAL - A TV VREXML 77 A LD
ClassiInfo\HelpInfo T

Base class DU TAWMEERT BT AN ATV 2T b 7T A, FEHERE T
TRTOWebT A AT V=7 k-2 F AT WebElement ’i’?f%ﬁbiﬁ“o

BIRUIZEARY TR0 L T, EHERTEORBEAT, 7AL - 47
Vb T AOEREONME Y N, TARN ATV b T TR
WCEDDTEDITEIRTE DR T e T OV A IR RESNET,

PAR—FLELOIELTWB Y =T, AV T AL THR—
MENBXATOHIML EEREENDEHE, ERTEHT AN - 47
VI k7 TR, ORESNIBYEE T aRT ¢ R — N B

HikA L ET,
FEIZOWTIE, 54— [HAZ 7 20| 2R L TLIEEN,
-

> AR FRAL > THAR—FENDX A 7O HTML E#HEH= o b
o—/WZEENDH, av ba—VAKERTEE TITRVEAI,
WFREMI A~ 2 3 ¢ [Function to get base element] % &% L
TLEEWN,

> ZOTT 4y bRy IR, KR, BT, oM Ty, TUE—A
a7 PG EANTEET, BAIOXLFIEHFTTHHALERH Y £,

BEBH: 7 A - A7 V=2 FE XML 7 7 A /L0 Classlnfo E

@ BaseClassInfoName /&'t
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Ul E%

i

Generic type

PR—=FLELIELTWVWEaL ha—LDF AT,

WHXA T, UFTOF TVl v T4 AZ VT8, F—T—FR-
Ea—®D [RF¥xa2 AL M BT LAHD KX 2 A2 R XFHNOERITHG
ODNET(T AN ATV MEEERTEINCERE L TWORNES),
BESFEE: AT AN - FT7V=7 b - 2T 20WHEA T (ZOE
X, BARZ TAEZRIRT S L ATMICRIRENET),

REJ/F : 7Ab - AT7 V=7 FRE XML 7 7 A /L0 Classlnfo E#
@ GenericTypelD J&

Advanced Options

BRI 2% &, 92— | [General] # 7 - Advanced Options] Tt L
TWHFMA T v a VRRRENET, TNHDA T v a VEERLR
W alE, UFT I3RYEREMa i L £,
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%% [General] 4 7 - Advanced Options

[General] # 7" (Test Object Class 7 1 F) (86— %% /) » [Advanced Options]
FHIKTIE, 7A R - ATV b V7 TADHMAT v a L 2RETEET, 260
AT v a EERLRVEEE, UFT [IREREM A L £

WODKIX, Test Object Class 7 %A F @ [General] # 7 CHEHTE DA 7> a v &R
LET,

ASPAjaxComboBox - X
i ] 4
Generzal | & Ad 1 Opi
| Map to Contrals
Settings Options
| Operations : ) T = = =
! Diefault implementation file: | JavaSorpfASPAaxComboBox s
| FProperties
File to get base element: ] x
Funclion to get base element: get_base_edithox -5 -E.
Filter Options
Learn test objects of this class: |Yes v |
Learn test object's children: | Mo - |
Filter function file name:
Filter function name:
Display this test object class in the Object Spy
Record Options
Event registration file name: | x
Ewvent registration function name: ' ListenToEvents :i
Handle events using standard \Web event configuration
[JHandle events an child elements using standard \Web event configuration

‘|
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WIZ, 22— e {2 BT 2 — RABER|ZONTEHALET,

implementation file

U =X E%EA
BEA T3y
Default ZDTANFT Vs b7 T AOREREE UFT MHIEEHER E CME

CHT 77 A1,

ZHUTFE AR R AT Y a T D, Extensibility Accelerator (2 5
TJavaScrip< TR b+ ATV b U SRE>js ICTRESNET,
TAN AT I TADLREELE LG E, TOF T e
VIEH LWARNC A DY CHBIMICES S ET,

T 7 ANEERE LA RIEE T DB, RCAROT7 7 A LR 2D
T A NVHICT TICHEET D354, Extensibility Accelerator (%, # L\
T AN (s PR O ICE VAR () EFFEMMLET,
BRIEHFT : V— Xy FRE XML 7 7 1 LN O default_imp_file &
V9 4 il Control\Settings\Variable #5%

File to get base
element

BABERZIRTEENEEND 774V (KT v ay),
COMMIIEEEE T L LIETEET A,

[Import File]| = | % v &M LC, %%+57 7 A LEBEL, %
WLTLEE,

TF 4y ke Ry A% VT 5121 [Clear] $ A x ML
30

Y —LF vy FRE XML 7 7 A LHAOXGET 5 XML B 7 U 7 &
NET N, JavaScript 7 7 A MFIT Y =7 FLHEIBRENEE A,
1R#EERE | [Default implementation file] L [F L

BREGFT . V¥ v FIRE XML 7 7 A LND
file_for_func_to_get_base_elem &\ 5 £ fijd
Control\Settings\Variable %%
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Ul Ex il

| Import File : JavaScript 7 7 A V&2 SR L CEIRTE 7,

ELLTTuAT5LDI0E, 77 AR T rY =7 o JavaScript
TANAITFETDHERDH Y £T, LT, BOEHcHD
TrANEERLUIEGS, £OT7 7 A0 —) « AaB—=R7=1EL
IZ JavaScript 7 + L X ICERR S E T,

LR — T DT A VDLBINZ DT AN HDETEDT 7 4
& —HF 584, Extensibility Accelerator |, f > R— kL7774
N (s JEIETORD eV AR () &/BEMAMLET,

Function to get base | SRR Z K 72 0T EIES 5 Mk, HAEHE~DT 7€ AT, UFT
element EHASNIZT AN - A7 V27 MMEB IO v 3T ¢ OHAREF
DFETIMHEHATE DL LI ET,

CORBEREL TRETAINERDHDIE, BRI TRIZL-TY
A—=FEN5 HIML #HER P R—FL Lo &L TWnHary be—L
WCEENDN, ZhBary br—VAKERTEHRETERWEAT
To TOBBEIER LWEE, MESNET A - ATV s M
EB L O T v /"7 1 D9 B, WebElement (28> CTHHR— k&7, ¥
A= MR LERBOCK LT, MEICEEZHARET2LERD Y
E3sp® _

[Implementation Code] _‘é |RE BT 2L, %475
JavaScript 7 7 A /VDFRE S 17z JavaScript BAEK O BT A2 E T,
B AFAE L 72 W A, JavaScript B3 A % 737 7 A MBS
E3,
F:ZoZF4v b Ry 7 AR, mWE, BT, TV, TV
L —=AaTEFEANTEET, BHOLFIIEFTTHLILERH Y
E3e

BREBET . VX FERE XML 7 7 A LND
func_to_get_base_elem &\ 5 4 iifi®> Control\Settings\Variable
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Z4NE - FFay

Learn test objects of
this class

UFT AZ D ay hu— Lz T _RENE I PaermLET,

Y5500

> Yes

> No

» Only if has children - = b2 — LT RBHLGHEOHTFE L E
7 (fChildren& L TfR{FINLET),

PRHERRTE  Yes

BREWAT .V — Xy FEE XML 7 7 A L0 Learn EHE D

learn_control J& %4

Learn test object’s
children

UFT A ZDay b —AOF BT RENE I R LET,

B 550

) S 3

> L\MvE

» Use Filter Function - ZO®%IZIEET 2B Cco Ay ) v 7%
F4TLE7 (CallFilterFunct L TRREFEINET),

RHERRTE : Yes

BREEM : Y — %y FEEE XML 7 7 A /L Learn EFE D
learn_children J& %

Filter function file
name

TUANBRABNEREINTVWE 774 (A7 a ),
COEITEHAET L LIETEEREA,

[Import File]| - | &% % LT, #%F57 7 A VEBRL, &
WLTLKEZEW (DA Ty a v OFMIZHOWTIE, BIOEY 25 R
LTL7EEWN),

TF 4y ke Ry s A% YT THICIE [Clear] #8 K& ML
*7,

V—LFy FRE XML 7 7 A VHOIGT S XML B2 U7X
WETH, JavaScript 7 7 A /WiE T BT =7 M OHIBRENER A,

EH#EERE : [Default implementation file] & 7L

BREBFT: V—L % v FEE XML 7 7 A /LD Learn EED
file_name J&1:

95




Ea4B.HREL -2 FA—)LOYR—F

96

Ul E%

i

Filter function name

T4 NE ) T B ETT DR

CORRBERE L TRET HLEND D DX, [Learn test object’s
children] %72 2 > ®OfiL LT [Use Filter Function] %R L 7=
BETT, _

[Implementation Codel ™= | R4 v &Ml 45 L, #4T5
JavaScript 7 7 A /VDFRE S 17z JavaScript BAEK O BT A E T,
BAENFAE L7254, JavaScript BISA % 703 7 7 A MZiBI S
9,

F:ZoZT oy bRy R, BFE, BT, M TV, TV
F—=AaT G EANTEET, RYIOLFITRFTHLILERH Y
E7

BEBF: V—F v FEHE XML 7 7 A /L ? Learn 22 ? function
B

Display this test
object class in the
Object Spy

ZDTANF T2V N VITANET V=7 b« ARALICERE
NHEMNEIPERLET,

EHEEETE  Yes

B4+ Tay

Event registration file
name

AR PBREBEABENERINTNWD T 74V (X T av),
COMEIEEETET S Z LITTEEEA,

[Import File]| - |[R¥ v &AL T, #4457 7/ VESRL, 5
WLTLTEEW (ZDOF T a v OFMICHONTIE, BIOES %5
LTLEEWN),

TF 4y ko Ry A%V YT T 5L [Clear] #8 K& AL
F7,

Y—F¥y FERE XML 7 7 A VAORET S XML B2 V7 S
WETH, JavaScript 7 7 A MiFE T BV =7 M DHIBRESIER A,

1R¥EEE | [Default implementation file] L [7 L

BREBFT: V- Xy FREXML 7 7 A LD
Record\EventListening 2% @ file_name J& £
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Ul E%

i

Event registration
function name

A b=V EENDERICHTHA X FEY v AT 52D
DAR kA LT D B

COBBEEE L CEETOIMNERDHDLOIL, v hr— A0y
ﬁ1&74fT5%QT?Q

[Implementation Code] | 7= | K% L &+ 5% &, %475
JavaScript 7 7 A )V DR E &7z JavaScript B OB T AL E T,
RS NMFIE L7254, JavaScript BIStA % 73 7 7 A MZIBINS
£

F:ZoxF 4w bRy T AL, KR, BT, ATy, TV
H—=2aT T EANTEET, RYOLFIIREFTHILERDHY
3

BEFBR: V—/1 % v FRE XML 7 7 A /L@ Record\EventListening
T O function J& 11

Handle events using
standard Web event
configuration

kY ar T, TOTAN ATV b I TATREND 2
V= U DA N N ORERE, FERED Web A N MR E &
FALTIT O EI D EEELET,

BEB: Y — 1% v FEE XML 7 7 A /L@ Record\EventListening
TR D use_default_event_handling J& £

Handle events on
child elements using
standard Web event
configuration

fifkt >y a T, TOTFTAN ATV b I TFATREND =
V=V OF BRI L THRAET DA X O, FEHED Web
AR MREZBEHLTITO ME I DEBELET,

RIS V— ¥ v FERIE XML 7 7 1 /L0 Record\EventListening
F 3 D use_default_event_handling_for_children &t
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—IAERE
AESE

98

g

Operaticns L & Call Identification Function
Eroperties | | ;[ select Controks... | [FEEB/E2E* 52 8 0 &
B |

IDATTIE, TOTAR ATV b e JTANYR—FTHarba—LDHA
TERTN—NVEEHRETEET, £/, FRLIEV—NET AT HZEHTEET,

BB HATENR=Ta DT TV EYR—NT5720, 7790V EEDOX T T
Blae DNV—VEERTEET, £7 7 UVEAEZ 712X, 3 20OV —NAER IR LRH
v, UFT BRZENZENRR L FIETERT I IL—LOE Yy FE2ERTEET,

FN—NAER IR (13— %) 1I21E, TORRADONL—b -y FOIER,
£, TAMMEHTE LT 7L a v BdH£7,

JeoHERsT Tl L=

l - %

General | DefatRues 4 E6EH ¢

Map to Controls _,_I_‘ Identi# Contral

| PagingBulletedlistBehavior Equal valid |

avents EgJa valid |
q MND [
l_' taghlame Egual ‘

[ TestRules.. | | Test&Refine.. |

~§—|—8 lgrare Conirol

|Icentification Function Details [ TestallRules. |
{| Identification file name: | ] o) 38

{| Identfication function name: | IsPaginglndex | =]
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T eRE&K

JTAEa—T, HILWT AL - FT Pz k7T A%&EMN
Toh, MIFEOI F AL TN ) v LET,
Test Object Class 7 ¥ A T3P & £7,

Test Object Class 7 %1 "C, [Map to Controls] ¥ 7 %R L
£7.

EELGRER

Test Object Class 7 VA T DEKE X 7EZFANT, TA L« ATV
7 b7 T ADFEMBERP TR TELL ERINTND I & &
BLTLLEEN,

BT RHDIIRNT ALV R T PERENTWDHEAIL, 20X
TREERINAL TN EERLET,

Web Add-in Extensibility D /X7 4 —< > X% EIF 572912

HTMLTags ZH# #{ERT 5% 618, XML 7 7 A VICFE CESR
THOMLENRDHY £9, V—ILF v FEE XML 7 7 A )V I
HTMLTags ZH1 & ENTNThH, 20X FIEF RSN EE A,

BEiES2 x5

61—V [FTAL e ATV N I TRAET S =g
Vb=l v 7T 55k

BB

» [HP UFT Web Add-in Extensibility B 4 A K] O J1 A 2 2 Web

I b= UIK LTHERT 27 A N ATV N I TAD
kA7 D UFT ~D R DI,

56 ~— [Extensibility Accelerator 321> FB— /LD~ » B J
T AN B

103 <— [JLb— BB/ SRV

107 ~—=< [[Selection] A 7wl « R 7 A

109 ~=*—<" [[Add Browser] #4707 « Ry 7 A
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WIZ, 2—P A F T 2= 2ABREHHALET (T2 LOEHIL, [Lh v aTH
HET),

Ul Ex Rl

<ISOYEE4L I> BEDIA TBLON—T 3 v 07 5 7 CETT BKEIC UFT 28
HEHT A~ T s =L Eir—ED X T,

LA 7B 5I2iE, [Add Browser-Specific Rules]
G0 4TI Y s LET, X7 EBIBRT 51213, %70 [Delete]
BHxzrarvyrLEd,

[Default Rules] # 71ZH B /L—/Lix, Y R—FENDT7TTUHFD
26, EHADONL—L -y RREZEIN TRV DT TITH L
THEHERET,

ENDY T DON—VE, ZTIHREINZT T UFITxt LTS
nNEd, 779 F0ONR—=2a UBRERESNTWDIEA, Wi+ 5
=X, BBEINIZATD, EESNIN—Va v EiEth
PBDON—2 a3 v D77 TR CEITTIHAICERENET,

<IV—AERE AR IL> TS =Dy FEERTE DXL OE Y b, L—b
DYERL E T A S DFEMIZHOWTIE, 103 ~2— TL— AER S F L
EHRLTLLIEEN,

BREEFR: V— 1% v FEE XML 7 7 A /L ® Conditions %3, =
DHEFZD type BMEIL, V— NV EERLIZRFICE>TRDO LD
WCIRED ET,

» [ldentify Control] /<3 /L-> IdentifylfPropMatch % 1 7

» [Call Identification Function ] /3% /L -> CallldFunclfPropMatch % -{
» [Ignore Control] <3/ -> SkiplfPropMatch % 7

KB A T DN—)V% UFT DMERT 2 HEOFEANZ OV CiE, THP UFT
Web Add-in Extensibility Bi%& 71 K] OB A% 5 Web 2> ha—
WMCHLTHRT AT AN A7 P27 b 752085 ikD
UFT ~DfROEEZZRL T IZE 0,
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Ul E%

Bk

Identification file name

FHBENEZ SN TWE T 74N (AT var),
COMITEBERE TS Z LT TEERA,
REEHEALT, 4T 74 VESRL,

[Import File]| -
BRLTLLZEn

TF 4y bRy RE2 YT 5HI0E [Clear] $ R4 %18
LET,

YV— ¥y NEE XML 7 7 A AVNORET A XML Bz V7
SIETN, JavaScript 7 7 A MET 0 V=7 FMLHEIBRENERE A,

RERTE : [General] ¥ 7 TEHZESIN TV 5 [Default
implementation file] & [ U

BEBH : V—LF >y FRIE XML 7 7 A /LD ldentification 2235

Import File : JavaScript 7 7 A VA2 B L CGEBIRCTX £,

ELLT7aA 3572020, 77 A n7ay=7 hod JavaScript
TANTIFAET DHERDH Y £3, Lo T, BIOBFHTICHD
Ty ANEERLUESS, TOT A 00u =)L s at =37
HIZ JavaScript 7 L ZIERR SN E T,

AVR=RNTBT 7 ANDHFB DT A VH D DEAFDT 7
A& —%T 24A, Extensibility Accelerator 1%, A A — kL7
TrANA (jsHEIEFOR) T UA R () E/RSEAMLUET,
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Ul E%

Bk

Identification function
name

CDTAL - FTVxs b 7T RAEFERT D a—L &bl
THEOICEET L85, ZOBBERSLERDIE, av ie—LE
TN T B =L DE v b EBIER TE RWBETZIT T,
[Implementation Code] —é |RE v 2ATHE, %4 T5
JavaScript 7 7 A VD4R TE S 417z JavaScript B OHFT 3B 2L F
T, BBEE L2V 4, JavaScript BIBA # 737 7 A WITEMN
EnET,

F:ZoxF v bRy 2R, BE, KT, oM Ty, TV
H—=2aT i EANTEET, ZYOLFIIRTTHDILERD
nET,

BEBH : V—LF v FRIE XML 7 7 A /LD ldentification 213

Test All Rules

PN TNDETRTOWeb 77V r—2a T, vy BT )b—
MMZ—HTHT_RTCOay he— L EZmFEERLET,

KHETONL—L, PN TWE T T IH0 ) BT 5 b 0Cxt
LT, HAZLWeb a2y bua— LI TAHT AR - 7V
b2 T RA%WRNITH1DICUFT BMERAT 2D LR Yy 7125
SWCHEHAESNET,

SHIZ, ERHEHSONL—VTHIESN TV DHIEAIL, BE#d s
b — L OB & BT B -0, EE UL PO S h
£7,

HHICOWTIE, 61 =Y [FRAI ATV b I FRETS
Vor—yagyearyhra—WWIi~vy X T5HE O o s -
N—NET TV r—a L TT AL, RERLEHLE
T OFEEZZRLTIIZEN,
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B LR SRL

[Map to Controls] % 77 (Test Object Class 7 %A F) (98 _X—T &2 HM) T, &7 7 v HH
27N, 3 2D —=IUAER SRV D Y, UFT I8N ENS R % TIETHEIT /10—
Dty FEAFRTEET,

BIV—WAER S FRIVZIE, —)b s ZF 4 ZEEBRE R Z B, —L D HEMERSS,

FTFYr—a KT HA—LDT A NEITH 2N TEET,

> L— LOHBEREN—NVDT A FOTFNEL, 61— [TARN - FT V=T k7
SAET IV r—ay s ayha—Iivy T L HE] ICREHINTWET,

> L — LETFECHRET AT, V—Ib - =F ¢ ZEEEN DY — L — & Ul B35 %
LET,

Select Controls... LQ.L ______ % I 1
IF
| PagingBulletedListBehavior Equal valid |
| 4 | events _events Equal valid
4 |AND
U g ame Equal A
| TestRules.. || Test&Refine.. |
FTORREE T [Map to Controls] % 7 (Test Object Class 5V f F°) (98—
EBR) T, TITUFEFEONL—I -y hOX T EERT D
n, BFEOX T EIRLET,
2 (R B DL A FITHIET DA ARR SR R L
FT,
BEES2RY » 61—V [FRAN ATVl N7 TAET T r—vay-
ary hr—Ivy 7T 5 HIE]
> 67 N—V Ixy BT =N Dty M ABBRIHERT T
]
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104

FN—NAER IR M, ROBENEGENE T,

> 104 X— THR&Z ]

» 105 X— [JL—)L « =5 ¢ ZHEEL)

R Y

Ul EX

Bl

Select Controls

vy BT e =L ERBIMERT A OOy v a VARG LE
T, = EERT DI, BT 2424 7Dy ha—LvEwT S
Vor—arThRAr hLET,

H AT DFAMZONTIE, 67—V [y 7 - L—1DE vk
ZHBIIIERT 2 k] 2B LTSN,

Test Rules

BN TNWAETRTOWeb 7 7Y r—a T, v BT - L—
JNE—FTHFT_RTCOay ha— L 2R R LET,

B AT DFEFMZHONWTIE, 61 =Y [FRL - F TV b7 T
2TV r—av-aryha—piey T 5HE © Ty
BT e =T T = a A LTCT AL, BERLE
FLET. ) OFEESRL TIIZE0,

Test & Refine

N—LEBEERT 500ty v a VEBBLET, BTy
HFTRTDOWeb 77U r—a T, BIEEERSNTWSHL—LIZ
—HTHT_RTOary ho—ARNEIRFEARE LTv—27 SNET,

B AT DFEHNZONTUE, 61 =Y [FTRA L AT VT b T
AT TV r—yarv-aria— iy 7 T5HE O T<wy
BT e =V ET TN =g A LTT AL, HERLE
FLET. ) OFIEEZSZRL TSN,
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JL—I - TF ¢ 2

ORI~y BT = LN FR &N, FEITHRETEET, e XE, ko
ENITAET,

> JL— LOBMEHIBRNTE 97,
> L—IDIEFE Iy 7 ZERETEET,
> T unT AEICKT A IERKBHRAER L TOV— N E L TEET,

Wi, 2a—=Y - A F 72— 2ABWHEHPLET (TR LOEFRIT, Ay = TH
HET),

Ul E% L)

<{REY—ILIN—> ol Gt 3¢ U)o
DY =N, RORE 3D ET,
» Add Single Condition Below
Add Single Condition Above
Add Grouped Conditions Below
Add Grouped Conditions Above
Delete Selected Element

Move Selected Element Down
Move Selected Element Up
Undo

Redo

YYYVYVYVYYVYY

<I—=N-arTFTF> H—DV—NVEZTN—TvEnov— vzl R, v—L
FENFINV =D TN =T ERIRT DHI21E, s TdarT7rTE27
Vo7 LET,
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Ul E%

Bk

<Jb—JL>

1 DON—)ViX, ROBRNLEREINET,

> < TONRF K> ZCOL—LTF=v 7 EN%H HIML a3
7 4 DAHT,
7V w7 LT a T 4400 A MDLEIRT 50, &
OExEmMELET,

» Equal / Not Equal : 7' 237 ¢ OENF SN DAMEIZE LV E
TN —BRIZEND D, FELL RN E XTI IN D0 ER
LET,
7Y v 73%E [Equall] & [NotEquall 2810 by £,

> < EhafE>: 7YYV r—varoar ha—LO HIML 7
13T ¢ OfE & T S,
ZOMETEMEBE LTS L ICHEE LIESAIE, EHERRT
Aay EANEREINET,

7V w7 LTCIZOEERELET, WIS HERE LS

B, WOBMAT v arNERENET,

> RegExp : HIff SN DA EMEH L LTHRI 1 E I ETR
LET,
RERE(E : false

» Trim : UFT 23V —V&25HIiT 28012, 7037 ¢ OfE & HfF
SNDEDOFIHED AN—RAERET DNE I DERLET,
REREE : true

7V wrTDHE, INHONL—VEMEDOMEN true & false DET

UL T (M- REUBF DL XL, fH true T

HHIEEEWRLET),

AND/OR

TN—T D=ty MIHLTAMd L OrDELLDOBRY v 7
EEMT SR LET,

7 Vw274 2%& [AND] & [OR] 23810 #b by £7,
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R [Selection] #4705 - Kys R

ZOFATaT Ry AL, TAN FT VT bV TRIRT O E T —
NOBEERDOT-OICay br— L EZEIRT 5y v a VORPT, Weba br—)L
BV w35 EMMET, 22T ERT AL —AERET D br— DRy
MZ, ZOarba—LE2ED50E I NERETEET,

ToXATar Ry AIZlE, 2 hr—® HTML OFMAERINE T, FRS
NIEREREORTHIO HIML EH#EARIRT S5 LICkY, Zoay ho— L 2R EHEL
EECTEETS,

WOKIE, Control T AL + A7 V=7 b« 7 F R L TEEBREN TV RN Y
fa—n%7 VU v 7 Lizk 2B 5 [Selection] XA 7 a7 « Ry 7 ADFITT, §
TIZBRENTWDar her—AE27 Yy 7 LIESGEE, #4787 Ry 7 ADKRE
VIREL BRI E9,

TR
LTD
Loy
NPT
Properties
alt Sign-In
name login
scopehllame|HTML
src hitp:finewtours. demoaut.comiimagesibtn_signin.g...
taghlame  [INPUT
type image
value Laogin
VAR FV:b: Test Object Class 7 ¥ A @ [Map to Controls] % 7 T [Select
Controls] #7 Vv 7 L, Web7 7V r—vavsCcarviae—i%
7Y 7 LET,
EETNR BATRT « Ry ADEA ML - 8—{Z1F, 2 ha—/LBHRO
KRB LERDT AN ATV b 7T ADARINTERINET,
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BS:EZRY 61—V [FTAN ATV b VTRAET ) r— a2
v hur—lw y ST B )

i 98 ~X—7 [[Map to Controls] %7 (Test Object Class 7 %A ) |

WIZ, =P A F T 2= 2ABREHHALET (T2 LOEFIL, b v aTH

HET),

U EXR B

<HTML EXVYYU—> BINL-7T 7Y r—var-arbo—IL (B\RERSATHET)
ZFRT HTML EROA4H, %41 5546, HTML BN OIE O3
FLERINET,
MEEANORIO HTIML BREEZER LT, ZO7 7V r—var-ayv
fa—nagRIFZ L TEET,

Properties BIRENTWD HIML EEO 7 137 ¢ DA & A,

Select Zoaryhr—LEBRL, 2Oty TERENDLL—LE
WETDHar ba—LOty MBMLET,
AATOT Ry 7 ANRAL, TFVr—varTary bag—LR
RFHE R I N ET,
FEHTEZAE&E: =0 Fo— A RNBHERIR SN TWARNT &,

Apply BIREPLTWAar ba—Loty hE2EHL, BEEHNTERS T
HIML E#£%#ifiLCZoary ha—AnfkEnd ErcLET,
AT Ry 7 ANAL, 77V r—varTay bo—LR
PHE R I E T,
FRTERZEYE: o e — A RBERRENTWAE D L,

Delete IOty varyTERSNAL—LERET AL FR—LOD
vy bbb, Zoarha—LEFEHIBRLET,
ATl Ry 2 ANRAL, 77V r—varcarrn—in
IRR SV RER SN E T,
FRTEZEYE: 2 e — ARBERRINTWE D L,

Cancel BIRENTWHAa fr— LDty NEEEFFIIZOF AT 0
TRy 7 AU ET,
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®, [Add Browser] #4704 - Kw4H R

ZoXATas Ry 7 AL, [Mapto Controls] % 77 (Test Object Class 7 A F) T
[Add Browser-Specific Rules] ¥ 7% 27 ) v 795 L& ET, 20X Tus Ry
J AT, HLvwb— -ty bOXRRLERLT T U FOEMERELET,

Browser Details

Browser: - |

Minimum wersion: |

[Jcopy identification rules defined for:

DK | Cancel

T RRFE Test Object Class 7 %A 7@ [Map to Controls] ¥ 7 T, [Add
Browser-Specific Rules] cp # 7% 7 V) v 7 LE9,

BS:EZRY 61—V [FAK ATVl h e VT RET SV r—ar - a
v hr—lw v 7T 5 )

i 98 ~—7 [[Map to Controls] %7 (Test Object Class 7 %A ) |
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WIZ, 2—P A F T 2= 2ABREHHALET (T2 LOEHIL, [Lh v aTH

HET),
Ul E=Zx% EREA
Browser HLNWFTOL—LARERAINDT T IFOX AT,
B 52510
» Default Rules : [ ED/AL—/L « v FBREFEINTUEWNT AR
TOYR—RINDT T UWFITH LT, EHEZRTE DN —/LHME
SNET
(ZOffilE, EHEREOL—LBEZINTORVEEOHRY R
MZERENET),
» Internet Explorer
» Firefox
REEHR : VL F Y FREXML 7 7 A LD
Identification\Browser 5% ™ name J&%:
Minimum version FHLNWF TONL—NABNEHAEIND T T FOR/NN—V 3, i
AT BHD, VA RNPBERLET,
RUT T OFDORRHNR—D g N LTRARZL—L -y b
EFRTEET, 72& %1%, Internet Explorer 5 (2% LT 1 2D /L—/b
& v %, Internet Explorer 7 \Z&% L CHIONL—L - &y NEEFRL
72354, Internet Explorer 6 CHEITT HIGAIZITATHEOL—L - £ v
k73, Internet Explorer 8 CEAITT 2L A IZITBEONL—L - B |
BHWLNET,
BREFF : V- LF Y FREXML 7 7 A LD
Identification\Browser %5 ® min_version J& 4
Copy identification ZOF T a v ERR LGS, BFEOL—L -ty FD1oO%Y
rules defined for 2 NMBBINLET, 2OXA Tl « Ry 7 ATEELET T
PFICHK LT, BIRL7L—L sy hOaB—BERSNET, 2
NooN—E, ZOTT IO A FITHEDET, LEIZSTT
EETEET,
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®. [Operations] % 7 (Test Object Class TH4 F)

i

IDZTTIE, TAM ATV b 7 TARFIR— b H28FEZRFTLET, RO
BEZEITTEET,
> ZDTAR ATVl b JTABRYR— N LBEO Y A NEERLET,

BEZ BN ETITHIBRLIZY, —"N"—=T A RTLEAS T ABELRIRLIZY L
=7,

> BINERITA—"=F 4 FLZEMEICH LT, AY y FOEAZHTEL, BINERE
EFRLET

> TDT AL ATV b T ADEUERTCEORIELZEELET (7 a ),
TOXTTERBLIERIL, YV—LFy bR —F kY FDO XML 7 7 A MITRES
nwET,

BINEITA——=F 4 FLEBEOZNEICK LT, %47 5 JavaScript 7 7 A /LT
JavaScript B9 A # 7N BIMENET GEA T v a v EER L CERERKE T T 74
NDLAFTH TIAZ A X LT E 7R,

[Implementation Code] "% > %27 U v 7 LTCEKICT 7 AL, EEE2FR— 142
LOIFEELET,
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WODKE, Test Object Class 7 %A @ [Operations] ¥ 7 CHEHTE2EARLTT v a v %

R~LET,
ASPAjaxComboBox - X
General ‘Opeﬁltions X pE
Map to Controls Sei(Texd) - Default
Operations Select(ltern)

Click{x y. BUTTON)

Properties SetSecure(EncrypledT ext)

Description: | Enters the specified fextin the edit | [2]Default aperation
baox

Return type: | -

Operation Arguments d;b Nl

MName Direction  Type Optional  Default  LOV  Description

Tex TN = I B =

<| [ b

|8gdmmdmus
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W DIXX, Test Object Class 7 %A 7@ [Operations] ¥ 7 CEHTE 2547 v a v %
RLUET,

Operations

AsPAjaxComboBox

General

Map to Controls

Properties

v X

| & Advanced Options
Icon file: . | b4 l:‘

Help file: [ HelpldSPAxcin) [ .| 3¢ ContextID: (2101 |

Implementation file name: ( I ﬁ

m

Implementation function name: ' Set

Tt RAE

[Operations] # 727 7 A3 5121E, ROFIEEZFATLET,

1 752 -a2—7T, HILWFRAL - FT7V=2 752580
T, BEfFDO I T ARLZ TNV v 7 LET,
Test Object Class 7 ' P& £9,

2 Test Object Class 7' 7T, [Operations] % 7 %2R L E£4,

FEMIA T Y 3 2T 7 B 24 5121E, [Advanced Options] % 7
Uy 7 LET,

EELGRER

> WRKSNIBIEET AN - FT V=2 b« 7T AOEREREHRIE
ELTEIRTEET,

> WK SNIBEOERIIEH CEEHEA,

> A SNI=A Ty a VTR LTHEGEIA 7y a vk & £
A,

» Test Object Class 7 H' A D& TH#HNCT, TA L - A7 V=
7T T AOFMERDT R CELLERINTND Z L%k
MLTLEEN,

BT HDOBIHRNT AL ) AT PBFERENTWDEGEIE, TDOX
TNEER»IN TN EERLET,
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EE2 R PBR=T [FAR-FTP=7 b - 77 2BEERET DA

SH [HP UFT Web Add-in Extensibility Bi%#E A RIDOT A k47 V=
J ke AV ROPE— hOFEEDIHE,

[Operations] # 7\Zi%, IROBEHXDH Y £7,
> 114 ~— [[Operation List] k]

» 116 ~X— [[Operation Details] I |

» 117 ~<— [[Operation Arguments] k]

» 119 ~*— [[Advanced Options] &3 |

[Operation List] $Ei%

FAN AT Vxs b 7 TATBIMUIARIEL, RS T 20— HOBRE RIRLT
F—N—F A R 52 L) NERENET,

> WK SNTBIEZAZ Y v « 742 NTETRISN, EETXEHA,
> B LWEEE A — =T FENHREL, BHEO7 4+ b TERRENET, 20X
TOENOMERT, Ay RKOBAERETEET,

BREEH: 7A N - A7 V=7 FERE XML 7 7 A /L0 Operation Z3&,
FLUWEBMEE 7213 A — =T 1 FENTZBEAIEDOENZ UK LT, %Y 5 JavaScript
7 7 A VT JavaScript Bk A # TN BMEN T, 0By, BEEZYFR—-FT5
LORCEETHIVERNH Y T,
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ZOMEIKICIE, RORE L EFFOY—NAAN—1H0 £7,

Ul E%

Bk

>

Add: FH LWREEZT A R4 T V27 b7 T AERITBMLET,
CTAUTIN AT, FEHERR TE D FEEE T 7 A /VIT JavaScript BIEA # 7538
MENET, ZNMTOIND XA IV T OFAMTDONTIE, 35 X—
¥ [JavaScript 7 7 A /WZxt L CHEIIZITONAEE ] 25 LT
<TZEVY,

¥ ;B4 7Y 3 T [Implementation file name] 7-1%
[Implementation function name] % §57E L 723 &, Extensibility
Accelerator | JavaScript 7 7 A WCEAEA # 7 & B LRNOT, F
FTEMTHLERH D ET,

Delete : IR L7-ff{EEZT AN A7 V=7 FiRE XML 7 7 A LD
TAN ATV NEEPOHIBRLET,

*Hitad % JavaScript BIZIFHIBRE N EH A,

F—R—TF 4 NENTBEZHIRT D E, TOBLHIFA XY v -
T4 MIREY T,

Debug Operation : [Debug Test Object Operation] %A 7 1227 « R
7 A (133X=U %) BN, TAN ATV =7 MEEZRE
G 5 7= OIZE%FF L7z JavaScript I — REZEIT L TCT Ny /' TX
£,

Override Operation : 2247 T 2Lk L= ffEE A ——F o
NI 28 LWEEE R L ET,

BEDBL DT > NREEOT FA MIEDLY, ZOX T OEE
DFMPIRETREIZ R Y F7,

I, HUWVERIELZBIN L5 &R, EEREOFEEY 7
A VAT JavaScript BIEE A % 7 2%BM & E 3 GEIIZ DWW THERTOHL
DEZRLTIIZEN),
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[Operation Details] £

C ORI T, BEY A MECERIR LI BEOLET, B, RVIEO X A 72ER (£
i3 FR) TEET,

o, BEAEREDOERELRIR LY, HfEa IS 5 JavaScript BT 7 A L7 h T
EET,

WIZ, 22— e f X T 2 — AFER|IZHONCHHALET,

Ul E% HL

Name TA b ATV MREEOLT,

PEOL R A EE LA, 347> a v CHEET 7 AV E 20T
BEOLETEZ D A Z <A XL TWiiThIE, #BIED JavaScript 23
BMOARBVEESNET (LA -> T, ZOEHEFIELICRT
THZEEBEOLET),

F— =T A REINTBEOLRIEEL LizhE, TDEBELIEA X
Vw7« 732 MIRY, BEEEOLANZFFOH LOERERER S
nET,

F:ZoZT 4y bRy s AR, EE, BT, oMM TV, TV
H—=AaTIEFE AN TEET, BYIOLFIIEFTH D LEN
HYET,

BRTFEM

> TAL AT V=7 FRE XML 7 7 A /LD Operation

» UV —/L% v M E XML 7 7 A /L0 Method %55 - JavaScript 3
ERBIc~ v 7

Description BEOBH, ZOHBIE, UFTOY—LE v MR TRSNET,
BREBFR: 7AN ATV FREXML 7 7 A LD

Operation\Description %55
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Ul Ex il

Return type YRR RIED & A 7,

ZOF T a AMEATE DX A4 70U XA MBRFREIN, FOF
MOEEIRTEFE Y, U A MIIE, Enumerations 7 %A F (513—¥
M) CERLIEIIFELEENET,

BREBIFT: 7AL AT V=S FREXML 7 7 A LD
Operation\ReturnValueType\Type %5

Implementation Code : %43 % JavaScript 7 7 A /L ®, 3T 5
JavaScript BAEL DT 2 BH & £ 7,

i

Default operation BENZDT AN ATV b 7T AOBEMERTERIETH B
EomERLET,

RERFEE : AV 7 XA OBHEREEE

BREBF: 7 AL - ATV s FEE XML 7 7 A L0 Classinfo
73R ¢ DefaultOperationName J& %

[Operation Arguments] fEist
COETIE, BEY A MER TR L BYEOS A EX (FEER) TEET,

BEBA: T AL - 7V =7 FRE XML 7 7 A /L0 Argument %3

WIZ, 22— e f X T 2 — AFER|IZONCHHALET,

Ul E% L)

oe ¥ U ZOY—n—2i3 [Add] R L [Delete] &%, FLUF]

BONEF % ET D200 [Up]l A& & [Down] A& 035D
F7,

Name S D4 i,

F:ZoxTF 4w b Ry 7 AT, w1, BT, oM7Y, TV
Z—RAa7 T EANTEET, BAOXFIIRFETHLLERD
D EF,

{R7E35FT : Argument %3 Name &1

117



Ea4B.HREL -2 FA—)LOYR—F

Ul E%

Bk

Direction

ZOBIEN AR ERELET,
R#FI5Fr : Argument 3% O Direction &'

Type

SIBDED 2 A7,

IOF T a NUIERTEL XA T DY A RRFEREN, TOF
MO CTEFE9, U A MIIE, Enumerations 7 %A F (51—
#HM) CEZRLIEIELEENET,

{RTEIBFR : Argument Z# N Type &%

Optional

BIBNAT v avinE S inamELET,
FT v a UEIBEERT DHE, £ OMEBEIIEREDOT N TOLAL]
BoO%THLILENRH Y T,

{R7E5,FT : Argument 5% O IsMandatory J& '

Default

FIBOEHEREME, SR A TS a v DBEORMMATE £,
RFIGFT : Argument 3% O DefaultValue J& 1%

Lov

T AN ERETHEIC, UFT A Z O8I BICHERATEAEDOY R M
BIICERTHNE D pERLET,

COF T a rEERLZGE, ATEEEZa Fr—AhD
i7" get_list_of_values JavaScript B % EIT 2L E R H Y F
T, BMERETIE, UFT X Z0o#%Z, o7 A - A7V =7
b2 7RI LTERINTVWDIEERTEDOEIET 7 A )V
([General] # 7, FtfiA 7> a ) DHNFOHLET,

{R7715F7 : Argument £5% > DynamicListOfValues J& 't

Description

SIE DA,
ZOFHPNE, NERZ2 R 2 A METY, UFT IEE RSN EEA,
{R7E5FT : Argument 555 Description J&
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[Advanced Options] #&ig

ZOREETIE, BEY X CTHRAEBRKR SN TWAHREICET 23MA 7Y a U 2RET
XFET, INOLDOF T a v EERLARWEAIE, UFT ISR EMmEFER L E T,

72t XKk : [Advanced Options] *x/L %27 U v 27 LET,

WIZ, 2—F e AU H T 2— RABERIZONTII L E9,

Ul EX

L

Icon file

FATE YV a VRERTZ OB LT UFT RRRT 5T A 2 -
7 7 A )L DL,
[import File]| | #5 » 28/ L, 847 7 4 L4 LET,

TF 4y bRy s A% 2 UTTHICIE [Clear] 8 R & f#
LET,

BWHERTE  UFT OFEEREDOT A 2

BEEBH: TAL ATV PREXML 77 A LD
Operation\iconinfo 23

dil T2k exe 77 A NVHNDT A 2L ZBIRLTEBE, 774N
DT A A DAEDA T v 7 2% Iconlnfo BHEICHRTFESNET,

ImportFile: 7 A 22>« 7 7 A V&SR L TRIRTE 7, .ico,
dil, .exe 77 ANANOT A AL EBRTEET,

ELLTIaAT27201E, 77 AVRTrY = D Res 7 4+
NEZFETDHDHERH Y F9, LEERn-> T, BOBINCH D7 7
ANEBRIRLIZBE, ZOT77ANDR =)L« =R HI
Res 7 # VA IZIER S ET,

AVR= T DT 7 ANDEARNIDT A NZIHDLEFDOT 7
A & —ET 5454, Extensibility Accelerator |%, A 7R — k L7z
Ty AN FEREFORD VAR () EF'RFEMMLET,
F:T77A4MWFY =Xy b PBR—F -y MTBINEH, 0D
—HELTT T IhDHDT, 4 XDKEV .exe 7 7 A LN
Al 77 A NVEA VR — T DT EITEET T EE 0,

<FAa>

BR U727 A 2 V£ IMRERED T A = D,
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Ul Ex Rl

Help file IDFAN A TS N I TADALTH AR - AT UFT
MEMRT S .chm ~Lv7 « 7 7 A )L D4,

[import File] | - | % > 2 LC, #6177 7 A A& diE LET,
TF 4y bRy A% 7 YT TSI [Clear] #& &% v & {1
LET,

BEBHR: 7A - A TV FEEXML 77 A LD
Operation\HelpInfo %3

Import File : .chm ~V7" « 7 7 A LA B L TRIRTE E 3,

ELLTFTTaA T2, Z77A4VR37TrT=2 hO Help
TANTFET H2HERH Y ET, LT, MOBICH S
TrANVEERLIZBE, €077 A VOR—H)b « A =R
HIZ Help 7 4 VA ITAERR SV E T,

AVR—= P TDT 7 AINDABINI DT VEHIBEFDOT 7
A& —T 2A, Extensibility Accelerator 1%, A A — kL7
Ty AN GEETORD VAR () EESEMNMLET,

Context ID HBELZAVT « 77 A VNTHL~VT « N v 7 RT3,

BEBFHR: TAL - A7 V=7 FREXML 7 7 A LD
Operation\HelpInfo Zi3%
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Ul E%

Bk

Implementation file
name

EIEEENREZSINTWE T 7 AL (AT a ),
COMIIEEEE TS Z LIXTEEE A,
REEFEALT, E4T57 740251,

[Import File]| -
BRLTL 230

TF 4y bRy s RE2 YT 5I00E [Clear] $ R4 %48
LET,

YV— ¥y NEE XML 7 7 A AVNORET A XML B 7 V7
SIETN, JavaScript 7 7 A MET a7 FMLHEIBRENERE A,

RERTE : [General] ¥ 7 TEHZESIN TS [Default
implementation file] & [ U

T ZoF T v a LI EIRE L7254, Extensibility Accelerator
137%24 9 % JavaScript 7 7 A WICBEE D A X T AEk LE A, B
BIITFETERTHALERH Y T3, F7o, BEOBAELET LT
L EICHEBEOBAITBBNICESR S NEREA,

BREBR: V— L% v FRE XML 7 7 A /L0 Method %3
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~

Ul E%

Bk

Import File : JavaScript 7 7 A V&2 SR L TR TE £ 7,

ELLT7TaAT572l2L, Z7rArnrayzy l\@JavaScrlpt
T A NE ﬁf¢7M§#%Di¢obt#of,w®%%
774w%§mbtﬁn,%®774w@u~ﬁw-:ﬁ~ﬁtﬁ
HiZ JavaScript 7 4V FIER SN E T,

AVIR—=F T DT 7 ANDABINI DT +VEZHDIEFDOT 7
A& —ET 5454, Extensibility Accelerator |%, £ > A — k L7z
77 AN (JsIEETFORD TV AR () EFFEAMUET,

Implementation
function name

ar b= LTT AN AT V=7 MREEIATT D201

FLHET 2 B o 44T,

ZERE - BEOART

X

> ZOF TV a AR EIEE LT2A, Extensibility Accelerator
137%4 95 JavaScript 7 7 A MTEE DO A ¥ 7 &2 1ER LER A
BEIX TRV CIERT D LENRH Y 3, 72, EOBLEZET
L ZICHEEOEAITBBNICESR S NEEA,

» ZOF TV a T EEE LA, JavaScript 7 7 A LN
A LEHTLOILERDHY £7,

> ZOTT 4y ke Ry R, BFE, BFE MM TY, TV
F—=AaT7 T E ANTEET, BRYIOLFITRFETH DM
NHYFEF,

REBF : V— %> F&RE XML 7 7 A /LD Method %5
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® [Properties] 4 7 (Test Object Class TH4 F)

[

ZDETTE, TAM - F TV bV TRAOBB T XT 4 BREFLET, RO

VB FITTE ET,

> TAN AT V2T b VTAORBTaXT DY A MNEEFLET,
TaRT 4 ZBEMELILHIBRT S0, AL TV XA MIEDLERT FAO TN
T4 EBRIRLET,

> TAN - F TV FERIZEDLTa T 1, FxvIZiRA L hTHERL THAHE
WHEHTE a7 4, A~v—NRHBRICHERT Ao XT o 2 EaRELET,

> A a T, A S a v EERLET,

IOATTERLEZERIE, V=X bV R—b -ty FOXML 7 7 A VIREFES
nwET,

BIMMEFLITHA L7270 )T  OZNEIUCH LT, %45 5 JavaScript 7 7 A /LD, =
Vb= nS T RT ¢ OEE ST S 7O FELE LB, JavaScript 27— F - &
AR BEMENET GEA T Y a VAR L CHEEMEE T 7 A VD4R E
HAF<A RLIGE, 2— K720 MIBIEREEA),

[Implementation Code] "% > %27V v 7 LCHBICT 7 AL, a7 ¢ D%
BT EocdE LT, SO NTE, 77 = [FEITROA TV =7 M bkl
T u T 4 OEETRET D JavaScript B%k & 3| 2L T EE 0,

E:ar br—Anb T NT  OEEZEGT 5 JavaScript B S LT H0TERH D F
T FEICOWTIE, 76 X—Y [T AR AT V2 b« 7 TAOEHT 087 1 &3%
FT2HE O TETREOF T V= 7 b bRk 7 187 ¢ OfE %G9 % JavaScript [
P FEEL) OFEZZHRL T LIV,
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WebExtBook

-

| General
| Map to Controls

| Operations

Properties

Edit the Properties list and 2dd properties from this list to the groups on the nght by selecting
a property and a group and dicking the >> button.

Properties g X b= [ ¥ Object Hﬁﬁcﬂm—ﬂml
Property [ ¥ Object Identification - Assistive l
title [ ¥ Smart ldentification - Base l
authors [ ¥ Smart ldentification - Optional l
S | 4 Checkpoints and Output Values |
Tl
. X o
himil fag )
authors
min_used_price
name price
fme [ title
¥ Object Spy
# Advanced Options
Implementation file name: | ] |_] X

Implementation function name: | |
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T eRE&K

[Properties] # 727 7 8 A F5121%, ROFIEEZFEITLET,

1 792 -Ea—T, HILWFAL - FT =2 b+ 7T 2EEN
TE0, BBFEOI T AZLTALI ) v LET,
Test Object Class 7 %A 723 & £7,

2 Test Object Class 7' 7~ T, [Properties] # 7% @R L £7,

FEMIA T Y 3 2T 7 24 5I21E, [Advanced Options] % 7
Vo7 LET,

EELGRER

> IDXTTEF LT AT 4 - =TT L5, UFT 22—
W[ ATVl VORI XATar Ry ATIToEEN
FEXEINDLOESTED, V—Fy bR -ty b
FEEOMH O 7227 7 1A F5HiIIZ, Toolkit Support Properties
F %A 5T [Development mode] 47 = (47 _—T%H
) 27107 LTLIEEN,

FEMIZRER IOV TIE, THP UFT Web Add-in Extensibility BH%&#
HA R 22 LTIIZEN,

» Test Object Class 7 A T OE X TEFHNT, TAN - AT V=
I N T ADFMERNT N TELL ERESNTWVWD Z & 2T
LTSN,

BT DEIIRNT ALY AT BERRINTWDGEEE, T0H
TMNEER»N TN EERLET,

EEL2 R

16 _X—Y [FTAKNFT V=2l b 7 TADFEBT 03T 1 ikF
35 ik

2|

[HP UFT Web Add-in Extensibility BAF& A K] OFEHKT =37 ¢
DY R— F DELEDIE,
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[Properties] # 71Zi%, ROBEHEBH Y £7,
> 126 = [FuaXF g R
> 128 X— a5 4 ks n—7]

> 131 X— (A~ v a )

FanF4 - UR b

TAN ATV N ITRBM LT 0T 0 b, KK T AT aRT 4 D—

S AL TYANMIEGHDZ ENAMER) BNERINET,

> KA S 2D T aRT 4134 F ) vV « T4 NTERREIN, ETHLOITBIRL
BWBYD ZDT AR « ATV ks 7T7ATEHYAR—FENEFA,

> B LT uRT o LK SN T 08T 1%, RO T 42 hTRRSN, Wk ATHE

“C“j—o
BEEHA: 7 AL - A7 V7 FRE XML 7 7 1 /L ldentificationProperty %3
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Z ORI, RORZ 2OV — A= H ) 5,

Ry

Bk

>

Add : BT LWVIRERRERFRGR T 0 T 4 2T AN« ATV =7 b -

7T AEFRITEBMLET,

BAHET, v br—Anb T a7 ¢ OfEE ST 2 JavaScript

Bfica— R - 27 A MBMENE T, HLLT r3T ¢ Off

ERETDHEIIE, oI AV FEFELET,

TuNRT 4 DARIEEE LILGE, a— kA FTERER

TWALTaRT 4 AREHEINET, ZNBMTbhdZ A IV TD

FEMIZOWTIE, 35 ~X— [JavaScript 7 7 A /LiZxt LT HBIC

TONLSER] Z2ZRL TSV,

bz 3

» M4 ~7L = ¢ [Implementation file name] F7-(%
[Implementation function name] % f57& L 72354, Extensibility
Accelerator (% JavaScript B3l — R - £ 27 A v FZBM LA
DT, FETEMNT DLENH Y I, T u/ T 4 DARIEEIC
DNWTHLRLI ENFXLET,

> TuART AR, RWE, BEF, oM Ty, TUyHE—RAAT, R
N=ALEFEANTEET, ROOLFEREF THLILERH
DET,

Delete: IR L7- 70/ T 4 T AN AT V=7 Fi%E XML 7 7

ANDT AN« ATVl NEZRDBHIBRLET,

> a7 o HHIBRT S & EIZ, JavaScript EEEREE O Z DT m R
TAEYR—FTHE7 v arNETHUE, Thbllksh
£,

> MR INT=Tu T 4 ZHIRT DL, REBAZY v - T
MTREY 9,

Debug Property Retrieval : [Debug Property Retrieval] %A 7 12 7 -
Ry 7 A (1353—=V%28) BN, 2 br—Ahb 7 ms
T 4 OEEBGT 57212335 LTz JavaScript = — REFEITLTT
Ny JTEET,
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Ra > L]

AE Implementation Code : %29 % JavaScript 7 7 f /LD, 21> k1 —

— BT a T 4 O ZIRFGT 2 JavaScript B D 5T 3B v
E9,
COREUEIY v 7T HRNCT aRT 4 IR LI GA, BN
OFIET D7 v a v OBFHAE»NET,

=) Inherit from Base Class : R L 72KV T 2D T a7 1 %, 7

AR F TV b VFAOTENRT DY X MGEMLUET,

BEICEoTE, Ta T a BREDT a/RT 4« T — T TR

WETEMENDZ b T,

> FONRFAH/DT F 2 FREHEDT XA MIEDY, REEIC
RV FET, FOKIZ, TENRT 4 BLEIL LT —FITBN
L7, ZU—7rbHIBRLEZY TEET,

> AR INT=T 0T 4 DARTEERE LIRS, RREFA2Y)
7 7% MIRY, BREDOAFZFOH LT w37 4 BE
REnET,

IBZ, FLnTaT g ZENLEGE R, 2 be—n
NB 7T ¢ O &GS 5 JavaScript Bflca— K- &7 2
RSB S ET,

KRG T AN EELPATERWGFEE, T T ¢ Offix B
THEINCZOET AL PERELET, RS T ADFEEDOMK
IZBE3 B EEMIZ DV TiE, THP UFT Web Add-in Extensibility BH %%
HA R OBMFEDT AL« AT P27 b+ 7T ADPIEDHEE B
LTL7EEN,

FanRFa BTN —T
ZDORED TN —TIER T 0 T 4 BB S5 2T, T uT o O BRIE UFT
IZHmsEsZ ENTEET,

EROTaRT 4 DY A RNDLERO 7 V—AIl2 a3 4 BT 51k, ZAr—7F
FERIRLTHE, 7ua T 422700 0y 73250, @RLTS>KRF %27 v s L
\ijﬁo

LW BT FRFRK SN T m T 4 2R LSERT FADT 0T 4 DT NV—
TIIEFETEEE A
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REBF: 7o T O NV—TEHVE T, TAM AT V=27 MEREXML 7 7 AL
WIRFEENET, ZoEHIE, IdentificationProperty EEDBIEIC L > TRENE T,

WL, 2= A ¥ 72— 2AFEHEEFPALET (VR LOEFRL, 11y aTH

HET),

Ul &%

HieA

X0V

BT N—=TINXY — AR —=0 b £,

> TARTOY—LA—(ZiT [Delete] A% 3d Y, BRLE=T R
RT 4 & T N—TDBHIRT DI & ET,

» T uT 4 OIEFICERRS D 7 —7I121E, BRLE T a8
F4 &2V X NATBEITS7-00 [Up] A% L [Down] &
2UWBHY ET,

[Object Identification -
Mandatory] 4’ )L—7

ZDITFADTA AT V= FNERO—EE LCUFT I
By 7mT 4,

X RUT v 3T ¢ W50 [Object Identification] U 2 NZ&
HHZLIFTEEEA,

{eTE A% : ForDescription JBIEDE % true ITRE

[Object Identification -
Assistive] FIL—7

—BOTAN - F TVl FEBREERTHOIL, BIRLZT T
ADT AN ATV x 7 MTOWT UFT B TE DR 7o
INT A,

UFT A7 Y =2 ba¥ET 8, —Bo47 V=7 it 2 Ek
THEDICHRE T 0T 4 BLIERGA, UFT X, —EORdE(E
T 5 DI+ RS LND ET, ZOTNAV—TTREINT
WBNEFFHZHES C, RIS T 87 4 & 1 DT oBML T
E3e

{85E A% : ForAssistive B D% true, AssistivePropertyValue
BYEDMEE 7V —TNO T a /8T ¢ OALE IR TE
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Ul E%

Bk

[Smart Identification -
Base] ¥ )L—7

IDTAL ATV b I TRIKTHIERT 4 VF - Tusr
T4 L LCUFT R¥EBT 27037 1, Av— bl A B =X 4
X, Zo7anXT o ZERLT, LRI ATO= FOY R L
EERLET,

F:RU 7 v T 1 2% 5O [Smart Identification] V X MNZE D
HZ LIFTEERA,

8 A% : ForBaseSmartID B O % true IZF%E

[Smart Identification -
Optional]l 7' )L—7

IDTANFT V2T b VTR T DA S Va7 4 H -
TanRF 4 LTCUFT ¥R T a7 o, A~— bRl A B =
AL, ZOTaRT 4 ZRECEFTHERALT, A7 V=7 ME
WOV AR 1 5OF TV =7 MUKV A THEET,

UFT WA~ — FRBEMERT 256, BT 4V F - TuT 11
Mo THEFLERDAT V=V bDY A NEIERL, BEY A R
ODF TV MIKRVIAENDET, AFvary T4y T
137 4 DIEEREDIEFIZHE->T1 >T>F v 7 LET,
855 % : ForOptionalSmartlD J&: D % true,
OptionalSmartIDPropertyValue &t D% 7' /v — 7N D 7 a X
T 4 DB IR E

[Checkpoints and
Output Values]
gn—7

UFT O [F=v 7R b7 a7 4] BIO [HAEO T v
Tl AATaY Ry JATHERATEX L maT 1,
TanRT 4 DF vl Ry I ARBRINTWDBEE, v
A FEERT D [Fov 2R bOT T 4] AT
07« Ry 7 ATEDT a/NT ¢ PIEMERE CEIRENET,

5% H % : ForVerification 35 L 08, BIREN TV EHAIT
ForDefaultVerification J& MDA % true [Z5% &

[Object Spy] Y IL—7F

8EH % : ForSpy BIEDOE% true IZF%E
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HHA T ay
Z O T, T anT 4 OV R — N EFEETHOOFMA T Y a VERETEET,
INLOFT v a VEERLBEWEAIE, UFT (MEEREMEEHA L9,

74+t ARFik : [Advanced Options] L% 27 U v 7 LET,

WIZ, 2—F e AU H T 2— RABERIZONTII L E9,

U EX BT
Implementation FRPEABNTERZ SN WD T 7 A (T a ),
file name

COMEITEBAT T A LT TEEREA,

[import File]| = |75 > 21l LT, #4957 7 4 LEBIL, iR
LcZan

TF 4y bRy 2% 7Y TT 5L [Clear] 3 R u v &AL
£,

Y —L¥y NEE XML 7 7 A VNOXET 5 XML B 7 U7 ShvE
T3, JavaScript 7 7 A /WiET a7 PO BHIBRSNER A,

EERTE : [General] ¥ 7 TEFK STV 2% [Default implementation
file] [T

oA TV a VITATTEIRE LTIZ%E, Extensibility Accelerator 1X3%
29~ 2% JavaScript 7 7 A WZBABD A ¥ 7 2R LEH A, BT FEIT
ERRT DM ER S 3, Tz, e XT o2 BMELRERLZL X
2, 3= R -7 A0 MIBBMIGEMEZIIEE SN ET A,

BEEBR : V— %y FEE XML 7 7 A /L0 Property 2%
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Ul E%

i

Import File : JavaScript 7 7 A VA SRR L CEIRTE T,

ELLT7TaAF52DI12E, 77A40B7ay=s ho JavaScript
T ANBIIFET HRERH Y ET, LB oT, BIOEFTNICHD 7 7 A
NEBRLIZGS, T0 77400 =0 ab—NREELHT
JavaScript 7 + /L Z \[C/ERE S L E T,

AUR= T 277 ANVDARB IO T AN FZHLWMFEDT 7 AV &
—EF 2354, Extensibility Accelerator 1%, 1 AR — K L7277 A L4 (s
JEEFORD BV AR () EFRFEMAMLUET,

Implementation
function name

A b= AL B RT ¢ OEERGT D 7202 FAET 5 BE D

AN

FHERTE{E | get_property_value

bz

> ZOFT v a VZARTERE L4, Extensibility Accelerator 1X7% X4
% JavaScript 7 7 A WIZBABD R & 7 2 AERL LER A BT FEI T
TERT D HERNH YV FT, £, 7o T s 2 BNERLIFEE L L
X2, a— N7 AL MIBBIIGEMEZFETINEY A,

> ZOAT T a U TAHTEEE LA, JavaScript 7 7 A VNO B4
HEHFTOILERHY T,

> ZOZT 4y bRy TR, RBE, BT, M TV, TUH—A
AT EFEANTEET, BHIOLFIIREFTTHILERH Y T,

BEHAT VL F >y FRE XML 7 7 A /L O Property %3
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@ [Debug Test Object Operation] #4704 - Ry R

ZDEATay « Ry 7 ATIX, Extensibility Accelerator N2>5H T A K « A7 V= 7
YEZ ST LT, JavaScript FERBAET A N L TT Ny 7/ TEET,

Debug Test Object Operation

Test object class: | ImageButton

Operation: | Click

Enter the values to use for the operation arguments.,

MName Type Value
% [optional] Long

y [optional] Long

BUTTOM [optional] String

3% You must select a control befere running the operation.

Select Control Run Operation Cancel
T RRFE WOFIFDONFTNNEIATLET,
>» [Project] > [Debug Test Object Operation] %R L ¥ 9,
» [Operations] # 7 (Test Object Class T %A 7)) (111 X—TV %%
W) <, #fEY A+ Y —s3—0 [Debug Operation] | &
2rxr )y 7 LET,
» VTR Ea—7T, FTT5HFEE4H27 Y v 27 LT [Debug] %
EIRLET,
EY b EBENRY T AL 2 —ICFRR SN TWRWERIE, %ICT
AR FTVxT b 7 TRAERRLET,
BEELGRE BEZEITT DRI, 77V r—varTHisddar ba—%

BR L TR LERH Y 7,
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BEESRY T9NX—=Y [FAN ATV NREOI R — 2T AMLTT
Ny 75 HHE]
i 57 ~X— [JavaScript B DT N 7|

WIZ, =P A F T 2= 2ABREHHALET (T2 LOEFIL, b v aTH

HET),

Ul EX

Bl

Test object class

HATTHREOT A b+ AT V=0 b+ 7T 2,

Operation

<REDIIH>

BIEOBI%, #518UCK LT, ROEARDH Y £,

Name : 318 DLET &, 7 arnE 0 GEHERVER),
Type : B1ED Z D515 x L TR 2D % 4 7 FisHi v 8
).

Value : #/EZ FEITT 2B Z 05 1%kicxt LTS 5, 33T
DMK L TEE AN T HHERH Y 9,

Select Control

VTV AETRTOWeb 7SV r— 3T, TAN AT V=
Ne 92D~y LT « = —FTHar ha—1L&2F T
RN L, BEEEIT T br—aBRIRTEHLOI1CL
7,

FERTESE&EH: ¥ 17 us - Ry 27 2T [Test object class] 7*
BIRENTWNWHZ L,

Run Operation

FXEF L7z JavaScript ZEEA MO LC, BIR Lz b a—icxt
L CEEEFITLET,

BERETEREH . 7SV r—varTary ba—ANERESA T
5Tk,

Cancel

BEZEITEPICZOX AT s - Ry 7 Z&EHALET,
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% [Debug Property Retrievall 54704 - Ky X

DA Tay « Ry ATIX, Extensibility Accelerator ZfffH L CT Ak - A7V
FOBHT O NRT 4 OEERGTEET, ZHIZEY, HEERGT 2720I/ER LT
JavaScript B9 AT A N L CT Ny 7 TEET,

[e] Debug Property Retrieval

Test object class: | ImageButton w |
Property: | image_name w |
Property value:

3% You must select a control before retrieving the property value,

Select Control Retrieve Value Cancel
T EREE WO FIBBONFTN»EFITLET,

» [Project] > [Debug Property Retrieval] % 3R L ¥9°,

» [Properties] % 7" (Test Object Class 7 A F) (1233— T %2 )
T, a7 4« YR K- Y—)L3—@ [Debug Property
Retrieval] p K> %21 v LET,

BEELER [Retrieve Value] %7 U v 7 3 %§ilc, 77V 7r—3 a » CHIET
Hary he—LEER L TEBLERHY 7,

BEE2RY 82 = 17 a T s B ET A N LTT Ny 755 .

8@ 57 ~X— [JavaScript B$K DT /N> 7|
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WIZ, 22— e f BT 2 — RABER|ZONTEALET,

Ul E%

Bk

Test object class

BAT270X7 A DT AN ATV~ I TR,

Property

B3 57 057 4,

Property value

a7 g BAGFEIEREENRTE, Z OfElE, [Retrieve Value] %
7Y w7 LT, ETeyvarNETLEET, Ginl MK
KT) Frahxd,

Select Control

BWTWATRTOWeb 77V r—a T, TAR AT Vxs
he 72D~y T =T Bar bu—LE2T T
IR RL, T RT A OEERSTS 2 br— L EBIRTE D
oL Ed,

FERTERZEHS: ¥ 17 u s - Ry 2T [Test object class] 7
BRI TWNWDHZ L,

Retrieve Value

FXEF L7z JavaScript EEERAE A FATL, BN LT a7 o 4%
FGA=HLELTETZEIZEY, BRLEZa br—pb 7 N
TAOEEBGLET (a7 0401, UFTICL D7 a7 1o
BEOBAFEEICADLET, FNXFTESNET),

ERTZREE . 77V r—arTay bo—ANEREN T
HTZ &,

Cancel

FusT 4 BEEEEEITEFICIoF A TS s Ry s AEHL
7,




F4E.HRAL - FO—LOYHR—

Q rSTLYa—TFo VT LGIBREE -3 FO—ILDYHR—

ZOHETIE, WAXL a3 ba— O R—NMIETDH N T TN 2—TFT 07 Ll
FREEICOW T L £ 9,

L—ILOB#HTYEY OO FO—)LOER
> Web ~— |- object FENH D 2> b — /LITEHR T FH A,

[El8% : object HHEPIERD HTML Y — & » =— R&BID Web _*—Il2a’™—L, %
D=V bigS T 53y br— LV ERIRLET,

> Kkl r — AT, BRI A7l ba—v% 2 Y v 7§ 5L, Extensibility
Accelerator S ER 2 FEFT 2DV I, HDOIWIFEHET 20122 <, 77V r—v 3
/#7J/7_ﬁ§¢6(bm/7&¢/ A=a—%FAU D7 EOMELFETT D)
ZEBRBHVET, ZOD, V—VEERTHIoOIZa Y hr— LB BT D DN
LWEERH Y £7°,

Bl : HAlc k> T, BENTELICH S HIML E#EE2 7 Vv 7 L, RRaShic
BEOFNLAMOa hr— L Z2RIRTELH2L03HD 9, ZRH TERVWYGE
i, 2 b= ST o= Ve FE TIER T 2B ERH Y £7,

> Extensibility Accelerator ?/L—/L + =5 ¢ & (Test Object Class 7% J-@ [Map to Controls]
BV INE, XATal - Ry ZANTOay ha—LOBREFF— N LEFA,

> Web X—UHNOD = b — L ERIRT5120F, [(Y—IL] >[40 83—Rky b AT
V] T, ROFT L a v BEMNI> TWAVERSHY FT (X —TFT 47« &
ATF LML oTIE, TNO6DF T g UPEERETENICR->TNLEZERHY
7).

> [EFa)F4]l (48— y k] V=) > [LRILOAREITALX] >
[ActiveX Y bFA—ILETSHTALU] > (N4 F) EAAMET—ERH YT E
N ET7—]

> [(£F2UT4] (Av8—hyk] V=) > [LRLOARETAX] > [Z
HQUTR] > [POF14T R ) FH]

> Extensibility Accelerator 2347 AX &« 2 b —/LiZxt L CIITTE DL IICTBIC
X, 77UV TR )T NOFITHREMR o THAUERSHVET, 77V r—a
VERITLELEET I UOYRAZ VTS NERTERBNIIC T 0y 7 T A55AF
Extensibility Accelerator & 21> b @ —/ LIkt L CTHEAT 2RI, vy Snufzar o
UV EHRTHLENH Y ET,
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Y—ILxy FERETFTAIL

> V—/L¥F v FiRE XML 7 7 A /L O Ildentification %3 Z HTMLTags &M &£ 5
%6, Test Object Class 7% F @ [Map to Controls] % 7 D/L—)L « =F ¢ X |ZIEF
REINFERA,
¥ - Zh3, Extensibility Accelerator O3> 7 /L Web 2.0 H7R— bk « 7 ey =/ FDO—
WO b — U2 TEEY £,
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5B O F
HREL-Y—ILXYy b - HBR—FD
F7AA A2k

AKEONE

> T7uA A hOBRR (1404—2)

> T aAd (142°8—2)

> T7uA R T A NVOMHE (1423—2)

ZRY

> V—LFy bR —F kY N ETTATDHHE (1433—)
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Bz

& FIaL AV FOEKN

Y=Ly kPR —hF vy FOTTuA AL M, UFT O8EEZT 2 b 572012,
BARO S EFXERBEBETIT) 2N TEET,

il

TIRATEIER BREERIREZ TR A

TFAL ATz bV TAELZED | UFT CAT v 7o MRETHBEICZOT A b« 7V
BEITER L2, #4ED JavaScript B | 7 b+ 7 T AEMHACTE S, F—VU—K-ba—1,
BUIEFR L TV, TF 4 XDAT— A N HEWHERERET, #BIESIE
L<&ERIND,

FAR ATV b I FRCHT | UFT NI DZA TOFT V= N x5,
B BT =B EF LT,
EIZEFR L TR,

BEIZx9 5 JavaScript B2 3285 Lz, | UFT BRIEZFEITTH AT v T HFITTE 5,

Ay b= ANLREHE T RNT O | BT o RT A DEEAT V=7 b ARALITEIRT
% BU59 % JavaScript B% & 23 L7, x5,

V= Fy b YR—b oy NORBENRET L, EEOERODIZT A
D, ATy =0T 5 Z LN TEET, FEMICOVWTE, 142 X—2 [F7m
A% BBRLTIIEE N,
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FRE—F-4+7>avnEe

BB CY —AFy b Y FR—F &y bET 7oA BEI21E, Toolkit Support
Properties 7 %1 5 ® [Development mode] #+ 7> = (47—T%5M) 2L
FFEIZLTBEET, ZhITEY, AN FT7V=27 FRE XML 774/ T
IdentificationProperty & D B2 AT L7854, UFT X {Thbh =T X TOEF 2 EH
[—/i‘a—o

EEH AT B0y =Xy b PR—F - By b2T oA T 50, B2
®ﬁ7/a/%7)7bf<tém o5 LW E, UFT B3NS NS, T A b -
AT FPREXML 7 7 A VDERICESNTT BT 4 - VA NREHFREINET,
UFT 2 —FN (A7 V=7 bORH] #4707 - Ry 7 ATTaRT 4« VA NEE
HL7=t%, UFT 2 HEdhd 5L, BENFIIHESNET,

FEHIZ DWW CIE, THP UFT Web Add-in Extensibility BI#&E 74 Rl OF 7o A #F AP HR—
FOERDOHZZIL T IZEUY,

Y—=IL¥xy b - YR—F - £y FOREE

Y—=nFy b YR—bk -ty NET T EA TSR, Extensibility Accelerator 1325 &
FTRTRIFL, BHRERGELE T, DBERT —ZPARRLTCNDED, BieD7 741D
HROMNZF ERLAR BB RO s, =T — - VAL - U FUICRHBEEZHY
THAYE—URRRINET,

BWELBEECTY— Ly b eV HR—F kb ET IR AT LA, =T — - U R MIH
HaINBEOL ITERTEET,

EBREOBEHOLDIETY =L Fy b« FHR— k- by bET T THHNC, FRSN
t?ﬁﬁ_zﬁwﬂébf<7iéuy
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& Fraq %k

Y—Fy kYR —bhky hER—ANVIZT T aAF %L, Extensibility Accelerator
ERILaEa—FIZA A =L I TW5D UFT ¥ 7213 Unified Functional Testing
Add-in for ALM T, Y—/bF v b« BR— |k - by MREELIEATEDS X 512Y
£

F0F, V—AFy b PR —F kY b zip 77 AVICHEINIZ Ny =L T,
IO UFT 2 Ea— X Il L CBEL, HT2Z2LbTEET, 2ip 77 A /1T
HiEShd 7 7 A VoEE, 7737y =A%y b PR —F -y hERET
TY, LEedoT, ZoY—AFy h-H%R—h-y hEUFT 2> Ea—% CHEAT
5I2iE, <UFTA >R b—JL = 7 # L& >\dat\Extensibility\Web (2 &3 2 L E23H Y
£,

B 2T DFMMMZONWTIE, 43— [V—LFy ke PR—F -ty h2FFal45
FiE] ZBRLTLEE W,

& FTAL AU TFAILDIEE

142

V—=nFy ke HR—b kY FOT 7 AL, ROBETT T oA SNET,

Bo+LWEFERIEzp 7714l

I
|---<¥Y—JLF* v k£ >TestObjects.xml 7 7 1 JL
|---Toolkits 7+ LA :
I
[--<Y—IL¥y bE> T+ ILH
I
[---<Y—=ILFxv F&>xml 77 1)L
|---JavaScript 7+ /L4 (JavaScript 7 7 1 ILEET)
[---Res 7+ )LE (FA4A> - T7AILEEDL) (FFay)
|-—-Help 74 L% (.chm I 7 A LEET) (AT a>)

Y= Fy kAR Y ERURNCBIOHETT T r A SN TWegE, EEX
SN2 NT 7 A VTITEOHITIZIR Y £70, DRIIEH S EE A, 72 & 21F, QuickTest
9.5 £721X 10.00 MIFICBHBE SNy — L Xy b« SR—b By hEASUFR—FL, £
DRBICHOT 7 aA LEGERINCHTEY £3, ZbD/\—T 3 T, JavaScript
7 7 A V) JavaScript V7 7 L Z I SN TV Ry o 72 B T, fERIBELSE T
HOERT B0, FERENLWT 7 A VFEIR LN EIWTL X 9,



ES5EHRIL - Y—ILFy b - HR—rODFTOA A+

2R

T Y—LExy bk -HR—b-ty brEFTOSLTIHE

IDFRTTIE, V—NAFy b VR —F kv NET TS TEHEERALET,
UFT ¥ 7213 Unified Functional Testing Add-in for ALM 232 —# /)L « 2 B o —H |24 R
F—LENTWEEAR, ThbHICEET Yal/+52 8 TxET, £21F, V—IL
Xy h e R—b-y b2 r—LTUIPO2 L Ea—X AT DHIENT
xFET,

V= Fy b BR—b -y FOTTOA AL ME, ROBEFELEHKTIT) ZLNT
EEEE

> BEHBEIET, HWIEZ T A M50,

> BEHETRIC, Y—AFy b FR— FOEHEZRGT S0,

Y—IF¥xy bk -HiR—b -y bEFIOLTBIZE, ROFIEERTLET,
1 2B ODT AN AT V=0 -V T REFUYIIRT 0 =7 PEHEET,

2 V- Fyh-YR—b -ty FORFPETLTEY, EBEOMEHOZDIZEART
DA, WOFEEFEITLET,

> Toolkit Support Properties 7 %1 7@ [Development mode] 47+ 3> (47—
CEBHR) 7 VT LET,

> EWETNTRFL, =7 —-URb T4 FUICERINTZTXTOREICKE
%Lij—o
I OWTIE, 140 = [F7aA4 A FOBER] 2B LTLEEN,
3 FRARIKELT, ROWTRNEITVET,

> UFT (ZDarEa—XIZAf VA M=V EINTWDIEHE) T 7uAT25I20F,
[Project] > [Deploy] > [Deploy to QuickTest Professional] % &R L E 7,

» Unified Functional Testing Add-in for ALM (Z D32 B2 —H |24 A F—/L3NT
WAEA) 1T 7 rA 3 5I121%, [Project] > [Deploy] > [Deploy to QuickTest
Add-in For Quality Center] %R L %7,
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> V—Fy kPR —k -y NEEMAHIC Yy =T 5121, [Project] >
[Deploy] > [Deploy to Zip File] % &L £, [Save Zip File As] %1 7 1
7Ry 7 AWMV S, BT S .2ip 7 7 A VDN AERRELET,

E: TRV MIBREFELTWRWEERS 56, 770 A « a<wy RRETS
NWBHENZ, BRIFOTDOT a7 MRFRENET, [Save Zip File As] ¥ 147
oy Ry 7 AL, REOT o ANGE T LB CHEET,

V=¥ ke R—bekby FbOT AL, 12— [FTTaAL A T7 AL
DOREE | IRENTWAIBETT e g ShEd,

UFT Z 7213 Unified Functional Testing Add-in for ALM (Z%f L CT 7’ 1A L7254,
Extensibility Accelerator /& UFT £72137 FA > DA A h—)b+ 7 4 L& % HoOF, <UFT
FEXT7 KA 2DA VR =L - T+ )LA >\dat\Extensibility\Web 7 -+ /L %27 7 A L
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F2BE - FRTAN TV b - V5RO

ZOIETIE, Book 2> b r—/L AT 79I UFT AMEH T 5 WebExtBook 7 A k « 47
TVl b 7 TREAFHRL, TOEAREEERLET,

1 TR ATz - 9S5SADER
J—Z7u— -1 ¢ KT [Add Test ObjectClass] #7 U v 7 L%,

> AA Y s R¥Fa AL MEROH LW F 71T Test Object Class 7 A T3 7,

FHFAL F RPN & X ITFRRENTWS DI, [General]l %7 (Test Object Class 7
PFAF) 86—V ESM) TH,

S BHIT, Hr L JavaScript 7 7 A AMMERINE T, ZOT7 7 A MET Y2V b
T AT U—T TR TEET, ZOT7 7 A ML, S Book T hE—L
YR — N D705 E T 5 JavaScript BRI SN E T,

U—77u— - Ky TlE, [EditTest Object Class] fEIKAS TR R S,
TaYxy MEFHOBAEOEME R L TWET,

2 FRM-FTLH - HUS5ROLH, 5B, FAOAVEES

[Name] 7R > 2 A (Test Object Class 7 %'+ F+® [General] ¥ 7) T, IEHERED
TAL - ATV= b 7T A% % [WebExtBook] IZEEH#AFET,

AT B ETHFAFT DI TICFRSNDARNED Y, EEBPRFSHL TR
LEFRTTAZY A (*) BETIIRRINET,

[Save] #7 VY v 7 LET,

TAN ATVl bV T ADLFNIE DT JavaScript 7 7 A VADPEE SN,
HWE XML) 77 ANVADT AL « AT V=T b« 7T AZNREFRSN, 774
IVDMRAFE EIVE T,

[Description] RNy 7 22, ZOTFAF ATz H b+ 95 RIEBook oV k
A—LZRTOICEREINET ) EAHLET,

ORI E B H O T, UFT 3R REhEEA,

WebExtBook 7 A b « A7 V=7 haRTIEEREDT A a L ZEEXHBIET, 7
A I NTHAO FICERRSNET,
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(] [lcon File] &> 7 ZDHLEMMOBRALZ %27 ) v 7 L,
%ALLUSERSPROFILE%\Documents\ExtAccTool\Samples\WebExtSample\

Res ZZ M L TEIR L £,

TAay - TyANin7Tay=y O Res 74 NVAIIA VFR—FE, 7adx
IR ATO =T CTCT 7 A NVEMHRTEET, 77414 M [lcon File] R
JACEKREN, TA A VEBLFEREINET,

e [SaveAlll #7V v 7 LET,

3 CHDRTTCHATZZZFDMOTRAN AT H M- HSRAEHELTERE

>» ALNT - DPAN:ZOFa— NI TATIE, Tadlcl Mo~V T - 77 A4 U%
EALEEA,

> Class Type : 148 ~X— Web Add-in Extensibility ® Book Sample > —/L- % > K~ ®
PR — FOF ] OFEIZEESNT, EAEFRE D WebElement A7 5 X L fEHE
FHED Object NWHZ A 72 ZDOEEMHHL ET

> Advanced : Z DFEIRICH HEEMA Y 3 i, BHEESTIIFERTALETISH Y F
A,

4 EBRLIE-BEI7Z7AMILORNBEHER

a 7uv=xz/ bz A7 —7TWebExtSample.xml 7 7 A V& X T NI Y v
LET,

BIDOZTD XML =T 4 X TT7 7 ANVPAEET (=7 4 ZIZONWTE23N—T %
M), 222X, V=A% FRET 7 A NVDOEREEIRSINTVET, 0
T AMIY—F v b BR—b By FOERE UFT (G52 T D &5 &2 R
LET,

JL— k@ Controls 2352, WebExtBook 7 A ~ « 47 ¥ =7 |k« 7 Z 2@ Control
FEENEEN, £INHR— FNOFEEE TR T S JavaScript 7 7 A LDMEE ST
WET,
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EHIL, 77 AT T UPFIEIE L 20 Identification EERNEE N ET, &
UL 161 =D 3R T AN ATV h V5% ar ba—Lilvy
TTBEN—IVOIERR] #FETTHEEHINET,

<Control TestObjectClass="WebExtBook">
<Settings>
<Variable name="default_imp_file" value="JavaScript\WebExtBook.js" />
</Settings>
<ldentification>
<Browser name="*" />
</ldentification>
</Control>

V=¥ y NRET 7 A NVNOERLBEMEOFEMIZ OV TIE, UFT Web Add-in
Extensibility Toolkit Configuration Schema M~/ 7" (Web Add-in Extensibility ~/L 277>
LRATEE) 2L T EEN,

7uvxzs b« 7 A7 1 —7 T WebExtSampleTestObjects.xml 7 7 1 /L % &
TNr Yy LT, OXML =T 4% - ZT7THEEST, 2077 A%, 7
AR FTT2I NRET 7 ANVDEAEERTRINTWET, ZDOT7 7 AL
I, WebExtSample BRIE & EDT AN« A7 V=7 b+ 7 7 ADEHR%E UFT 145k
THEEI R LET,

Typelnformation 3% > PackageName Jg:(%, ZDT Ak - A7 V=7 FE&E
Tr7AN (BEXOTZ77ANVNTEHRELEZT AL - A7 V=2 ) % WebExtSample
BRELIZRHE AT 9, UFT 2BV 72 & %12 WebExtSample BR 15 2 38R L 22 WIG4E,
UFTIZZDT7 7 ANDT A « ATV b+ 7 FTRAEHBEERLET,
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ZOMDERINE, THAFTTHELLT AN ATV b 77 ARERE F
NEY,

<Typelnformation PackageName="WebExtSample" AddinName="Web">
<ClassInfo GenericTypelD="Object" Name="WebExtBook"
BaseClassInfoName="WebElement">
<Description>The test object class used to represent a Book control.
</Description>
<HelplInfo />
<lconlinfo IconFile="INSTALLDIR\Dat\Extensibility\Web\Toolkits\
WebExtSample\Res\WebBook.ico" Iconlndex="0" />
<Typelnfo />
<ldentificationProperties />
</ClasslInfo>
</Typelnformation>

TAKN ATVl NRET 7 A NVNOESR L BEOFEMIC OV TIE, UFT 7 X
heAF TVl bk« AX—<D~LT (Web Add-in Extensibility ~/L 7" & Fl| f 7]
e) ZZH LT 7Z&EWN,

€ XML 77 ANV&ETRTEHLUET,

EBIB/E: TR AT H - HSRFa2FA—LIZIVTTS
IW—ILDYERL

HAZ L ay bo—LEYR— 57202, UFT I3 EO 3> b a— st LCff
HAT27 AN ATVl b 7 T2ZHINTHHLERDY 9, 20D, BAX L -
avba—nLOYR— FORBICKITAEEREME LT, UFTAay hba—LzT X
he ATVl b 7TRTELL vy T T 520DV —LOERNH Y F9,

Extensibility Accelerator IZ1%, 2D vt 22 BAEILT 57DDRA L h-T U K7 U
T RAN=ALMWBYVET, TAN ATV bV TATREINDIY hr—)L%
U35 E, @R LEay ba—LO7 a7 (2383 C, Extensibility Accelerator
MWTAL «F TV b« 7 TRTHT DV T - =N EAERLET,

ZINBEDN—LE, V=X FRIET 7 AL (WebExtSample.xml) /N, £ Control
FHENTER IN T2 Identification ZE IZFldk S v E 7, Control B L, ThEh
D1ODT AR FT V=7 b7 T 2%EHLET, Identification KX, £#7 A b -
FTV 2T b VT RAEFHLCEDa b — A ERTHERELET,
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Z DIETIL, [Map to Controls] %7 (Test Object Class 7% A1 F) DA B =KL (98—
P EBMR) ZEMALT, Yo7V Book 2 hr— KT Ay LS s — L a2 AE
L ET,

1 Test Object Class T4 3@ [Map to Controls] # 7 %<

a Extensibility Accelerator M A A > + F¥ = A MEMKT, WebExtBook Test Object
Class 7 A T OX T HRIRL £,

FTHATRHALOLNTWAESIE, 79X Ea—ilhbdb7ul=7  OTA K-
FT 2T e 7T ADY A T WebExtBook 2% 7V U w7 LTT YA T %
=FE7,

b Test Object Class 7% A FDOEMIZH DX 7 )25, [Map to Controls] & 7 % B L
E

2 TV Book 7 T r— a3 U EERST

TN T TN = a U RFEITT D70, %ALLUSERSPROFILE%\
Documents\ExtAccTool\Samples\WebExtSample\Application\Book.htm ~ 7 1 /L
Z, PAR— &N 5H/3— g O Microsoft Internet Explorer TBI& £,

TV TR VT ROEITRAEDNI/>TWNWDL I L 2R LET,

3 [Map to Controls] 4 JZHARTHEEZER

BAEICEoTE, ar b= E2ETTL57 70U T, AR ATV b
I ARE AL MWy T T HEN—NEEZDNENELDZERHY ET, =
D X H 72354, [Default Rules] % 7 DEED % 728 % [Add Browser-Specific Rules]
RELZ2T Y w7 LT, BMOL—IL &y FEERLET,

IHIC, JBHICL - T, FHEO=a v b —/L & UFT ICER 2, LML
~ BT EBFEITT H7DIT JavaScript BB A MO L7 THOMLERECDHZ & B
HYET, 20X LA, V= E ABICERT 5 7 0 22 5AT 5,
[Identify Control] /XL D>V IZ [Ignore Control] F7-i% [Call Identification
Function] /XL EEIRLE T,

Book 2 kR —/LDBFE, Y R—FEINDLZTRXTOT T UHFIIH LTI DO/NL—)L -
Ty NMETBRBETHY, L—AEFHL Y be—A @5 LET,
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4 arbo—)LBEREY 3 U ZERK
[Default Rules] # 77 ® [1dentify Control] 3% /L-C [Select Controls] 227 V v 7 L7,

Extensibility Accelerator 233F&/RIZ72 Y, Wif O _L#FIC [Create Rules] & [Cancel]
D2ODRE U NFRENET,

5 7FU—2a e EIELEHBICTOREEE
YR RA BRI LVBIIEDY £T,

TV r— g UNTY I RAEE W -3y ha— LR RFHFRRIN, FOar ha—
NEFRT HIML BEEOLARINERINET, TOXTIE, ROBALNE EI5HHEKIC
st L CTDHTML EENFRINTWVET,

File Edit View Favorites Tools Help

—— -
©@“ |@J Ch\Users\Public\Documents\ExtAccTool\Samples\WebExtSample\Application\Bookhtm - | +y

E’,:'fFavorites ‘@ Book ‘ | - |

1] The History of QuickTest Professional

New: 59.99% Used: from 29.99%
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6 Book O FO—/)LEKRT HTML ERZEIR
a KOBEADEENDIEEE 7Y v 7 L, RIZRFREND TD BREZRIRLET,
7T UHO EIC [Selection] ¥A4T7RT ARy 7 A (1072—V%5H) NEAX, 2
FEDOHIML 7035 4 #FR LET,
B
§ File Edit View Favorites Tools Help

UU |fé_| CA\Users\Public\Documents\ExtAccTool\Samples\WebExtSample\Application\Book.htm =

Tw? Favorites @ Book f;i“

WebExtBook
TABLE
LTBODY
LTR
A

Properties
classMame BookTitleCell
tagName TD

X Book 2> b — VEHEREERTHEETEO D EHA, XA TRT - Ry 7R
O _EEiZ, TD B O HTML BEER#GE RS RSN TWET, TOHIZ, Book =2 k
o —/V%&%9 TABLE EZERNE N TV ET,

b HTML E#HOWE#ECTTABLEZ 27 ) v 7 L¥7,
TABLE BE D7 a7 4 BNERINET,
¢ [Select] #7 VU v/ LET,

7 AV rA—LEREY 3 VERT
[CreateRules] #7 Vv 7 LT, avybto— W@ty g 2T LET,

Extensibility Accelerator(X, /L—/L1ER/ %/ (1032— %2 &M) T, TABLE BEHED
TanNT IZESNT, TARN ATV N VTRIHKT DY E ST - L
R LET,
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ER &z —uid, 148 ~2—3 [Web Add-in Extensibility ? Book Sample Y —/L % »
kDY R — ~OFME ] CTEHE L7=5&M (tagName = table, className = Book) (Z—%

LET,

Default Rules P

4 Identify Control
[ selectContrals... | |[E5(R | (EEr ¢ U 10

IF
lclassl\ame Equal Book J

( |AND
U ltacName Equal TABLE J

Test Rules... . Test & Refine... ]

[ ¥ Call identification Function ]

[ ¥ lgnore Coniral ]

Evb:MADOaY b= UTHT YR — FEBRETOBICE, By va ol
Boary ba—La2RIRTHUENRS Y £§, ZHITKY, Extensibility Accelerator i3
L OIEMHBRN—NVEAERT D LN TEET, ZDOL I R—E, BRLIFED
Iy hr— AR TR, Y TAEXATOTRTCOay ba—LE#H+ 252 &R
TEET,
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8 Extensibility Accelerator BEF L= v EVY - L—ILDT X +

ZOAT 7T, BEMICIER 72—/ L 7)8 Internet Explorer & Mozilla Firefox @
M C Book 2> hr— VAT HZ L AR LET,

a Y7V Book 77V —3 3 (%ALLUSERSPROFILE%\Documents\
ExtAccTool\Samples\WebExtSample\Application\Book.htm) %, 3~ CIZBAVT
V% Internet Explorer (212 T, H— N &N 5/5—2 5 O Firefox THE £,

b L1—WOTFiZH? [TestRules] m"Z %7 1) v 7 LET,

Book =12 N B — /LN DT T Y CHRFER S, Bl LEC [Done] R4
NFERSNET WERGE, 77 UVFICFBTT7+— D AZBEILET),

¢ [Done] #7 U > 7 L, Extensibility Accelerator TR Z{R{F L £ 7,
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9 Y—)L¥ vy FRET 7 M I)LIZx L T Extensibility Accelerator 237> 1-F &
7uvxz/ k- B2—77T, WebExtSamplexml 7 7 f V& X7 V7 U v 7 LET,
7 7 A /VINT, WebExtBook @ Control Z & ® H1|Z Identification Z3&7)3% 5 (37 C
T, 2RI, 77 U FICHAE L7 Conditions EENEG £, TOFIZ2 oD%k
RS> T, TOWGTNET-SnT-E 22 b —/u) WebExtBook & 7.7 S
E3x

<Control TestObjectClass="WebExtBook">
<ldentification>
<Browser name="*">
<Conditions type="IdentifylfPropMatch">
<Condition prop_name="className" expected_value="Book" />
<Condition prop_name="tagName" expected_value="TABLE" />
</Conditions>
</Browser>
</ldentification>
</Control>

TAL AT Vxs b 7T ACHT S Identification B3O EFEDOFEMICOWTIL,
[HP UFT Web Add-in Extensibility BARHE A Kl A 2% 5 Web =2 b —uizxt L
THHT T AN - FTT=7 b - 7T 2O FED UFT ~DOFEROHEE, UFT
Web Add-in ExtensibilityToolkit Configuration Schema ™ ~/L- 7 (Web Add-in Extensibility
VT DBRHTEE) 2SR T EEN,
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% 4 BtF% : WebExtBook DIRELEBHE TONRT A DURX FDEE

ZOETIX, TAL AT V=T b+ 7T ADEFRLZTEMT D 729DIT, WebExtBook 7 A
b ATV FTHEAFMREICT28E (XY v R) ER@ET a7 2BELET, &
NHOEFRIL, TAN A7V MRET 714/ (WebExtSampleTestObjects.xml)
IR ENET,

BOBMET, 2 bOEEE T o/ RT 4 OV R — MMIHEER JavaScript 32BN L 9,

1 Test Object Class T4 7@ [Operations] %2 7 #F<
WebExtBook Test Object Class 7 %' DAz $ 5 [Operations] ¥ 7 &&IRN L £,

2 Select ¥/ & GoToUsedBooksPage #£{EZiE 1N
a [Operations] >V —1"—7T, [Add] #27 VU v 27 LET,
lOperation1] &\ 5 A4 HTOHT LWEMERERED U 2 MBS h, @RS ET,
b [Name] &> 7 %iZ [GoToUsedBooksPage] * AJ1L %,
[Description] "~ 7 2z TUsedBooks R—U #REET 1 EANLET,

d LSO FEEMYIKL T, Select: W) ARTOEMEZBIML, #iHZ [RKZEZERL
F9. ICRELET,

e [Default operation] = v 7 - Ry 7 A&EBRINLET (Select HEIZx L T),
f [Save] #7V v 7 LET,

g ZDETOERVDOAFT v arERRFLT, MIBMEHTE 2022 ~E7, FEflic
WTIE, 111 ~*— [[Operations] % 7 (Test Object Class 7% 1 F) | 2B L T
TE&EWY,

Select #E & GoToUsedBooksPage #fElX, 5z o7, EbIKLEHA, Lz
BoT, ZHNELEEEEZITH MEITH Y EH A,
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3 GoToAuthorPage 1#&4E%3EN

o
e an T

-

GoToAuthorPage &5 A RITOHT LWEEZBINL, fill % FEDEEICHT S
Web R—DZRHEET ) ITRELET,

[Operation Arguments] > —/L/N—"7T, [Add] %7V v 7 LET,

[Operation Arguments] 7—=7/L® [Name] %iZ, [AuthorName| & AJjL £,
ZHIER 0T, [Optional] FIDF v 7 « Ry 7 A&7 VT LET,
[Description] %z, E&) L AN LET,

[Direction] %11 & [Type] #IIEMEREMEz O EEMEMNLET, 2FV, Zh
MXFFETHY, BIRTEINDZ LERLET,

[Save] #7 Vv 7 LET,
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4 HLWTFR - FATSzH - V53XV FX - Ea—IZ&TF

Yzl keI AT —TDFD [ClassView] ¥ 7% 27V v 7 LT, 7T A
Ea— 42—V %2M) 2 ET,

Class View >~ 0 x
Test Object Classes g X

A% WebExtBook

Cperations

GoToAuthorPagelAuthorName)
GoToUsedBooksPage()
Select()

&lProject Explorer|  Class View

WebExtBook 7 A b « A7 V=2 b« 7 TR &, ZFRIHELLZT A 2R, TA b -
FT2 T N T TADY A MIRRINET, EFRLIEBRIENPBIEDO Y X MIETR
SNET,

5 Test Object Class 744/ 7@ [Properties] % 7 #Ri<
[Properties] % 7 (Test Object Class 7 A F) (123 X—T & SM) #BIRLET,

6 WebElement hW SR T 5 TO/T 1 ZH6E

a htmltag 77 /37 ¢ 38R L, [Properties] ' —/L»3— T [Inherit From Base Class]
7 Vv LET,

b FUZ¢% htmlid e 7 (125t L THITWVET,
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7 FR/\T 4 %3BN : title, authors, price, min_used_price

=) a

b

C

[Properties] > —/A/N—T, [Add] 227 VU 27 LET,

[Property1] L WO ARIOHF LNT B X7 o N7 AT DU R MBS, 3
WanxEd,

TaTFa4Ews) v LT, Mitle] E AT LET,

X 51T, authors, price, min_used price &\ ) ZARTO T BT ¢ ZBMLET,

8 JONT 4 EEYHTIIL—FIZEM

COEZTOEMIHDHTaNT DY A NME, UFT A7 T 4% 8D L) kel
AT AN ERELET,

a

[Object Identification - Mandatory] 7'/ — 7 %&R L £,

SOOI N—FIEN LT a T 41, UFTICE > CF AR - A7 U=/ hanih
R ShET (FAR A7 V=7 babiE, BEOT AL AT Vs R
fﬁzéiﬁ%ﬁuﬁ‘é A=A AP RN N —(ﬁ—)o

htmltag & htmlid (ZZ D7 L —FICHBMICBEMS T E T,
title 3 X Wauthors 7 X7 42X TN 7 U v 7 LT, ZOZNA—TILEMLUET,
[Checkpoints and Output Values] 7 /L — 7/ %3&R L £,

ZOIN—FIBM LT m8F 1%, UFT OF = v 7R A v k& A E
TEXHX91T0ET,

B LT=7 a T 4 22 nNTREL T N7 ) v 7 LT, ZO7V—FZBMLET,

BNMLIEET o XT o DF v 7 Ry 7 A3, EERECTERIATHET, =
WX, Ty 7 ARA Y FERIMEZERT AR IO DT 0 X7 ¢ ZAERERRE T
BINT S X912, UFT ICHRT A& EIZ R LET,

[Object Spy] 7 /L —7FZ@iR L7,

ZOTN—FITEBM LT e T 11, UFT DA TP =7 b« 2231 T Al
WD ET, TXTOTaRT A PEERETZOZ A —FIZEBNINTHWET,
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9 FRAI-FTPxH FRET 7 A ILIZH L T Extensibility Accelerator A%
To-ER#HR

TuYxy b Ba—T7 %HZ, WebExtSampleTestObjects.xml 7 7 A /L% X 7 )L
7V LET, TOT7 7 A/ T, WebExtBook 7 A k « A7 Y=/ k+ 7T AD
BIEL R T 08T 4 23, 154 ~X— [Web Add-in Extensibility #+EF = >~ 7 U & k|
THHSNTODFFMICHE > TERSN TV D2ORR LN DITT T,
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BEIL, AL, ST ALAIESIEE o TER SN E T, Select #eEix, 7 A b -
FTV=0 b 7T AOFEREOHRIFEL LTHRESNLTWET, o7 1 DER
Wi, e T A BRT DN —TERT XML BERH Y £,

<ClassInfo DefaultOperationName="Select" GenericTypelD="Object"
Name="WebExtBook" BaseClassInfoName="WebElement">
<Description>The test object class used to represent a Book control.
</Description>
<HelpInfo />
<lIconinfo IconFile="INSTALLDIR\Dat\Extensibility\\WWeb\Toolkits\
WebExtSample\Res\WebBook.ico" Iconindex="0" />
<Typelnfo>
<Operation Name="GoToAuthorPage" PropertyType="Method">
<Description>Opens the Web page for the specified author.</Description>
<Argument Name="AuthorName" IsMandatory="true">
<Type VariantType="String" />
<Additionallnfo xsi:type="xsd:string">The author.</Additionallnfo>
</Argument>
</Operation>
<Operation Name="GoToUsedBooksPage" Property Type="Method">
<Description>Opens the UsedBooks page.</Description>
</Operation>
<Operation Name="Select" PropertyType="Method">
<Description>Selects the book.</Description>
</Operation>
</Typelnfo>
<ldentificationProperties>
<ldentificationProperty Name="authors" ForVerification="true"
ForDefaultVerification="true" />
<ldentificationProperty Name="min_used_price" ForVerification="true"
ForDefaultVerification="true" />
<ldentificationProperty Name="price" For\Verification="true"
ForDefaultVerification="true" />
<ldentificationProperty Name="title" ForVerification="true"
ForDefaultVerification="true" />
</ldentificationProperties>
</ClassInfo>

TAN ATV MRET 7 A )V ORETE &L NAEDFERMIZ, UFT Test Object Schema
/L7 (Web Add-in Extensibility ~/L 7 CRIHAHE) 2B L T 72 &0,
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UFTADFaS Y tOTFFASEY—ILFY b Y R—F -y D
TR

ZZETT, V= Fy b PAR—b -y FVOERFETTRATERINTNET,
XML REZ 7 A WML, UFT 3Y =A%y FE¥R— b SNDBEEDO Y 2 MIFKRL,
WebExtBook 7 A b + A7 V=7 Fe ZORECTHEMAMREERTIL, ZOT AL 47
YV MeERT LI ba— LV EREBT AT O ERERBERN/EENTWVET,
F 72, WebExtBooks T FIREZREEL 7' m T 4 LT TIZERINTVET,

BEOETR T v T (EOBSIC M ERRE I E EHEG L TV ERAD, ZOIHTI,
Y—F ke PR —F-ky &2 UFT CHEALT, Book 2> ba—L&2#~, *+7
/7 FURYRNVICEINL, 2 b — T 57T A M 2T v FEERTE 7,

Y—IFxy bk -HiR—b -y bEFIOSTBIZE, ROFIEERTLET,

1 [View] > [Toolkit Support Properties] %R L %9, Toolkit Support Properties 7
PAFHRENWED 47—V %5H), [Development mode] * 7'+ =z & EINL,
EREERFLET,

B TOT Fuf AL T, BICZorTvarEHEALEY, Zhicky,
FAb T TV FRE XML 7 7 A /L T ldentificationProperty %35 0 g it 2 2
BLESGAIE, UFT BT R TCOEREZEATL X010 3, FFHBET LESGE
1L, EBRICEHT 7201 F — AT RIS, Zo4TvarwE 7 VT LET,

2 [Project] > [Deploy] > [Deploy to QuickTest Professional] % &R L &7,

V=¥ ke BR—F Yy bOT 7 AL, <UFT £RIE7 FA1 2D VX b—
JU » Z 4 LA >\dat\Extensibility\Web 7 + L &2, 142 X—Y [F7aAf A 77
ANDOREE] RSN TWAETT 7a A ShET,

Extensibility Accelerator Z £ L C UFT O\ a2 v B a—# CTHR— MR T 5
4, [Project] > [Deploy] > [Deploy to Zip File] %#i&{R (E/-ixFv—2r 77— -
7 4> Ko ® [Deploy Toolkit Support Set] "% > %27 U »7) L, {ElT 5 .zip
Ty ANDONRAERELET,

Extensibility Accelerator (%, #7277 A WAiEE zip 7 7 A VPICIERR LET, ZD
T 7 ANE, UFT 2 Ea—4% EO<UFT £1E7 FA VDAL DR b—JL- T HILA>\
dat\Extensibility\Web ~ =+ /L % (2 JEB L £,
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Y=Ly b -HYR—F -ty FEFRAMFTBIZIE ROFIEEZEETLET,
1 V—Fo b PR —F vy hOTTaANET L%, UFT 2l & £9,

SELUFT IR, Bz Xy —AF o b e BR— K« 77 A L EFHIABET, UFT
BEWTWAEHAIZIE, BT LTHrOEEREITA2XLERHY 7,

[T Ry ~x=Vx] AT 0T Ry 7 AT, HAEERT BA DU R M,
WebExtSample 7 Web B850 T & L TERRINET ([T R ==V v ] ¥4 T
a s e Ry 7 ANV EAIL, [HP Unified Functional Testing 7 KA >« HA K]
ZZRL TSN,

2 WebExtSample DF = v 7 « Ry 7 2A%Z&ERL, [OK] 227V 27 LEd, UFT 3B
X BmELEHA— EE—FLET,

[] 3 GUI 7AMERZ, (A7 V=27 VRV KNI X470 7 Ry 7 20 [HRTAR
FAITOzH VOB RX %27V v o 0E, FHRTANE T V27 FOER
EATag Ry ZNEE £T, WebExtSample BitE7y (3R] U X MCFERENE
T, U A 2D WebExtSample BREARINT 2L, TR A7V b THAF
TiEF L7 WebExtBook 7 A k + A7 Y=/ b« 7T AN, FRELET ALt d
Hiz, [PFR] VA MIERINET,
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4 Yo7 ar br— L EBETT 572017, %ALLUSERSPROFILE%\
Documents\ExtAccTool\Samples\WebExtSample\Application\Book.htm 7 7 -1 /L
ZHEET,

FELUFTIE, 77— a NN e 7 AU r—a v & OBk a i L%
4, L5 T, Book 2o hm— L BHWTWAIRAIZIE, & T LTH5FEREd
HUHENRHY ET,

UFT G, Book 2> hua—/L|Zk L CROBEMEEZFEITL, UFT B2 hr—Lax 8o
L O T 20 &~ E T (UFT TOIEZEDFHMIZ-DVW T, [HP Unified Functional
Testing 2 ——X « T4 F] 2R LTLIZEWD),

> ATVl b ARAEBHEHALC, BT a7 4 2FK AL, Book 2 hr—/L
WXL THR—=FENTWBET AL - A7V MEET A M LFET,

ik

» Book = b —/LHIZIER &7 WebExtBook T A ks « 47 Y =7 MIIF,
TARN ATV b I TADABBDHFNTCNET, 2Oy AUDHEDIF
IT, V—=nAFy b HR—bF By NEIRAZAALT, DTN
AizEELET,
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> TAM ATVl MEEDY X MZiX, WebElement A7 Z 2 Hikk L
72T _RTOEE (A Yy T a7 1) L, Test Object Class 7 VA F TEF
LIcT RTOBEREENET,

=

B Object Spy (7]

v |

Object hierarchy:

@

=[5 Browser
BD Page
f L MwebExtB ook

Properties | Operations|

) Mative @ ldentificatian
Properties Yalues

T~ Clazs Name ‘webE stB ook 7

T authors i

T min_used price

T price

T title

g gy

Selection:
Clazs Mame
Description:

Dezcriptions are available only for test object operations.

Cloze

> BT u T 40U R ML, EBRELETRTOTa T 4o NEENET, 7
0T DERFRENTHVRNDIE, 77— arhb 7 usT  Off
ST BB A EEEE L Ty (>, WebElement JiA 7 7 2032
5DTBRT 4 EZ P R—=FL TRV NETT, 20X BT Z0F = —
MU TAOHOITTEREELET,
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w2

> A7V N YRV RNI] FAT0T Ry 720 [A—ANAF TS b &

Bl REUEEALT, Book = ha—L& 2 LEd, A7V b UR
PRI TTFARF TV FERTOIZIELWT A 2 U MEH SN TWSD R
BLTLEEN,

XF—U—RK:eba—7T, £7V=7 b+ VRY U D WebExtBook 47 =7 k
 [TEB] #7LTEIRLTT A b « 27 v 7 2B LT,

> (B 7 LML FTREZRERIED U X MITIE, ER LIEBRIERE TN TV ET,

> GoToAuthorPage #:/EZ IR L 3, UFT X [{l] Loy —Lbr M2
AuthorName &\ ) 5184 2 FR LET, EEO5IKEFOBELZERZ LTS
&, BEABRIR L7z & =i, [{lE] BB BEDOBI OIS U THEISET,

> BEMEICKH L THERRENLZY— e v M2IE, EELEZGADKMISNET,

> [FFa2 AV HTLTHE, ERLEBIEORT v AITH LT REFa A b -
= VIFfEA & £ A, Extensibility Accelerator DL —H + A > & 7 = — A%
RFa A b PV EFR—-FLEEAR, XMLTT 4 X E2EHLTT A
b F TVl MRET 7 AMIFHTEMT L LIETEET, ZUIZD
Ly AL DBROFTTITNET,

TF 4 X EPIE, WebExtBook 7 A b « A7 V= FEEHTEZT AL AT v
EERRLET, A7 — MA U FEHBHEHERERIZIE, AR -7V NCHEAT
EDLTRTCOBEN, BOTERLEZLOLED TERREINET,

BHEOBIBITHERRERE L ER L Th AL, TNb A7 — b X v NS
DA MZEREINET, 5IEICHEHARER % EFT 5 I121L, Enumerations 7 1
F 51—V %5M) THZEEZEHL, [Operations] ¥ 7 (Test Object Class 7 Y
AF) M=V EBH) TENEFIEZ AT L L TEIRLET,
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5 WebExtBook 7 A b+ A7z MK LTHLWT A b - A7z MEEELFEITT
DAT T HFOTANEFITLET, 7TA L A7 V=7 MMEOETOTD DY
R PFeELERELTWRNOT, ATy T2ETLTHT I F—2a THLT
WX biThoivER A, 72721, Extensibility Accelerator 135 L WRIEOZ N ZHicxt L
TZ2? JavaScript BIA Z 7T A B L TWET, L7z -T, 2 br—LIkt LT
TAN ATVl NEEEFITT D JavaScript BI% A UFT MR L7- & &2, Z=ED
ABTPRONDDT, FATREZ 7 —13FELEH A,

ES5BRE: FAM-FITOxH FREEDYER— FOEE

UFT WA AL L - v ba— A&l TE5L212LESL, TA L - FT7V=7 MRE
DEITOFR— N E2ERTHLERDHY T, EXRLET AR A7 V=7 MREDZ
NENIZHKH LT, arbe— 43527 v 7 2FEITT 5702 UFT BNFEOH T
JavaScript B A ER T 2 LB H Y £7,

ZDIETIE, WebExtBook DF Ak« A7V b« AV vy RIZxtT 5% R— b &ERk L
FI, JHBL7eB AV v Ni, Select, GoToAuthorPage (AuthorName),
GoToUsedBooksPage T,

E:ZOFa2— MU TATIERT 59X TO JavaScript = — R, Microsoft Internet
Explorer TEITT 2 L2 IZKFFENTWET MAD = br— OV KR— MERET D
BIZiE, 7T U PIURIE LRV E D ICEEL, 307 I U TH UFT A2y bu—b
EYVR—FTEBLIICTDHZ ENTEET, FEMIZOV T, THP UFT Web Add-in
Extensibility BAFE A K] ©O7 7 v FIUKIF LW A — FORBOEASZRL T
YA

1 WebExtBook.js JavaScript 7 7 1 JLZR <

EXTDT AN AT VxT ke AV FOZRZEIIZR LT, JavaScript 7 7 A /L &
BEEEET Db TEET, RELIDOLYAVTE, AR AT V=7 k-
AV REFETTHYR— METELETHBERFIETERT 2 FIEEBN LET,
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I

WOFIEONWF e FITLET,

> TAL ATV x=7 b+ THAFD [Operations] ¥ 7T, Select #{EZEINL,
[Name] & v 27 A0 [Implementation Code] "X > %27V v 7 LET,

> VT A-tEa—T, Select #4427 VU >~ 7 L, [Implementation Code] % i%&{R
LET,

WebExtBook.js 7 7 1 V3B &, JavaScript T 4 % (22— % &) T Select B
ok LR SN2 4 7 iREREh T,

ERLBEOEREI— FZEM

FEAERR 1%, UFT 1% JavaScript 7 7 A AVNT, TA b« A7V MfELFREIC4
ATORB AR L £ 97, JavaScript B¥IL, AT L7 A - A7 V=7 MMELRILE
L ERFOLENRDHY ET, Lo T, I THERETIHNIEND D JavaScript BIEIE,
Select, GoToAuthorPage (AuthorName), GoToUsedBooksPage T3,

Extensibility Accelerator £ 24156 DOBAD A X 7% T TI/ER L TR Y, BN+ 25 a—
ROFIR=a A PO THRASNLTOET,

FRBDAZ T a2 RO, WITRTRINT 2 FEITE S E T,

E:oelem ATV M, BFELETDO HTML =22 b0 —/L A BT 5 72012 UFT
PERT L TRENAT Y27 M TT,

function Select()

{/l Click the link in the second cell of the first row.
_elem.rows][0].cells[1].children[0].click();
_util.LogLine("Running Select test object method.",1);

}
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function GoToAuthorPage(AuthorName)
{/l Look for the specified author name among the children of the first cell
/l'in the second row and click it.
var bWasFound = false;
for( vari=0 ;i< _elem.rows[1].cells[0].children.length ; ++i )
{
if( _elem.rows[1].cells[0].children[i].innerText == AuthorName )
{
_elem.rows|[1].cells[0].childrenli].click();
_util.LogLine("Running GoToAuthorPage test object method.",1);
bWasFound = true;

/I Update the report

var params = new Array();

params[0] = AuthorName;

_util.Report(micPass, "GoToAuthorPage", toSafeArray(params), "Author ™ +
AuthorName + " was found :-)");

break;

}
}
if( bWasFound == false )
throw ("Author name not found !");

}

function GoToUsedBooksPage()
{/l Click the link in the first cell of the third row.
_elem.rows][3].cells[0].children[1].click();
_util.LogLine("Running GoToUsedBooksPage test object method.",1);
}

FORE: TAF-FATOx) FMREICHLTERHLEZYR—FDTX
TG
[Debug Test Operation] 47> 3 2T 5 &, BEICK L TRGEFL2FEEDT X |+
ET Ry Tk, V=Fy b FR—b -ty MEUFTIZT 72 A LR THHETTE
%9, Extensibility Accelerator %, JavaScript %% = b e — Wik L C UFT LRI CH
ETEITLET,

JavaScript BIER 23 F21T S 415 & ¥ 1T, Microsoft Internet Explorer T31T L TW A A1,
Microsoft Visual Studio 3% @ JavaScript 7 /3 7« & v 3 3 > & [ JavaScript BI%KL
BTNy I TEET,
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1 BEOTX FE%E(HE
a Internet Explorer 7 7 VW CAZ U T NOT NNy T HHMNILET,

WIZHl &7~ LE 7, Internet Explorer 6.0 £721X 7.0 C, [WY—IL] > [41 V8 —FY
AT ar] ERIRLET, GERE] 27T, [F59X] Z7v—70 [R
HSYFEDTFNRYTHFERALBEW A7 a2 2707 LET (INSDFT Vg
VEERELEERT, 77UV EBHUCHLOHEETSLENHY £9),

b YV>7n .77V r—3 9% Internet Explorer TEITLET (Tuv s Inika
VT UVEFTATAIEEENRNTL I,

€ Extensibility Accelerator T, i)V + > KU % Bi& 9 ([Debug] > [Windows]
> [Output]), MEFERIGE, Vv KU U v 27 LT, [Clear All] ZiE{R L
ij—o
2 GoToAuthorPage TA bk - # TV x ¥V MEEZT R & & L TEIR

b TAK ATV b FYAF D [Operations] ¥ 7T, GoToAuthorPage f:1{E%
#IR L, [Operations] > —/L3—@ [Debug Operation] "% %7 U v/ LE T,
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[Debug Test Object Operation] %A 7 1 7" « /K> 7 A3BH &, WebExtBook 7 A bk - 4
7>y b - 7T AL GoToAuthorPage #{E/VBIN SN E 4,

i Jﬂebug Test Object Operation

Test ohject class: [WebExtBook hd I

Operation: [GoToAuthorPage hd I

Enter the values to use for the operation arguments.

Name Type Value
AutharMame String

3 You must select a control before running the cperation,

| Select Control | | Run Operation | Cancel

3 BEE2ETT5a,O0—)LELTBook Oy FO—)LEER

a [SelectControl] #7 VU v 7 LET,
Extensibility Accelerator 233EFR R IZ72 ¥, Book =& b 0 — /L3 7 T o Cofif &R
S, EmE EEIC [Cancel]l AZ U ARFINET (TAUTITD LIR30 5
ZEBRBHYET),

b #FHFE RSNz Book 2 ha—E I U w7 LET,
[Debug Test Object Operation] ZA 7 07 « Ry 7 AT +—BANREY £,

183



$E6E.Fa— k1) TFIL: Extensibility Accelerator Z{ER LA X% L Web 2> FE—/LDHYR— DK

4 BEICERTS5I8%EAN
SIEfET —7 Vv C, AuthorName OfEED&/VIZ, Jane Doe & AJJLE T,

5 BEE=EfT
[Run Operation] %7 U v 7 LET,
Extensibility Accelerator |3 GoToAuthorPage #:1E% 514 "Jane Doe" THEITL £,
PN 77V r—va yE, JaneDoe.htm X—UREIRINET,

HAD 4 FolZiE, Zo7 vt X THEOH S _util.Logline A%t & _util.Report B
BRFRENTNET,

D ZORT T, SIBOERDEAEHLCEEET A M LE L, IELZRWD
FEL WM U254, JavaScript BA%IE B4 & R4 L, Extensibility Accelerator |3
T— Ayvk—VERFRLET, UFT ETE v a UV CTEIEEZET LGS, BlShC
Ko TEATHE T — A v —UNEL, HISNL 52X DN TFIINRERINET,

6 BBIZTL—9 RS > F%EERE L T GoToUsedBooksPage k% =£1T
a 77v%T, [Backtosample] 7V v 7 LE7,

b JavaScript =7 1 &% T WebExtBook.js 7 7 1 /LIN®, GoToUsedBooksPage %X
DA—= RORYPOITOE~T = %7 ) v 7 LT, TL—IHRA » befiALET,

€ 77 A-tEa2—T, GoToUsedBooksPage #{E% 27 U v 7 L, [Debug] %i%&iR
LT, [Debug Test Object Operation] %A 7 B2 « RNy 7 AZFHEFET,
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d [RunOperation] %27V > 7 LE7,

Extensibility Accelerator i< GoToUsedBooksPage %% 4T L, 7L —27 KA
FCEIELET,

e [Debug] V—N—b X=a—iF, SEIERT AT - AT aryBAES
nNTnWEd, Zokyraroi%e LT, [Stepinto] , [Continue] , [Stop
Debugging] oW T @A L THRTL ZEN,

7 Select AY Y FDTRX b+

HIORT v P THEAREY —NVEFALT, FELEEVOT AN ATV MEE
T AMLET,

ETEE:BEIONRTOYR— FORE

ZOHETE, 7AMETRICEE T 0T ¢ OEEZIRGT 27200 R— M E2EELE
9, UFT %, @7 v 37 ¢ OFEITIEOfE%, GetROProperty 72 &0 X & S F 2 EHES
AR ATVl b Ay FCHERALET, BT 237 ¢ OFITREOfEIE, T v
JRA b EMIMEOIERIEREZ &, S E SR EAMELZFIT T OBICHLLEIZARY
=3

AR — h 3% WebExtBook DB~ 1= /37 1 I3, title, price, min_used_price, authors
T3, html tag & html id O AR — MNIEEFTALEETHY THA, ZOEEF
WebElement 7> bk S 5726 T,

2SN Z T, logical_name 7 737 ¢ O G T 2 FEARRM L £3, 2L UFT
MT AN - F TVl FEERTDEIZ, TAL AT V27 NOAHIZRET D720
W T2 7 07 4 T, 207 a7 A DEEIAZARXTHT LITL
U, WebExtBook 7 A b + A7 V=7 NOAHIEEDOBAIZIESNTHIT S L HIZUFT IZ
FRTDHZENTEET,

get_property_value %523 logical_name 7' & /37 ¢ %7K — K LBRWEAIZE, T
e A7 V=22 MIITAN ATV b 77 AQARBEIV L TOHRET (125D
NR=DWIRILT AL« F TVl b VT REESFT TV =7 N BNERIEET DA,
AT o7 ARMFMINET),
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[

WebExtBook DR T O/NT 1 DRTHOEZRM T BICIE, ROFIETITVET,

TARN ATVl NOEFT 0T 4 ZIBET H 729D JavaScript 7 7 A L & B D4
RiZRETHZLbTEET, L, ZOLyAUTHE, EEREDT 7 1L & B
THAR— h&BHF L ET, Extensibility Accelerator IXBED A X 7T 2{EL L TE Y, EXR
LIe& T anRT 4 B3 570087 v a U REORICHBES L TOHET,

1 72 FT V=7 b TV A FO[Properties]| ¥ 7T, 7 /37 ¢ Z3ER L, [Properties ]
Y —LN—@ [Implementation Code] ~¥ %7 U v 27 LET,

WebExtBook.js 7 7 - /L7 JavaScript =7 « # (22— % & M) TR»NET, 1 —
YV ViL, get_property_value B3 D7 ODIZHEBE INIZAZ T O, R LT= 7 v X7 4
DIEZBET D700 7 v a v OEHEICEMET,

2 get_property_value B4 C, ¥R — b 5687 a7 s Hoa— Kz Ao, RIR
FTa—RIESNT, T T OEERETHRIICHRELET, HRLhbsr7n
/X7 11, logical_name, title, price, min_used_price, authors T7-,

& DL, get_property value B {k%, WOEEICEESHZ E7,
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function get_property_value(prop)

{

if ( prop == "logical_name" || prop == "title" )
/I For the "title" identification property, as well as the "logical_name"
/I property, return the inner text of the second cell in the first row.

{

return _elem.rows[0].cells[1].innerText;

}

if ( prop == "authors" )
/I To return a list of all the authors, look for all the children
/I of the first cell in the second row.
{
var BookAuthors = "";
var AuthorsCount = 0;
for( vari=0;i<_elem.rows[1].cells[0].children.length ; ++i )
{
if( _elem.rows[1].cells[0].children[i].tagName == "A" )
{
if( AuthorsCount > 0 )
BookAuthors +=",";
BookAuthors += _elem.rows[1].cells[0].childrenli].innerText;
AuthorsCount++;
}
}

return BookAuthors;

}

if ( prop == "price" )
/l To return the price of the book, return the innerText property of the
/I first cell in the fourth row.
{
return _elem.rows[3].cells[0].children[0].innerText;

}

if ( prop == "min_used_price" )
/I To return the lowest price available for a used copy of the book,
/I return the innerText property of the second child of the first cell
/l'in the fourth row.
{
if(_elem.rows|[3].cells[0].children.length > 2 )
return _elem.rows|[3].cells[0].children[2].innerText;
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ESEE: BEIANTAICHLTERHA LY R—rOTR N E
TN T

[Debug Property Retrieval] 47> a V2 HTHZ &I2LY, BfEE2T A MLz L
FEEOIFIET, 78T (I L GG LEREEZ T AN LT Ry I TEET,

1 7O0RTADTRNEEE

HHR— & D /3= 3 O Internet Explorer T, 7L 77V r—va UERHE
T (FEE : 77 v ¥ %B < ANl Extensibility Accelerator C WebExtBook 7' &2 ¥ = 7 |
ERWTEBE, 770 Ty Ry ENTcar T oY EFATLILERLYD £9),

2 [Debug Property Retrieval] ¥4 70745 - Ry A%<

TAN AT T o TYAF D [Properties] ¥ 7T, authors 7 1/ 37 ¢ % EiR
L, [Properties] > —/L23—@ [Debug Property Retrieval]l "% > %27 U v 7 L£7,

[Debug Property Retrieval] %A 7 12 « Ry 7 AH[H &, WebExtBook 7 & k « 47
YxZ k77 AL authors a8 T ¢ RIS ET,

4 Debug Property Retrieval
Test object class: [WebExtBook = I
Property: [authors x I

Property value:

3£ You must select a control before retrieving the property value.

| Select Control Retrieve Value Cancel
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3 7ORF4ZWRBTHa2rA—)LELTBook Y FO—)LEER
a [SelectControl] 27V v/ L% 7,

Extensibility Accelerator 233EZ/RIZ72 ¥, Book = v b @ — /L3 7 T 0 CHligiEoR
Sh, HifE LEC [Cancel] RZ U ARARINET (ZHITITD LEFRIR 0 5
ZERBY ET),

b R SH 7 Book a2 hu—A %7 U v LET,

[Debug Test Property Retrieval] A 70227 « Ry 7 AT +—HANKRY £,

4 ToRTaEERE
[Retrieve Value] #7 VU v 7 LET,

Extensibility Accelerator /X, Book =t > k =—/L{Z%f L C, get_property_value PH%%
5% "authors" TFEITL £,

[Debug Test Property Retrieval] %A 712 « Ry 7 AREFH OB X, [Property value]
AR 7 212 Jane Doe,John Doe AF R ENE T,
5 BY0TanT«&TRAE

min_used_price, price, title D% 7 0/ X7 4 OEOEEGE, IO T v 8T 4 L[FH
UHETT A MNLET,

JR— D UFTADTTIOAEBTRA
ZHTC, Book v b a— UIxtd B AT v S DFEST, BEOFELT, T a T 4 DD
HBEVR— T D7D RFREFNET LE L,

ZOHETIE, V= Fy b Y R—bty bEL I —FEUFTIZT 724 L, Book 2>
ha— kT D AT v T DFEITET AN LET, T 70 A DRI, F—U—F:Ea—
D [FXa AV BT 25V R— N TE-OICMNEREEEZITVET,
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1 FAE-FTP14H FBET 7 1 )LIC Documentation ZEXZFETiEMN

Extensibility Accelerator T7' 2= |k + =7 270 —F /15
WebExtSampleTestObjects.xml 7 7 1 /L 4B %, &3 L 7-#{£\C Documentation
FEREZBMLET, Typelnfo BEERITKRDO L 51720 £7,

<Typelnfo>
<Operation Name="GoToAuthorPage" PropertyType="Method">
<Description>Opens the Web page for the specified author.</Description>
<Documentation><![CDATA[Open the Web page for %a1.]]>
</Documentation>
<Argument Name="AuthorName" IsMandatory="true">
<Type VariantType="String" />
<Additionallnfo xsi:type="xsd:string">The author.</Additionallnfo>
</Argument>
</Operation>
<Operation Name="GoToUsedBooksPage" Property Type="Method">
<Description>Opens the UsedBooks page.</Description>
<Documentation><![CDATA[Open the %! UsedBooks page.]]></Documentation>
</Operation>
<Operation Name="Select" PropertyType="Method">
<Description>Selects the book.</Description>
<Documentation><![CDATA[Select the %I book.]]></Documentation>
</Operation>
</Typelnfo>

2 Y R—+% UFTICF A4
[Project] > [Deploy] > [Deploy to QuickTest Professional] % &R L £,

3 UFT #f &, Book 77U — 3 U &ET

a UFTZHALTHhBHUMEET, [T A v v3x—Vx] ATl Ry 7 AT
WebExtSample DF = > 7 - Ry 7 2A%@&RL, [OK] #27 VU v 7 LET, UFT
NEE, FEtLEEYR— e —FRanhEd,

b V>7n -arba—NEKTLTIOLEEFEITLET,
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]

4 TAF-ATOx) FORFFITOYR—FETR F

GUI 7 A MEBNWT, A7 V=2 b VAV MY ZHE, [A—A~AFTOzY %
] RZ> %2 w2 LTBook 2> b —L &% LES, UFT BMERK L7-T A
kA7 =2 NO4RID The History of QuickTest Professional Th % = & % ffeid
LET,

5 FRMATOzH) FMEEDETOHR—FETR
a WMOAT v T heEGleT A ME{ERL, TARNEFITLET,

Browser(“Book”).Page(‘Book”).WebExtBook(“The History of QuickTest
Professional”). GoToAuthorPage “Jane Doe”

3 : GoToAuthorPage 7 A b + A7 Y=/ b+ AV v RIZ, 2y har—/LITFE
L7pWEE L% 52 THEITT D &, JavaScript BB BIsA 2 RELET, 77U
WCRFLDFIFMCET DT — A —=URNEREN, TR ITTENE I %
Fhbohnichb, [WWR] 2270y 7 LET,

UFT (361542 6 52 b X 2 GO FEITRT T — - Ay b—VaRRL, 7
Z b 2Ty FIFERBLET,

b Select 15X 1" GoToUsedBooksPage 7 A  « &7 =7 b+ A Vv RK&T A b
T 520, FEEOT A FEERLE T,

€ ¥—U—KREa—TTAb - FT7V=7 MMEZH L TEREIND RFa2 A2 b
SCFHNBIE LW & R L £,

6 BHEIONT L DETHOEORBOYR—LETR L

a WebExtBook 7 Ak + A7V x s NMIKTDHAT v 7 HERLET,

b +7Y=/ a7 ) v/ LT [BEFzyIRAY FOBA] 2R L ET,
(Fzv I BRA L bOTRT ] FATOT Ry 7 ARKRENET, TA b+
FTT 2l VRET 7 ANTER LICE#B T 237 ¢ (title, authors, price,
min_used_price) 7 1/%37 ¢« URA MIFERINTHNT, BRI THDIKEE
ThHhHZEEHERLET,
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C FTNENOE#HT e T 4 2HEGEL, HETF v I/ TN AvE—V Ry 7 AT
FRTHBTAMEER L CEIT LET . 2L 2, ROLIBRT A MEFEITLET,

Itemn Operation Walue
w @ Actionl
-9 Book
- D Book,
ﬁ “wiebExtBook | CheckProperty: "authars",""lane Doe John Dog"
: ﬁ WwiebExtBoak : Check CheckPaint[* " ebE xtB ook
- Function Call i MsgBos Browszer["Book').Page["E ook' ] webE «tB ook [ "webE «tBook"]. G etROProperty( title']

PO AT 7T, authors 72 X7 4 DEEF =7 LET, 2FHORAT v
T, Fo v ZHRA Y FNTRINLIZT7 087 ¢ (2 2Tl price & min_used price) %
Ty LET, 3FERORT v 7T, ROBEHEA v E—Y - Ry 7 RZRRL
£

d [OK] 27Uy 7 L, Avk—Y Ry ZA2ALES, TAMPETTDL, #&
RBFIRSNET, FATHROY ) —2RHT DL, 27 v TOFHMERPERS
nEJ,

EIBREE : Book Y FA—J)LEDRFDHHR— FEEE

Fa2— NI TARZ ZFEFTHEALRERT, fERLEY—Fy F - AKR—F-&y T
X, T CIZUFT OFT X TOMERPEH CXE 3, UFT L Book =¥ k1 —/L &30 L
FEL, TAMEERITTLIENTEET,

UFT TT A FEAERT 269 1 DDA 7T a v OFERL LT, 2a—FRn7 7Y r— =
VCETTLMERZ LT D HIENSH Y 9, 148 21— [Web Add-in Extensibility ¢
Book Sample > —/L% > b DY R — b DFHE (TR STV D K 91T, FHERE TIE, UFT
X Book = h— /LAND I EIFER Web J v 7 RPEBEA T V=7 MIXHLT, Higd
Click B E/Z T 25k LET, £z, 7V v ZIZS LT T Book 2 hr—/LHE TEITX
% Select, GoToAuthorPage, GoToUsedBooksPage M4 #{E4 fidnd L, &5
WZFE7 T A R OFATORIERIZ AR D £ 7,

ay ba— VKT DI AL A ASNTzmeka R — F35120%, BERANV b E
Vo AT BLIICUFTIZHERL, ZNENOA XY MUSLTEDT A « AT v
Zitdk T A0 UFT IZELE A MNERH D 77,
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Z D=, 2 FEFEO JavaScript BIEE 1ERC L £ 97,

> AU MDY vy AUEREET D 1 OO JavaScript B, Ziuik, UFT 2% Web Add-in
Extensibility SDK CABI L TWD _util 2—7 4 VT 4 - A7 V=7 +O
RegisterForEvent %% ] L C, ) /R BHR KT 2R <X hDY v A%
BERLET, ZOBKOSIEICI 5T, A2 b2BFEA LTz & Z1Z UFT RO
JavaScript BIEARE D £,

Test Object Class 7 %1 F® [General] % 7C, Z ® JavaScript B D4 RIE, A7 =
> THFT 2 FEE L £ 9, Extensibility Accelerator |3 Z DfE#HE Y — /L% v FRET 74
MIRFLET,

> A X2 NEUHET B 1 DF IO JavaScript B%k, i, _util =2—7 4 U7 ¢ -

F7 Y= o Record AN LT, & MIBMT 2 AT v 7% UFT IZ465R
LET,

i : Record Bi/e b Da—7 ¢ VT ¢ - A7 =7 MUK, SafeArray % 1 7D
S EETVLENH Y FF, BF%E SafeArray (AT 5121, Web Add-in
Extensibility |2 & &4 CV 5 toSafeArray (array) BI%k 2 L £9, = OB,
<Extensibility Accelerator € > X k—JL * 7 # JL & >\bin\PackagesToLoad\
common.jsCTEHRINTVET (ZDT7 7 AL, <UFTA VR F—JL+ THILE>\
dat\Extensibility\Web\Toolkits 7 -+ /L X124 5 Y

£9).

2—FT 4 VT 4 « AT V=7 FEEOHESTIZOW T, UFT Web Add-in Extensibility API
Reference (Web Add-in Extensibility ~/V 7" 2 LFHIHFIHE) 2B L T &0,

Book O FO—)LEDFEEDHR— b EERT SIZIE, ROFIETITVET,

1 Test Object Class TH' 1 3@ [General] # J CREDHMA T a %k
BE
a WebExtBook @ [General] # 7 (Test Object Class 7 %A F) ZB&E7,

FHATBACONTVEHAR, /TR - Ea—ilhbTnY =/ bOT A b -
ATV k2T ADY A LT WebExtBook &4 7L U w7 LTTHA T %
& xd,

b [Advanced Options] #2 U > 27 L, [Record Options] £ TTIZAZm—/L L
e
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A R BEEBIEAL DR v 7 212, [ListenToEvents] & AL E7,

d 2 o= ZDFITHT DA R FOUFRITEERED Web A1 X N ERIE &l
TAEICUFT IS RT ALY a v DF ey Ry 7 A% VT LET,

e EHWEHEAFL, Yul=zs b/ 271 —7 /5 WebExtBook.js 7 7 1 /L& [
WTC, BENZ 7 AMIED LI ITKRENTNDE D EMRLET,

&k D Record 373, WebExtBook @ Control EHENERIZIBEMEI N CTWET,

<Record>
<EventListening use_default_event_handling_for_children="false"
use_default_event_handling="false"
type="javascript" function="ListenToEvents"/>
</Record>

ZhE, Book A b m— L L ZDFITKT DA N FDRFRIT, FEAERRIE D Web A
ANy MNRE R MW, JavaScript Bi%k ListenToEvents # MEOVH 3L 9 1, UFT I2f8
7~ L ¥ 9, JavaScript 7 7 A MIFHEE L TWRWO T, UFT 1% JavaScript B3 %,
WebExtBook 7 A b « A7 V=7 k « 7 Z A |Z%F LT Control L' ~/L CHE I TV
% WebExtBook.js 7 7 { /L T L £ 7,

2 WebExtBook.js 7 7 1 L ZR<

Test Object Class 7 %1 F® [General] ¥ 7 OFFEROFEMA 7> 2 > T, [Event
registration function name] &~ v 7 2DiE< 2% % [Implementation Code] 7%
YEIV I LET,

I

WebExtBook.js 7 7 A /L A3BH &, ListenToEvents B0 %f L CERR S Lim A ¥ 7533k
RENET,
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3 BEEYR— FT5DICREL JavaScript BEZEM
a ListenToEvents B4icxf L CIE SNz A ¥ 7%, ROa— RIC@EEHELET,

function ListenToEvents( elem )
{
/I Connect to the "Select" event:When the book name or the book
/l'icon is clicked, call OnSelectClicked.
_util.RegisterForEvent( _elem.rows[0].cells[0].children[0], "onclick",
"OnSelectClicked");
_util.RegisterForEvent( _elem.rows[0].cells[1].children[0], "onclick" ,
"OnSelectClicked" );

/I Connect to the "Author" event:When an author name is clicked,
/I call OnAuthorClicked.
for( vari=0;i<_elem.rows[1].cells[0].children.length ; ++i)

{
if( _elem.rows[1].cells[0].children[i].tagName == "A" )
{
_util.RegisterForEvent( _elem.rows[1].cells[0].children([i], "onclick",
"OnAuthorClicked" );
}
}

/I Connect to the "UsedBooks" event:When "Used" is clicked,
/I call OnUsedBooksClicked.
if( _elem.rows[3].cells[0].children.length > 1)
_util.RegisterForEvent( _elem.rows[3].cells[0].children[1], "onclick",
"OnUsedBooksClicked" );
return true;

Z oL, A4, BB, FF, Used Vo 7T 27 v s « ARV N
VAT DI UFT 288k LET, X2 MIRTBEOERIZ, oK
A R R BEARFZ UFT A3REONE - JavaScript BIE AR E L £ 7
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function OnSelectClicked( handlerParam , eventObj )

{
/I Record the "Select" step

var arr = new Array();
_util.Record( "Select", toSafeArray(arr) , 0 );
return true;

function OnAuthorClicked( handlerParam , eventObj )

{
/I Record the "GoToAuthorPage" step

var arr = new Array();

arr[0] = eventObj.srcElement.innerText;

_util.Record( "GoToAuthorPage", toSafeArray(arr) , 0 );
return true;

}

function OnUsedBooksClicked( handlerParam , eventObj )

{
/I Record the "GoToUsedBooksPage" step
var arr = new Array();
_util.Record( "GoToUsedBooksPage", toSafeArray(arr) , 0 );
return true;

}

ZH ORI, 148 ~X— TWeb Add-in Extensibility ® Book Sample > —/L-%
b DY R — b OFHE) OFEICHES T, WebExtBook 7 A b « A7 Y= MIKIL
T Select, GoToAuthorPage, GoToUsedBooksPage % fték L £,
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AR—hk- kY N2 UFTIZF oA LTTFAMLET,

Book AV FA—LTETEhDREEOREOYR— FETR FTBICIE, ROFIETIT
WETS

1 £¥ %2+ _XTERIFEL, [Project] > [Deploy] > [Deploy to QuickTest Professional]
EIBIRLET,

2 UFT LT LHEUHEEET, [T RA v v%—Vx] 447807 - Ry I AT
WebExtSample OF = v 7 « Ry 7 ZA%ERL, [OK] #27 V> 2 LEF, UFT 23
&, FEPLEYR— e —REhET,

3 Internet Explorer T, > 7/ a2 b — L EZH U THLEIATLET,

4 GUI 7 A bxBI%, [BB&] Ax 22V vr 3250, [BBER] > [ 2®NLE
9, Book 2> b —/VNOIEXERV 7%V LET (77U v LRI,
Book = b B —/WIZR B T=DICHION—DICR B LENH Y £97) ., ADELA, =
e — L NOWE, EE4L, [Used] Vo277l % 70 v 7 LTHET,

IV w7 FTBHINNG, @ LTEBEEZFERHLT, BILWAT v 7R T X MTBIMEN

\i j—O
Item Operation Walue D ocumentation
v @@ Action
- (&1 Book
- [ Book
ﬂ The Histary of QuickTest: Select Select the "The History of QuickTest"” book,
=[] Mot Implemented Sync Wit for the Web page to syrchronize before continuing
17":::';': Book. Back Mavigate back to the previous page of the browser.
- D Book.
ﬁ The History of QuickTest: Select Select the "The History of QuickTest” book.
[ Mat Implemented Sync ‘wait for the ‘web page to synchronize before continuing
- ,' Book. Back Mavigate back to the previous page of the browser.
- D Boak
ﬂThe History of QuickT est: GoT aduthoP age “Jane Doe": Open the Web page for "Jane Doe'
[ Mat Implemented_2 Sync ‘wiait for the 'web page to synchronize before continuing
- [E Book Back Mavigate back to the previous page of the brovwser.
- D Boak
ﬁThe History of QuickTest: GoTolJsedBooksFage Open the "The History of Quick Test" uzed books page.

(L] RE 22V 732570, (B > [BLlE] 2@RL Ttk v o a o &fk
Tbi?’*o
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UFT 2 Ea—XIZZh%77uA L, Book 77 ) r—va v %FTLTCTA TS
ENRTEET,

1 [View] > [Toolkit Support Properties] % iR L %7, Toolkit Support Properties 7

A FHRENZD @72—T%2M), [Developmentmode] 7> o %7 V7 L,
ERERAFLET,

2 U—/7u— -7 KT [Deploy Toolkit Support Set] %27 U v 745,
[Project] > [Deploy] > [Deploy to Zip File] %#®iR L, 1Bk B.zip7 71 /LD
NAZRELET,

3 EEOUFT 2 Ba— XD <UFT FIET7 FA VDA VX F—=)L» T\
dat\Extensibility\Web 7 + /L # (27 7 A V2R L £,

ZOF =— KU 7L T, Extensibility Accelerator % H L "C Web Add-in Extensibility > —
AExy b YR—h -ty FEBRELELE,

» Web Add-in Extensibility 7’2 ¥ = 7 &R T D720 OHRED — 27 70— % F W, ME
TR FNEEE L E Lz,

> HLWF AL - AT Vxr k- 75 X WebExtBook Z1ERL L, FORFET w7 4 &
TAN ATV b Ay FEERELE L,

» Book 2> hR— /LI TH v BT - =V EAERTHZ T, UFT A Z D= b
o —/L% WebExtBook 7 Ak « A7 V=7 & LTHETELLIIcLE LA,

> HLWVERHB T aRNTF (T AR ATV b AV ROYFR— MIOWTEEL
F L7

> V—=nFy b Y R—b by NORET 7 AN BT 5 EEFOE LT,

> FiEkE Y AR— 95 HEE %, Record 1 X (Y RegisterForEvent = —7 ¢ U 7 ¢ -
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Web Add-in Extensibility ® BAF& DFEMIIZ DUV TIE, [HP UFT Web Add-in Extensibility B85
FEHA RI([~NILT] > [Web Add-in Extensibility BIFEH A F1) 22H L T Z &0,

TAR ATV PRET 7 A N OMIEENEOFMIIONTIE, UFT 7 A b - 47
Tzl b AFx—<D~)LT (Web Add-in Extensibility ~/L 7/ LF|HA[HE) #EBM L T
TSV,

V=¥ MEET 7 AN OHEE ENR OOV TIE, UFTToolkit Configuration
Schema D~/ 7 (Web Add-in Extensibility ~/L 77 LFIHATHE) 2R L T &0,

_util=—7 s V7 - A7z h& 7 a—sYL JavaScript A Y v FOFEIZ OV T,
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